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. VORBEMERKUNGEN

A. XML, EXMARaLDA und der Partitur-Editor

Der Partitur-Editor, den dieses Handbuch zum Gegenstand hat, ist ein Werkzeug zur Ein- und Ausgabe
von EXMARaLDA-Transkriptionen. EXMARaLDA ist seinerseits ein XML-basiertes System zur
Diskurstranskription auf dem Computer, das die Grundlage einer Datenbank ,Mehrsprachigkeit* am Son-
derforschungsbereich ,Mehrsprachigkeit* (SFB 538) der Universitdt Hamburg darstellt. Es ist flur das Be-
dienen des Editors nicht unbedingt notwendig, diese Zusammenhange standig parat zu haben. Aber es
ist auf jeden Fall nutzlich, sie sich einmal vergegenwartigt zu haben. Konkret bedeutet dies namlich z. B.:

" Es gibt neben dem Partitur-Editor auch noch andere Mdéglichkeiten, EXMARaLDA-Transkriptionen
zu erstellen und zu bearbeiten (z. B. mit Hilfe der Transkriptionswerkzeuge Praat oder TASX-
Annotator, mit einem beliebigen XML-Editor oder nach der ,Simple EXMARaLDA"-Eingabemethode
in einem herkdbmmlichen Texteditor oder Textverarbeitungsprogramm).

" Sinn und Zweck des Editors ist es nicht in erster Linie, ein Werkzeug zum Erstellen von ,schénen®
Partituren zu liefern, sondern die Erstellung von Transkriptionsdaten in einer Form zu erméglichen,
in der sie fur eine Datenbank verwertbar werden. Trotzdem kdnnen mit dem Editor natirlich Partitu-
ren ein- und ausgegeben werden.

] Als XML-basiertes System macht EXMARaLDA vom Konzept der Trennung von logischer und gra-
phischer Struktur eines Datums Gebrauch. EXMARaLDA-Transkriptionen ,sind“ daher keine Partitu-
ren und ,bestehen” nicht aus Spuren — dies sind lediglich Elemente, die zur graphischen Darstellung
von EXMARaLDA-Transkriptionen am Bildschirm oder auf dem Papier Anwendung finden. EXMA-
RaLDA selbst kennt nur solche Elemente, die sich auf die logische Struktur von Transkriptionen be-
ziehen, also beispielsweise ,Ereignisse®, ,Zeitintervalle®, ,Sprecher” etc. All diese Elemente finden
sich daher auch in den Bedienungselementen des Partitur-Editors wieder. Mit anderen Worten: Die
graphische Struktur einer Partitur hat keine unabhéangige Daseinsberechtigung, sie ist lediglich eine
(von vielen mdglichen Visualisierungen), die aus der logischen Struktur einer EXMARaLDA-
Transkription berechnet werden kénnen. Weil diese graphische Struktur Ergebnis einer Berechnung
ist, ist der Partitur-Editor auch kein wirkliches ,What you see is what you get‘-Instrument. Bei der
Nutzung des Partitur-Editors ist es daher hilfreich, neben dem graphischen Erscheinungsbild, wel-
ches man vor Augen hat, stets auch die logische Struktur, die ihm zugrunde liegt, im Hinterkopf zu
behalten.

Kurze Rede, kurzer Sinn: Man muss kein Experte der Texttechnologie sein, um mit dem Partitur-Editor
Transkriptionen zu erstellen, aber ein grundsatzliches Verstandnis des EXMARaLDA-Konzepts ist den-
noch sicherlich hilfreich. Da es ist nicht der Zweck dieses Handbuches sein kann, ein solches zu vermit-
teln, sei hier einfach auf die folgenden Publikationen verwiesen:

Schmidt, Thomas (2001): The transcription system EXMARaLDA: An application of the annotation graph
formalism as the Basis of a Database of Multilingual Spoken Discourse. In: Proceedings of the IRCS
Workshop on Linguistic Databases, pp. 219-227.

Schmidt, Thomas (2002a): EXMARaLDA — ein System zur Diskurstranskription auf dem Computer. In:
Arbeiten zur Mehrsprachigkeit (Working Papers in Multilingualism), Serie B (34). Hamburg.

Schmidt, Thomas (2002b): Gespréchstranskription auf dem Computer — das System EXMARaLDA. In:
Gesprachsforschung (Online-Zeitschrift zur verbalen Interaktion) 3, 1-23.

Schmidt, Thomas (i. V.): EXMARaLDA — ein System zur computergestiitzten Diskurstranskription. Er-
scheint in: Mehler, Alexander / Lobin, Henning (Hrsg.): Werkzeuge zur automatischen Analyse und
Verarbeitung von Texten: Formate, Tools, Software-Systeme.

Schmidt, Thomas (2003): Visualising Linguistic Annotation as Interlinear Text. In: Arbeiten zur Mehrspra-
chigkeit, Serie B (46). Hamburg.
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B. ,,Words of Caution“

Als zusatzliche Vorbemerkung und zur Vermeidung von Missverstandnissen sei an dieser Stelle noch auf
drei wichtige Umstande hingewiesen:

EXMARaLDA ist ,Work in Progress*

Die Homepage weist bereits darauf hin: Sowohl EXMARaLDA als auch der Partitur-Editor befinden sich
mitten in der Entwicklung. Auf der einen Seite bedeutet dies, dass die Software noch nicht reibungslos
und fehlerfrei funktioniert. Auf der anderen Seite heif3t dies aber auch, dass Sie sich mit Fehlern und Un-
zulanglichkeiten des Systems nicht abfinden mussen. Eine kurze E-Mail an den Entwickler, in der das
Problem so prazise wie moglich geschildert ist, genigt in vielen Fallen bereits, um relativ kurzfristig Abhil-
fe zu schaffen.

In regelmafRigen Abstédnden werden Updates veroffentlicht, in denen Fehler der vorherigen Versionen
behoben sind und neue Funktionen eingefluhrt werden. Es lohnt sich daher, stets mit der aktuellsten Ver-
sion des Editors zu arbeiten, auch wenn dies eine regelmaflige Neuinstallation der Software bedeutet.
Auch dieses Handbuch wird in regelmafRigen Abstanden aktualisiert. Wenn Sie die EXMARaLDA Mailing-
Liste abonnieren (siehe entsprechende Option auf Homepage unter http://www.rrz.uni-
hamburg.de/exmaralda) werden Sie automatisch immer Uber die Bereitstellung neuer Versionen infor-
miert.

Der EXMARaLDA Partitur-Editor ist weder der neue syncWRITER noch das neue HIAT-DOS

Der Partitur-Editor orientiert sich in einigen Punkten zwar an diesen beiden Programmen, verfolgt aber
grundsatzlich einen anderen Ansatz: Er soll nicht nur ein Ein- und Ausgabeinstrument fiir Transkriptionen
in Partiturschreibweise sein, sondern dariiber hinaus auch als Eingabeinstrument fur die an der Universi-
tdt Hamburg im Sonderforschungsbereich ,Mehrsprachigkeit‘ (538) geplante Datenbank ,Mehrsprachig-
keit* fungieren. Viele Dinge funktionieren deshalb anders, als Nutzer des syncWRITER oder HIAT-DOS
es gewohnt sein mogen.

Dieses Handbuch ist keine Anleitung zum Transkribieren

EXMARaLDA ist ein formales Framework, das eine Abstraktionsstufe héher angesiedelt ist als konkrete
Transkriptionssysteme wie HIAT, DIDA, GAT etc. Aus diesem Grunde liefert dieses Handbuch keine kon-
kreten Anweisungen, welche Phanomene gesprochener Sprache wie zu transkribieren sind. Dies muss in
gesonderten Transkriptionskonventionen festgelegt werden. Ein Handbuch fiir das Transkribieren nach
HIAT mit dem EXMARaLDA Partitur-Editor erscheint in Kiirze als:

Rehbein, Jochen / Schmidt, Thomas / Meyer, Bernd / Watzke, Franziska / Her-
kenrath, Annette (2004): Handbuch fur das computergestutzte Transkribie-
ren nach HIAT. Arbeiten zur Mehrsprachigkeit (Serie B). Hamburg.

Eine Anleitung fur das Transkribieren nach DIDA mit dem EXMARaLDA Partitur-Editor ist ebenfalls be-
reits in Arbeit. Fir diesbezligliche Informationen wende man sich an das IDS in Mannheim.


http://www.rrz.uni-hamburg.de/exmaralda
http://www.rrz.uni-hamburg.de/exmaralda
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Die Programmoberflache sieht leicht unterschiedlich aus, je nachdem, welches Betriebssystem verwen-
det wird und welches ,Look & Feel“ dieses Betriebssystem als Standard verwendet. Die Abbildungen
mit dem Windows Look & Feel erstellt.

(Screenshots) in diesem Handbuch wurden iberwiegend

Windows Look & Feel (Windows NT)

% EXMARaLDA Partitur-Editor Version 1.2.1. [E:\AAA Beispiele\Helge_neu‘Helge_Basic_xml]

File Edit Yiew Tier Evert Timeline Format Segmentstion Help

UBERBLICK: PROGRAMMOBERFLACHE

|of=la] @F Bl
| == e ) 2

@%ﬂlﬂ@@@ﬂ

|

IHﬁh, warm lacht der denn jetzt?

37 [437]| 32 [44.0] 39 44 8] 40 46 7] A1[#E3])| 42 [40.1] |45 [495] |44 |45 [507]
KLA |Bitte? |Ich hab nichwerstanden. [Hék, mmh\ lacht der derm jetzt? aja, | iz egal. ;l
KLAL Pardon? I cidn't get that Whyr 15 he laughing? Dioesn't matter.
ERW Achso, ja iilacht 1,9 sech). Hruhrn, |A11m, dh jaa. | Ach, ach, Volkshochschule!
ERW1 L, yes ((langhs 1.9 sec) Fes |A}\, wes L, adult education centre?
AUDIO |ATDIOA =]
Kl — IO

e

Motif Look & Feel (Linux)

% EXMARaLDA Partitur-Editor Version 1.2.1. [E-\AAA_Beispiele\Helge_neu\Helge_Basic_xml]

File Edit View Tier Event Timeline Format Segmentation  Help

EECE S|

EIE L EHEEIEIE

El=pe =z (| mesEeee e |
\

|37 27 32 e 39 44 40 [$67] 4103 (421404305 |44 15[45 150 46 [521]
ELAR] 1 |Bltle7 Ich hab ruch verstanden, Hiih, warur Jacht der denn jetzt? Haja, | is egal Ja, sicher
KILA [en] |) Pardon? |1 didn't gat that. Why is he laghing? Doest't muatter. Tes, aure
ERW R Achso, ja ((lacht 1,9 sec)). Hruhen, |Ahm. dh |jaa. |Ach, ach, Volkshochschuls?
ERW [en] Al yes ((laughs 19 sec)) Tas [ es A, adult education centre?
[and] AUDIOG

T

Aqua Look & Feel (Mac OS X)

» O 0 BT EXMARaLDA Partitur-Editor Version 1.2.1. [{Volumes/NEU/Beispiele/Tropftsteinhoehle ftropfsteinhoehle_bz |

EIII'llIﬂllI
?Eﬁ HEEE

/ﬁéﬂé;ﬂgﬂigﬁﬂg

‘e

3 |31 32 |22

s 36 |3z
KLA[v] |Bitte ich hab nich verstanden. |Hih, Warun lacht der denn jetat? Ja, sicher, hal ich doch | grade gesachi
KLA [eng] | Excuse me. | didn't get tha?  [Eh, why is he langhing? Yes, sure, that's what I just said.
KLA [f] |
KLA [nv] |
ERW [¥] |Achso, ja ({lacht)). Hmm, ja. |Ach, ach, Volkshochschule? Ach, Volkshe
ERW [eng]| | scc. yes {ilaughsi) Mhm, yes. |Oh, adult education centre? | Oh, adult edus
ERW Inv] | | |
[} £ Y ERE
Noane
£

Die beiden folgenden Seiten sollen einen Uberblick ber die Elemente der graphischen Benutzeroberfla-

che und die Bedienungskomponenten des Editors geben.

-1

Programmoberflache
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# EXMARaLDA Partitur-Editor Version 1.2.1. [E:\AAA_Beizpiele\Helge_neu\Helge_Basic_ xml]

Flle Edt View Tier Evert Timeine Formst Seameniation Help

EECRCEREEY

= R
|'dhy is he laughing?®

37 [437) 32 p340) B |s0 6] |#1p23) (42089 |43 p95] |44 [ 451507) .
KLA  [Bitte? [Ich hab rich verstanden. [Hek, wanun lacht der denn jetzt? | Najo, [segal | | = Hauptfenster
ELAL Pardon? |[didn't get that. v is b laughipg? Dicesn't matter. | Parti
BRW hehiso, ja (lacht 19 5e2)). Huan. | [k, 81 jaa. | ch, sch, Volkshochschle? artitur
ERW1 A, yes ((laughs 1,9 sec)) Yes. | |Ah, WES. |Ah, adult education centre?
AUDIO [AUIDIOG |
A — I
o ]
“ EXMAHaLDA Partitur-Editor Yersion 1.2.1. [E:\AAA_Beispiele\Helge_neu\Helge_Basic.xml]
Fie Edit View Tier Evert Timeline Format Segmentation Help @——— Meniileiste

ol=al S Blele  (2A[e] slEne
= 5 o s 5 < = = [ == I [ P

G Toolbar

|'My is he laughing? — Textfeld
37 n33]| 38 [440] 39 [447) 40 [46.7) 41 He3] 4249 43 [49.5) (i 45 [50.7) — Zeitac]hse
— (Timeline)

t_t 4

Zeitintervalle

KLA [Bitte? [Ich hab nich verstanden | |Hah, warumn lacht der denn jetzt? | [Waja, [isezal. [ B 4
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Programmoberflache

(Virtuelles) Keyboard

S Keyboard
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Link Panel

% Link Panel

Diesar Beraich it fiir
das Steigenlaszen
van Leakdrachen
ISlurmekachont eriaubt,
i :

R

FRINEYE o e mer

" e L e

| - Ewent description
Eild1

Link Medium

Ilmage

E
—Link URL
I|as'l.l»{rimerams'l.Eiilder'l."-.-"erbnﬂ Jpe Browwse. . |

Segmentation Panel

% Segmentation Panel

Get speaker contribution

Parze speaker contribution

Speaker Contribution Text

~Parsed Resuft

Dreizehn Mann auf des toten Mannes Kiste, [[schniffelt])
Eoah, wat stinkt datwiederin der Tropfsteinhdhle. Oh, da
kornmt einer. Kommt noch einer. [[hustet]] Wa?

~Finite State Machine

LI CIREn... |

HIAT: Ltterances and words

;] sc: Oreizehn Mann auf des toten Mannes Kiste. [[sch &
J HIAT:u: Dreizehn Mann auf des toten Mannes Ki
J HIAT:u : [[schniffelt]] Baah, wat stinkt datwieder
= _| HIAT:u : Oh, da kermmt einer.

# HIATw: Oh

HIAT:ip:.

HIAT:ip :

HIAT w2 da

HIAT:ip :

HIAT e : kot

HIAT:ip :

HIAT v : einer -
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Audio Panel

% Audio Panel E x|
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Playback started.
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lll. TUTORIUM

A. Anlegen und Eingeben einer Transkription im Partitur-Editor

Schritt 1 — Neue leere Transkription erstellen

Wenn Sie den Editor nicht gerade neu gestartet haben (und somit ohnehin eine neue, leere Transkription
vor sich sehen), wahlen sie File 2 New. Die Partitur sollte danach so aussehen:

Xpl

Schritt 2 — Einrichten der Meta-Information

In der Meta-Information werden Daten vermerkt, die die Aufnahmesituation oder die Transkription als
Gesamtheit betreffen (also z. B. Datum und Inhalt der Aufnahme, Name des Transkribenten etc.). Zu-
sammen mit der Sprechertabelle (siehe nachster Abschnitt) dienen sie vor allem Dokumentationszwe-
cken, d. h. sie sollen u. a. das (Wieder-)Auffinden der Transkription in einem Korpus erleichtern.

Wahlen Sie File 2 Meta Information... und geben Sie den Projektnamen, Transkriptionsnamen usw. in
die vorgesehenen Felder ein. Um ein benutzerdefiniertes Attribut hinzuzufiigen, klicken Sie auf Add attri-
bute... und geben den gewlinschten Attributnamen ein. Den zugehorigen Wert geben Sie in die entspre-
chende Tabellenzelle ein.

% Edit Meta Information x|
rFixed sttributes
Project name: X253 "Wommunikation sm Babinbof"
Trahscription name: Eeizpietranskription
Transcrigption convertion: HIAT
Referenced file: I}(23_Aufnahme12.wav Browese. . |
rUser defined attributes
Add attribute | Atribute | alue |
{oatum 23011974
Remove attribute
Up Dioven
Template...
—Comment
Transkription zum Ausprobieren des Editors ﬂ
I
Ok Cancel

SchlieRen Sie den Dialog, indem Sie auf OK klicken (nur dann werden die Anderungen ibernommen).
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Schritt 3 — Einrichten der Sprechertabelle

So wie die Meta-Information das gesamte Gesprach, dessen Aufnahme und Transkription naher charak-
terisieren, kénnen in der Sprechertabelle wichtige Informationen Uber die einzelnen Sprecher festgehal-

ten werden.

Wahlen Sie File = Speakertable... und markieren Sie den vorhandenen Sprecher (X). Andern Sie sein
Kirzel im Feld Abbreviation. Editieren Sie die Eigenschaften dieses Sprechers. Um benutzerdefinierte

Attribute hinzuzufiigen, verfahren Sie wie bei Schritt 2.

% Edit Speakertable

X

~Speakers

SRR [5-1]
SPK2 [5-2]
SPKE [5-3]

COWA TS A1

Add speaker

Remove speaker

| 'Speaker properties

~Fixed attributes
Abbreviation:

S

Imale

rLanguages
Languagels) used:
First languagel =)
Second languagel =)

Edit languages ... |

GER

—iCarnmet

hérbar "auber Atem"

Spricht relatiw laut, wit bayerischem Akzent, ist il

[wvermutlich aus
Mnfrequng/Hervosicat iber den Unterrichtshesuch
durch TIMS3 bhzw. die Videoaufzeichnundg).

=

~Uzer defined attributes

Add attribute

Attribute

Walue |

Remowve sttribute

L Dovwery

Collect attributes

Template. ..

0.4 I Cancel

Fligen Sie einen weiteren Sprecher hinzu, indem Sie auf Add speaker klicken. Markieren Sie den neuen
Sprecher und editieren Sie nun dessen Eigenschaften. Um die benutzerdefinierten Attribute des ersten
Sprechers zu Gbernehmen, klicken Sie auf Collect attributes.

SchlieRen Sie den Dialog, indem Sie auf OK klicken (nur dann werden die Anderungen ibernommen). In
der Partitur ist jetzt das geanderte Sprecherkiirzel eingetragen:

u|1

MAX [v]] |

-2




EXMARaLDA Partitur-Editor — Handbuch Tutorium

Schritt 4 — Einrichten von Spuren

Wahlen Sie Tier = Add Tier... . Es wird ein Dialog angezeigt, in dem Sie die Eigenschaften der neu ein-
zurichtenden Spur festlegen kénnen. Wahlen Sie einen Sprecher und einen Typ (eine verbale Spur hat
z. B. in der Regel den Typ , T, eine non-verbale den Typ ,D) und tragen Sie eine Kategorie ein.

% New tier ﬂ
Speaker: ISPKD [hl2x] | Edit zpeakertable. .. |
Type: T(ranscription) j
Category: 'H.-'_

™ copy everts from: ITIEEI [hAa V] LI

8] Cancel |

SchlieRen Sie den Dialog, indem Sie auf OK klicken (nur dann werden die Anderungen (bernommen).
Wiederholen Sie diesen Schritt, bis die Partitur alle gewiinschten Spuren aufweist. (Sie kdnnen natrlich
bei Bedarf auch noch spater weitere Spuren hinzufiigen.) Die Partitur sollte danach in etwa so aussehen:

MAX ]
MAX ]
TOM ]
MAX ]

Alle Spuren bekommen — abhangig von ihrem Typ — eine Standardformatierung zugewiesen. Sie kdnnen
diese aber auch jederzeit andern (siehe dazu weiter unten).

Schritt 5 — Transkribieren

Sie kdnne jetzt transkribieren, indem Sie Text in die Zellen eingeben. Die ZellgréRe passt sich automa-
tisch der Grof3e des Inhalts an.

0 1 2 3 |
MAX R |Du fallst mir mmer |ins Wort.
MAX [nv] | gesafubiors
TOM f] Simmt  |ja gar nicht. |
TOM [mw]

Behalten Sie im Hinterkopf, dass Transkribieren nach dem EXMARaLDA-Verstandnis darin besteht,

" Ereignisse zu beschreiben,

" einem Sprecher und einer Kategorie zuzuweisen und

" sie in eine Zeitachse einzuordnen.

Den betreffenden Sprecher und die betreffende Kategorie wahlen Sie aus, indem Sie die zugehorige
Spur wahlen. Die Einordnung in die Zeitachse erfolgt dann Uber die Auswahl des zugehérigen Zeitinter-
valls bzw. der zugehdrigen Zeitintervalle, i. e. der ,Zelle(n) in der Spur, die unter dem entsprechenden

Ausschnitt auf der Zeitachse steht. Die eigentliche Beschreibung nehmen Sie vor, in dem Sie Text in
diese ,Zelle“ eingeben.
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Fir das obige Beispiel heifdt das, es gibt insgesamt flinf Ereignisse:

1.  Das Ereignis, das mit ,Du fallst mir immer® beschrieben ist, wird dem Sprecher Max, der Kategorie
LV (fur ,verbal“) und dem Zeitintervall 0 zugeordnet.

2. Das Ereignis, das mit ,gestikuliert* beschrieben ist, wird dem Sprecher Max, der Kategorie ,nv* (fir
»non-verbal“) und den Zeitintervallen 0 bis 1 zugeordnet (verwenden Sie die Funktion Event > Mer-
ge events, um die beiden Ereignisse zusammenzulegen).

3. Das Ereignis, das mit ,ja gar nicht.“ beschrieben ist, wird dem Sprecher Tom, der Kategorie ,v* und
dem Zeitintervall 2 zugeordnet.

4. /5. Die Ereignisse ,ins Wort“ und ,Stimmt*“ erfolgen zeitgleich und sind deshalb demselben Intervall
(Intervall 1) zugeordnet. Mit anderen Worten: Die Beitrdge der beiden Sprecher iberlappen sich an
dieser Stelle.

Der Editor stellt zahlreiche Funktionen zur Verfiigung, die Sie beim Eingeben und Korrigieren solcher

Ereignisse unterstiitzen (ndhere Angaben im Kapitel ,Funktions-Referenz* unter ,Event-Men(® und ,Ti-
meline-Meni").

Schritt 6 — Transkription speichern

Wahlen Sie File 2 Save as..., vergeben Sie in dem sich nun 6ffnenden Dialog einen Dateinamen (die
Dateiendung ,,.xml* wird vom Programm automatisch erzeugt) und speichern Sie die Datei ab.

% Save a basic transcription to file il

Speicherm in: I[:I kitrina_gantia_web LI |‘j€
kitrirg sl
kitring_format ml
R

@

et
[
=

Eigene Dateien

Dateiname: I Speichern |
Dateityp: IEx‘tensible Markup Language (X j Abbrechen |
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B. Formatieren einer Transkription

Allgemeines

Die Formatierung, d. h. Informationen Uber Schriftsdtze, Schriftgrof3en, Hintergrundfarben etc. sind nicht
Bestandteil der eigentlichen Transkription, sondern werden als zuséatzliche Information behandelt, die nur
fur die Darstellung im Editor und fir die Ausgabe relevant ist. Sie werden darum auch nicht mit der ei-
gentlichen Transkription, sondern als gesonderte Datei gespeichert. Der Editor versieht jede Transkription
automatisch mit einer Standardformatierung. Dieser Abschnitt zeigt, wie Sie diese Standardformatierung
nach lhren Bedirfnissen andern kénnen.

Ein wichtiger Hinweis zu Beginn

Die Systemarchitektur sieht vor, dass nur ganze Spuren, bzw. alle Spur-Labels oder alle Zeitachsen-
Labels mit einer Formatierung versehen werden kénnen. Insbesondere ist es nicht méglich, einzelne
Abschnitte einer Spur, z. B. einzelne transkribierte Woérter, zu unterstreichen, fett zu drucken oder in eine
andere Schriftart zu setzen.

Der Grund dafir ist, dass sich derartige Formatierungen nur sehr eingeschrankt in andere Datei-Formate
Uberfihren lassen. Beispielsweise ist es nicht mdglich, Unterstreichungen oder Fettdruck als solche in
eine Datenbank zu Ubernehmen. Wenn Sie diese Mittel nur aus Grunden der Darstellung verwenden
mochten, kénnen Sie die gewlinschten Anderungen spater in einem exportierten RTF-Dokument vor-
nehmen. Wenn sie jedoch Bestandteil ihrer Transkriptionskonventionen sind (z. B. wenn Sie betonte Re-
deteile nach den Konventionen unterstreichen mussen), sollten Sie dariiber nachdenken, ob sich das so
markierte Phadnomen nicht mit anderen Mitteln ausdriicken lasst.

Schritt 1 — Formatieren einer Spur

Legen Sie eine neue Transkription an oder 6ffnen Sie eine Transkription, die Sie bereits erstellt haben.
Die Spuren und Labels werden vom Programm zun&chst mit einer Standardformatierung (Times New
Roman in verschiedenen Schriftgro3en) versehen. Markieren Sie dann die Spur, die Sie umformatieren
mdchten, indem Sie auf das zugehdrige Spur-Label klicken.

0]
D fallst rar rorner s Wort.

Max [v]
Max [nv]
Tom [v] Stirent  [ja gar nicht. |

Tom [nv] | | | j

Wahlen Sie jetzt Format - Format Tier... (alternativ kdnnen Sie das entsprechende Symbol auf der Tool-
bar oder die Tastenkombination [Strgl+F| auf dem PC bzw. [ [+F] auf dem Macintosh benutzen).

Sie erhalten einen Dialog, in dem Sie die aktuelle Spurformatierung andern kénnen. Wahlen Sie z. B.

eine andere Schriftart, eine andere Schriftgrofe und eine andere Hintergrundfarbe. In der ,Test Area“
kodnnen Sie die Formatierung ausprobieren.
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% Edit tier format x|
~Test Area

Dies ist ein Test. |

—Formatting properies

Faont; Lucida Sans LI Earder: [ Lett I Right [ Top [ Bottom

Style: Plain LI Eaorder colaur: -

Size: 20 LI Eaorder style: Isnlid ﬂ
Text colour: - Height calculstion: % Generous Mizerly

Backaround Colar: Ediit... " Fied: 10 Px

Alighirmerit: ILeﬂ LI

QK | Cancel |

SchlieRen Sie den Dialog, indem Sie auf OK klicken (nur dann werden die Anderungen ibernommen).
Die markierte Spur hat jetzt die von Ihnen geanderten Formatierungseigenschaften:

1] 1 T 3
Max i |py fallst mir immer ins Wort.
hax ] P sttt
T ] Starovt ja gar micht.
Ton ]

Schritt 2 — Formatieren der Spur- und Zeitachsen-Labels

Um die Formatierung der Spur oder der Zeitachsen-Labels zu andern, wahlen Sie Format - Format tier
labels... bzw. Format - Format timeline... und verfahren Sie wie oben.

s A g [
LIRENTEMD L fallst mir immer ins Wort.

Max v/ BRIkl

Tom fvf
¥

= )
Tom fav]

Alternative — Bearbeiten der Formatierungstabelle

Statt die Formatierung fir jede Spur und die Labels Schritt fir Schritt zu &ndern, kénnen Sie auch in ei-
nem Schritt die gesamte Formatierungstabelle bearbeiten. Wahlen Sie dazu Format 2 Edit format
table... . Sie erhalten folgenden Dialog:
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% Edit tier format table

x|

TIED (3 [+]) S o
EMPTY ()

EtP T -EDITOR () Remove fotmat
ROV-LABEL ()

SLUB-ROW-LABEL ()
COLUMMN-LAEEL ()

Test Area

DIEsS IST EIN TEST.

Formatting properties

Fort: BankGaothic Md BT LI Border: [T Let I Right [ Top [ Bottom

Style: Plair LI Barder colour: -

Size: 20 LI Border style: Isnlid LI
Text colour: - Height calculation: * Generous Mizerly

Background Colar: Edit... " Fixed: |1D P

Alighmerit: ILeﬁ ll

Ok I Cancel |

In der Liste im oberen Teil des Dialogs sind alle formatierbaren Elemente aufgelistet, die zur aktuellen
Transkription gehdren. Wahlen Sie das Element aus, das Sie andern méchten und verfahren Sie dann
wie in Schritt 1. Die Eintrédge ,EMPTY ()* und ,EMPTY-EDITOR ()“ bezeichnen die Formatierung derjeni-
gen Stellen der Partitur, die keine Ereignisse enthalten.

Schritt 3 — Speichern der Formatierung:

Da die Formatierung nicht Bestandteil der Transkription ist, missen Sie sie in einer gesonderten Datei
speichern. Wahlen Sie dazu Format - Save format table as... . Suchen Sie im dann erscheinenden Dia-
log das Verzeichnis aus, in dem Sie die Formatierungstabelle ablegen mdchten und geben Sie einen
Dateinamen ein. (Sowohl die eigentliche Partitur-Datei als auch die Format-Datei tragen das EXMARaL-
DA-Suffix ,.xml“. Es empfiehlt sich daher, den Dateinamen so zu wahlen, dass er sowohl erkennen lasst,
dass es sich um eine Format-Datei handelt, als auch, zu welcher Partitur-Datei die Format-Datei gehdrt.)

Schritt 4 — Laden einer Formatierung:

Wenn Sie jetzt die eben angelegte Transkription erneut 6ffnen, wird diese wiederum zunachst mit der
Standardformatierung angezeigt. Um die gednderten Formatierungen wiederherzustellen, wahlen Sie
Format = Open format table... und 6ffnen Sie die in Schritt 3 abgespeicherte Formatierungstabelle.

Ubrigens kénnen Sie zu einer Transkription mehrere Formatierungstabellen erstellen, z. B. um die For-
matierung fur die verschiedenen Ausgabemethoden zu optimieren. Weitere Erlduterungen und Beispiele
zum Formatieren finden Sie in der Funktions-Referenz unter ,File > Partitur parameters® sowie unter
~-Format-Meni*.
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C. Ausgeben einer Transkription
Mit dem EXMARaLDA Partitur-Editor lasst sich eine Partitur auf drei verschiedene Arten ausgeben:

1.  Druck: Die Partiturausgabe wird direkt an den Drucker gesendet. Nutzen Sie diese Funktion, wenn
Sie nur einen Ausdruck der Partitur haben mdchten. (Auf einem Macintosh-Rechner kénnen Sie auf
diese Weise zudem Uber die Vorschau-Funktion eine PDF-Datei erstellen.)

2.  RTF-Export: Die Partitur wird in ein RTF-Dokument exportiert. Dieses Dokument kann anschlielend
von den meisten gangigen Textverarbeitungsprogrammen (vor allem von MS Word) gedffnet und
dort weiterverarbeitet (z. B. mit Seitenzahlen, Kopf- und Fuzeilen und/oder zusatzlichem Text ver-
sehen) werden. Anschlielend kann die Druckfunktion des Textverarbeitungsprogramms fir einen
Ausdruck verwendet werden.

3. HTML-Export: Die Partitur wird in ein HTML-Dokument exportiert. Dieses Dokument kann anschlie-
Rend von jedem géngigen Internet-Browser (vor allem MS Internet Explorer und Netscape Naviga-
tor) gedffnet werden. Wenn Sie lhre Transkription mit VerknlUpfungen zu Bild-, Ton- oder Video-
Dateien versehen haben, werden die Plug-ins des Browsers verwendet, um diese Dateien anzuzei-
gen bzw. abzuspielen.

(Allgemeine) Partitureinstellungen

Unabhangig davon, welche der drei Ausgabefunktionen Sie nutzen mdchten, kbnnen Sie gewisse Einstel-
lungen flr die Ausgabe der Partitur vornehmen. Wahlen Sie dazu File = Partitur parameters... . (FUr eine
Beschreibung der einzelnen Optionen siehe ,File > Edit Partitur parameters® im Kapitel ,Funktions-
Referenz®.)

Festlegen des Seitenformates

Wenn Sie |hre Transkription auf dem Drucker oder als RTF-Dokument ausgeben wollen, missen Sie ein
Seitenformat festlegen (der voreingestellte Standard ist DIN A4 hochkant). Um ein anderes Seitenformat
einzustellen, wahlen Sie File 2> Page Setup. Sie bekommen den vom System zur Verfigung gestellten
Dialog zum Einstellen von Seitenformaten angezeigt. Wahlen Sie die gewilnschte Grofe und Orientie-
rung, stellen Sie ggf. die Seitenrander ein und klicken Sie zum Abspeichern auf OK. Diese Einstellungen
werden sowohl fir den Druck als auch fir den RTF-Export ibernommen.

Drucken einer Transkription

Der Partitur-Editor hat eine eigene Druckfunktion. Um eine Transkription zu drucken, wahlen Sie Fi-
le 2 Print... . Sie bekommen den vom System zur Verfigung gestellten Druckdialog angezeigt. Wahlen
Sie den gewiinschten Drucker aus und klicken Sie auf OK — die Transkription wird auf dem Drucker aus-
gegeben.

(Tipp fur Mac OS X—Nutzer: Wenn Sie im Druckdialog unter Mac OS X ,Preview“ wahlen, erhalten Sie
eine PDF-Druckvorschau, die Sie als eigenstandiges PDF-Dokument auf der Festplatte speichern kon-
nen.)

Exportieren einer Transkription in ein RTF-Dokument

Zunachst ein grundsétzlicher Hinweis: RTF ist offiziell ein von Microsoft deklarierter ,Standard“ zum Aus-
tausch von formatierten Textdokumenten zwischen verschiedenen Anwendungen, insbesondere zwi-
schen verschiedenen Versionen der MS Word-Software. Leider funktioniert dieser Standard in Wirklich-
keit nicht immer so, wie es ein Standard eigentlich tun sollte, d. h. das gleiche RTF-Dokument sieht in
verschieden MS Word-Versionen unter Umsténden unterschiedlich aus. Im Falle von Partituren kann dies
so weit fihren, dass die Partitur in manchen MS Word-Versionen nicht mehr vernlinftig lesbar ist. Bedau-
erlicherweise ist es nicht moglich, den RTF-Export in allen denkbaren Konstellationen von MS Word-
Version und Betriebssystem zu testen. Im Anhang C finden Sie einige Beobachtungen und Hinweise zu
gangigen Konstellationen.
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Um eine Transkription in ein RTF-Dokument zu exportieren, kdnnen Sie zunachst einige Optionen festle-
gen, die speziell fur diese Art der Ausgabe relevant sind. Wahlen Sie dazu File 2 Partitur parameters...
und klicken Sie auf den Reiter ,RTF“. (Die Bedeutung der einzelnen Optionen ist in der Funktions-
Referenz unter ,File > Partitur parameters® beschrieben.)

Nach Einstellung dieser Parameter (und ggf. Anderung des Seitenformats, s. 0.) kann der Export in ein
RTF-Dokument erfolgen. Wahlen Sie dazu File = Visualize - Export RTF patrtiture... . Sie erhalten einen
Dialog angezeigt, in dem Sie eine Zieldatei fur den Export auswahlen bzw. neu erstellen kénnen. Klicken
Sie zum Abspeichern auf OK — die Datei liegt jetzt am festgelegten Ort auf der Festplatte und kann mit
MS Word gedffnet werden:

=l xi
Dotel  Bearboken frokht  Erfigen Format Extras  Tobele Eenster 1 ’ r e
DEHSH SRY BT -« 0 QB0 8 B[N]w -0.
A Suondsed + ArislUni = frial Unicade M5 -a -[Flk u EEEEME-IZEERED- -4
e EI N ey S [ ey [ ey oy Y TR
L
=y
A1
B | =7 I o
rw -elnfach-diese-Geschichtedmmer-mit-dem- Tiefounkt. - Und-nochr mak: [:
9 Faipes weop B & B B
1 (2]
Lo |
1
3 o
[ n-Tisfounke -Und-dann-aibt-s-noch-mal-n: niadrigeren Tiefpunkt -+ +a_ |
1
sy
|" kehrkenne diesen-Scheildreck-nich-mehrhoren. Muss-ich-ganz-o
1
i |
1 -
B
tw ehrich-gagen. - Da-stelle ich mich vor-die-Mannschaft, -« Natoricho t/
] R gt LH - s BB 3
By
1

war-das-haute nich-in-Ordnung, -auch-n-der-zweiten Halbzeail.-Abers I:
[ 5

B vaeirits B

|1-;1'|
1

LIEICIE ]

Exportieren einer Transkription in ein HTML-Dokument

Auch hier zunachst ein Hinweis: HTML ist ein wesentlich verlasslicherer Standard als RTF. Dennoch
kann es auch bei der Darstellung von exportierten HTML-Partituren zu kleinen Unterschieden kommen, je
nachdem welcher Browser zur Anzeige verwendet wird. Unter Windows mit der jeweils neuesten Version
des Internet Explorers (z. Z. Version 6.0) und des Netscape Navigators (z. Z. Version 6.1.), die beide
kostenlos beim Hersteller herunter geladen werden kénnen, sind bisher keine Probleme aufgetreten. Die
Mac OS X-Version des Internet Explorers hat hingegen keine vollstandige Unicode-Unterstiitzung, d. h.
dort werden Unicode-Zeichen auferhalb des ASCII-Bereiches unter Umstanden falsch oder gar nicht
angezeigt. Fur den Macintosh ist daher Safari, Netscape 7.0. (die Vorgangerversion hat ebenfalls keine
vollstandige Unicode-Unterstlitzung) oder Mozilla zu empfehlen. Der Omniweb-Browser ist ebenfalls voll
Unicode-fahig, weist aber einige Eigentimlichkeiten auf. Um verknlpfte Video-, Audio- und/oder Bild-
Dateien anzeigen zu kénnen, muss lhr Browser aulRerdem die entsprechenden Plug-ins installiert haben.
Dies ist normalerweise der Fall.

Um eine Transkription nach HTML zu exportieren, kdnnen Sie zunachst einige Optionen festlegen, die
speziell fir diese Art der Ausgabe relevant sind. Wahlen Sie dazu File - Partitur parameters... und Kkli-
cken Sie auf den Reiter ,HTML". Die Bedeutung der einzelnen Optionen ist in der Funktions-Referenz
unter ,File = Partitur parameters” beschrieben.

Nach Einstellung dieser Parameter kénnen Sie den Export nach HTML durchfiihren. Wahlen Sie dazu
File =2 Visualize = Export HTML partiture... . Sie erhalten einen Dialog angezeigt, in dem Sie eine Ziel-
datei fir den Export auswahlen bzw. neu erstellen kénnen. Zusatzlich enthalt dieser Dialog ein Feld, in
dem Sie festlegen kdnnen, ob fiir die Ausgabe Frames verwendet werden sollen:

Framme Options

o frames

" Frames

-9
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Wahlen Sie ,No frames®, wenn Sie keine Verknlpfungen in lhrer Transkription haben oder wenn Sie
mochten, dass verknlipfte Dateien vom Browser in einem eigenen Fenster gedffnet werden sollen. Wah-
len Sie ,Frames®, wenn Sie méchten, dass verknlipfte Dateien vom Browser im gleichen Fenster wie die
Transkription (in einem eigenen Frame) angezeigt werden. Klicken Sie zum Abspeichern auf OK — die
HTML-Datei liegt jetzt am festgelegten Ort auf der Festplatte und kann mit einem Browser geoffnet wer-
den:

a http:/ #wvwe. iz uni-hamburg_de/exmaralda/data/Beispiele/Soerens_Transkript/FramePartiury2/Ma... [H[=] B3
J File  Edit “iew Favoites Tool: Help |
J - s D W a m B
Back Fonward Stop Refresh Home: Search Fawvarites Histary
J Gﬂi:glEvl j B WebSuche »“ Address I@j hitp: £#viaa. rrz. uni-hamb ﬂ o Go
-]
GOT [v] Madonna, eine Frage: Als ich s neus Album gesehen hab, hab ich natldi
GOT [nvk] Zeipegests o
EAM [kowm] zuf 0T
KAM [Bild] ioo0m
KAM [Filn] -\}';ll-.t;l;a-\;s-sv:]miﬂ aus "Wetien dass..?"
KAM [aud] Audivausschniti aus "Wetien dass...?" =
4 | Ll_l
E
|£J ’7 F’ilﬂ Inteinet %

Tipp: Erneutes Exportieren von HTML-Dateien / Direktes Senden an den Browser

Die Funktion ,Reexport HTML® erlaubt es, mit einem einzigen Klick, d. h. ohne erneutes Festlegen der
Zieldatei, eine veranderte Transkription in das zuletzt benutzte HTML-Dokument zu exportieren. Klicken
Sie dazu einfach auf File =2 Visualize - Reexport HTML. Wenn Sie anschlieBend im Browser den Button
Aktualisieren anklicken, wird die veranderte Version der nach HTML exportierten Transkription geladen
und angezeigt.

Noch einfacher geht es Uber die Funktion File = Visualize 2 Send HTM patrtiture to Browser, die auch
Uber die Toolbar zuganglich ist. Diese ,sendet die HTML-Ausgabe mit den gegenwartigen Einstellungen
einfach direkt an lhren Standardbrowser und zeigt sie dort an.

Export eines Transkriptionsausschnittes in ein RTF- oder HTML-Dokument

Haufig moéchte man nicht die gesamte Transkription, sondern nur einen kleinen Teil davon ausgeben. Um
beispielsweise einen Ausschnitt aus der hier benutzten Beispieltranskription auszugeben, der nur aus
den verbalen Spuren der beiden Sprecher und nur aus einen Abschnitt zwischen zwei bestimmten Zeit-
punkten besteht, gehen Sie wie folgt vor:

Markieren Sie zunachst die erste non-verbale Spur, indem Sie auf das zugehérige Spur-Label klicken und
wahlen Sie dann Tier = Hide Tier. Verfahren Sie mit der zweiten non-verbalen Spur genauso. (Um die
ausgeblendeten Spuren spater wieder einzublenden, wahlen Sie Tier - Show all tiers). Markieren Sie
dann den gewinschten Transkriptionsausschnitt, indem Sie auf die zugehdrigen Zeitachsen-Labels kli-
cken und die Maus bewegen:

64 g4 7] 65 )5 7] 95 P3E]

51 ] und aber a was aus der FRAT ¢
521 h=|=ne, (--) |jetz wohnt er nimlich mit seiner SCHW ESter

e S

Um den jetzt markierten Ausschnitt auszugeben wahlen Sie Edit 2 Selection - Selection to RTF... oder
Edit = Selection 2 Selection to HTML... . Die Ausgabe-Parameter kénnen Sie vorher wie oben be-
schrieben einstellen.

1-10
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D. Transkribieren in einem Text-Editor (Simple EXMARaLDA) und Import in den
Partitur-Editor

EXMARaLDA stellt eine Funktion zur Verfliigung, mittels derer Transkriptionen, die nach gewissen einfa-
chen Konventionen in Text-Dateien in vertikaler Notation angefertigt wurden, importieren lassen. Eine
kurze Beschreibung dieser ,Simple EXMARaLDA®-Konventionen finden Sie in der Funktionsreferenz
unter dem Mentipunkt ,File > Import = Import Simple EXMARaLDA".

Auf diese Weise kénnen Sie z. B. auf relativ einfache Weise eine erste ,Rohfassung” einer Transkription
erstellen oder vorhandene Transkriptionen einfacher Diskurse nach EXMARaLDA Uberfiihren.

Schritt 1 — Anlegen einer Transkription in einer Text-Datei

Starten Sie einen beliebigen Texteditor (z. B. MS Notepad auf Windows-Systemen) oder ein Textverar-
beitungsprogramm (z. B. MS Word). Geben Sie dort eine Transkription nach den ,Simple EXMARaLDA*-
Konventionen ein. Achten Sie darauf, jede Zeile mit einem Zeilenendezeichen abzuschliefl3en.

Unbenannt - Editor
MAX: [gestikuliert] Du fillst mir immer <ins Wort. >1>
<Stimmt >1>ja gar nicht.

Speichern Sie diese Text-Datei auf der Festplatte (wenn Sie mit MS Word arbeiten, denken Sie daran,
den Dateityp ,Nur Text* auszuwahlen).

Schritt 2 — Importieren der Text-Datei in EXMARaLDA

Starten Sie den Editor. Wahlen Sie File = Import 2 Import Simple EXMARaLDA (oder klicken Sie auf
das entsprechende Symbol auf der Toolbar). Sie erhalten einen Dialog, der Sie auffordert, die zu impor-
tierende Text-Datei zu spezifizieren. Wahlen Sie die eben erstellte Datei und klicken Sie auf Open. Die
Text-Datei wird importiert und im Editor als Partitur dargestellt:

1] 1 i 3
MAX ] | D fillst mir fvomer [ne Wort.,
MAX ] gesstulor:
TOM ] | Stimwvt | ja zar wicke.

Sollten die Spuren nicht in der von lhnen gewlinschten Reihenfolge erscheinen, wahlen Sie
Tier =2 Change Tier Order... , um die Reihenfolge zu &ndern.

-11
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E. Verknupfen von Ereignissen mit Bild-, Audio- oder Video-Dateien

Die Integration von Audio-, Video- oder Bild-Dateien geschieht in EXMARaLDA Uber Dateiverweise. Die-
se werden bei der Ausgabe nach HTML als Hyperlinks realisiert. Wenn der Browser, mit dem diese
HTML-Datei gedffnet wird, Uber die entsprechenden Plug-ins (d. h. einen Audio-Player, einen Video-
Player bzw. einen Image-Viewer) verfugt, spielen bzw. zeigen diese die zugehoérige Audio-, Video- oder
Bild-Datei.

Im Partitur-Editor selbst gibt es zurzeit noch keine Moglichkeit, solche Dateien abzuspielen bzw. anzuzei-
gen. Das ,Audio-Panel®, das ab Version 1.3. zur vollen Funktionsfahigkeit ausgebaut wird, soll diese Auf-
gabe zukinftig Ubernehmen.

Ein automatisches Alignieren der Transkription mit der zugrunde liegenden Audio- oder Video-Aufnahme
soll ebenfalls zu einem spateren Zeitpunkt méglich sein. Voraussetzung daflr ist, dass im Transkriptkopf
(,Meta Information®) unter ,Referenced File“ eine Angabe Uber die der Transkription zugrunde liegende
Aufnahme gemacht ist und zumindest einige der Zeitpunkte mit korrekten, d. h. auf diese Aufnahme be-
zogenen, absoluten Zeitwerten versehen sind (ndhere Angaben im Kapitel ,Funktionsreferenz® unter ,Ti-
meline > Edit timeline item®).

Schritt 1 — Vorbereiten einer Audio-Datei

Der folgende Transkriptionsausschnitt soll mit einer Audio-Datei verknipft werden. (Die Zeitpunkte wur-
den hier mit absoluten Zeitwerten versehen, das ist aber nicht zwingend notwendig.)

0 0] 1pE 26 '3[

|Maxp1 | Du fillst rair iraver |ins Wort. |
| Wax ] pestituliert |
| Tam fv] Stivernt | ja gav nackt. |

Die zu integrierende Audio-Datei muss in digitalisierter Form vorliegen; die gangigsten Formate hierfiir
sind ,.wav“ und ,.mp3“. Angenommen Sie mdchten beispielsweise den Diskursabschnitt zwischen Zeit-
punkt O und Zeitpunkt 2 mit einem Verweis auf den entsprechenden Ausschnitt aus der Audio-Datei ver-
sehen. Zu diesem Zwecke missen Sie diesen Ausschnitt zunachst vorbereiten: Schneiden Sie die ent-
sprechende Stelle aus der Gesamtaufnahme heraus und speichern Sie sie als eigene Datei auf der Fest-
platte, idealerweise in dem Verzeichnis, in dem auch die Transkription und die spater zu erstellende
HTML-Ausgabedatei liegen.

Schritt 2 — Einrichten einer eigenen Spur fiir Verweise

Zwar kdénnen Sie im Prinzip jedes beliebige transkribierte Ereignis mit einem Datei-Verweis versehen, es
empfiehlt sich aber aus verschiedenen Griinden trotzdem, daflr eine eigene Spur anzulegen. Gehen Sie
dazu wie folgt vor:

Legen Sie zunachst eine neue Spur an (wahlen Sie dazu Tier 2 Add tier...). Da diese Spur nur Audio-
Verweise enthalten soll, ist es nicht sinnvoll, sie einem Sprecher zuzuordnen. Wahlen Sie daher unter
~Speaker” die Option ,[no speaker]“ aus. Wahlen Sie als Spurtyp (,Type®) ,L(ink)*. Als Kategorie (,Cate-
gory“) kénnen Sie z. B. ,aud” (fiir ,Audio®) eintragen:

Speaker: I[nu:u speaker] vI Edit zpeakertable... |

Type: Lirk) =]

Category:  |aud

|_ copy events from: ITIEEI (M [+]) j
ik Cancel |

-12
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SchlieRen Sie den Dialog, indem Sie auf OK klicken (nur dann werden die Anderungen iibernommen).
Die Partitur sollte dann in etwa so aussehen:

0[] |1[13] 2 [26] 3|
Max ] |Du fallst rair iraer |ins Wort. =]
Max [nv] | sesniadiat
Tom fv] Stiramt  |ja gar rdcht.
Tom [nv]
[aud] hd

Schritt 3 — Eintragen des zum Verweis gehoérigen Ereignisses

Der Datei-Verweis, den Sie einrichten mdchten, erstreckt sich Uiber mehrere Zeitpunkte. Sie missen des-
halb die zugehdrigen Ereignisse zusammenlegen. Dazu markieren Sie zunachst die jeweiligen Zellen:

0 [.0] 1[1.3] 2 [2.6] 3
Max ] | D fillst mir iteteer | ine Wort.

Max vl pestifuliert

Tan o] Stiuat | ja gar rcht.
Temn ]

AU B

Wahlen Sie dann Event -2 Merge Events, um aus den zwei Ereignissen eines zu machen. Tragen Sie
dann einen Text in diese Zelle ein (z. B. ,Audio-Verweis1):

0 [0.0] 1[1.3] 2 [24] 3
Max fr] Duf‘ai]lstrrd.ri.mmer|ins Wart.
Max pv] | peshiiudiot

Tam [v] Stimrat | ja gar nicht.
Tam frv]
AUD Aud i rwmil

Schritt 4 — Einrichten des Verweises

Wenn Sie jetzt in das eben eingetragene Ereignis klicken, konnen Sie im Link-Panel den Verweis einrich-
ten. (Sollte das Link-Panel gerade nicht angezeigt werden, wahlen Sie vorab View = Panels - Show
Link Panel.) Wahlen Sie dort dann zunachst ,Audio“ als ,Link-Medium* aus. Klicken Sie dann auf Brow-
se... und suchen Sie im sich nun 6ffnenden Dialog die Audio-Datei, die Sie in Schritt 1 angelegt haben:

% Link Panel EI
~Link

—Ewent description

Aldin-Yerweis

~Link Medium

I.&udin LI

—Link URL

Iu::'l.audicﬂclip‘l .Wa'-.-'l Erowze. . |

-13
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Schritt 5 — Ausgabe als HTML

Wenn Sie jetzt die Transkription in eine HTML-Datei exportieren (s. 0.), ist das eben angelegte Ereignis
mit einem Hyperlink auf die Audio-Datei versehen. Wenn |Ihr Browser den entsprechenden Plug-in instal-
liert hat (was normalerweise der Fall ist), wird er durch einen Klick auf diesen Link die Audio-Datei ab-

spielen.

a http:/ /www.rrz.uni-hamburg.de/exmaralda/data /Eeispiele /GelbeHandschuhe/Gel

=10l x|

Dakei Bearbeiten  Ansicht  Favoriten  Extras 7

4= Zuriick - = - (£ Fat | @ suchen (Gl Favariten 54 | - S -

Adresse I&j htkp: v, rrz.uni-hamburg. defexmaraldadat a/Beispiele/ GelbeHandschuhefGelbeHandschuhe  html j ﬁWechseln 2u

4| |

Google - I 7| Boweb-suche  @gsite-suche | DRk @ seitencinfo - FyAufwans - »
o

Stavridis [GR] Moid g eival edw; Arou
Stavridis [MVE] Foraat rein, geht zurn Tresen. Falit ko sein Hut, i
Stavridis [DUE] Wer izt hier? Hiir rnal
Gionakis [GR] Epeic o &, e, we, we
Gionakis [NVE] Trinkt aus Flasche. Zeigt it der Hand. Lacht
Gionakis [DUB] Wir beide. Cha, cha, cha.

video VIDED (Worsicht! Eine grofie (1ME) MPEG-Dateil [

il

=] [ [ | [4 nternet

-14
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File-Menu

IV.FUNKTIONS-REFERENZ

A. File-Menii

Edit

[:?ENEW...

@ Mew From speakertable. ..

| Open...

Cpen recent

File Wieww  Tier  Ewent

Reskore

Timeline F

Strg+h

Strg+o Untermenii ,,Visualize*

] @ HTML pattiture. ..

O Reexpart HIML parbibure:
Strg+5 0

Skrg+H

Send HTML partiture to browser  Strg+Umschalt+H

—f
W | RTF partiture. ..

Skrg+-R

@ Free stylesheet Yisualization, ..

Untermenii ,,Import*

Simple EXMARALDA. ..

‘J;E. Partitur parameters. .. — HOA
¥
. ? Praat Texkarid
EI Prink... Strg+P
H ELAM..
YWisualize b
=TEl= TEI...
Irnpork k
I£_LI "Trport" HIAT-DOS, ..
Export ]
Exit "Import” ExSync. ..

File > New... D;

Untermenii ,,Export“

E Inkerlinear bext XML, ..

Tl

—— TASH...

(auch (iber die Tastenkombination [Strgl+N] auf dem PC bzw. 38 4N auf dem Macintosh)

Legt eine neue Transkription an. Die neue Transkription besteht aus einer Zeitachse mit zwei Zeitpunk-
ten, einer Sprechertabelle mit einem Sprecher ,X* sowie einer , T“-Spur, der dieser Sprecher und die Ka-
tegorie ,v* (fur ,verbal“) zugeordnet sind. Um die Eigenschaften des eingerichteten Sprechers zu andern,
siehe ,File > Speakertable...“. Um andere Eigenschaften der Spur zu andern, siehe , Tier > Tier proper-

ties..." .

A-1



EXMARaLDA Partitur-Editor — Handbuch File-Menu

Die Spur erhalt die Standard-Formatierung. Um die Formatierung zu andern, siehe ,Format - Format
tier...“ bzw. ,Edit > Preferences...”.

File > New from speakertable...

Generiert eine neue Transkription aus einer Sprechertabelle und einem Stylesheet (siehe auch Anhang
D). Verwendet wird das Stylesheet, das in den Benutzereinstellungen (siehe ,Edit > Preferences...”)
unter ,Speakertable to transcription“ angegeben ist. Ist dort nichts angegeben, wird ein internes Styles-
heet verwendet, das pro Sprecher eine Spur mit Typ , T“ und Kategorie ,v* generiert.

Es wird zunachst der Dialog zum Bearbeiten einer Sprechertabelle angezeigt. Fiigen Sie dort die ge-
wiinschten Sprecher hinzu und bearbeiten Sie deren Eigenschaften (siehe ,File > Speakertable...).
Durch Klicken auf OK wird das Stylesheet angewendet, und Sie erhalten eine neue, leere Partitur mit den
Spuren, die das Stylesheet festlegt.

File > Open... (&3
(auch Uber die Tastenkombination [Strg+O] auf dem PC bzw. [8]+{0] auf dem Macintosh)

e Open a basic transcription from File 5[
Suchen in: I@ Testset LI E ,?IE E

PMC_Format2 il
TELIA, xrul
TELI&_Farmat xml
BABEL _Format.xml TELIA _Format2 . xml
BABEL_Forrrat2 sl Tesst xil

BEISPIEL xnl TIMMS 2l

(=] BEISPIELZ 0l TIMMS_Forrat il
EIZPIEL2_Format xml TROPF xml
EISPIEL_Format.xml TROPF_Format.xml
ALSCH_TranSkripiZ.xml TROPF_Format2 xml
DO A, sl TROPF_Formata zml
MWD S, _Fartriat xml TROPF_Formstd xml
PRIl TROPF_Formsts xml
PMC_Farmat xmil

Dateiname: I Oifhen |
Dttty IE)densibIe Markup Lanouace (XhiL) LI Abbrechen |

Offnet eine gespeicherte Transkription. Es wird der Standard-Datei-Dialog des jeweiligen Systems ange-
zeigt und alle Dateien mit der Endung ,.xml“. Das Start-Verzeichnis entspricht normalerweise demjeni-
gen, das beim letzten Abspeichern einer Transkription verwendet wurde. Wahlen Sie die zu 6ffnende
Datei und klicken Sie auf ,Offnen“. Die Partitur muss anschlieRend einmal vollstandig formatiert werden.
Bei grolReren Transkriptionen kann das mehrere Sekunden dauern. Um eine zugehdrige Formatierungs-
tabelle zu 6ffnen, siehe ,Format - Open format table...“.

Tipp: Wenn Sie in zwei Transkriptionen gleichzeitig arbeiten mdchten, starten Sie den EXMARaLDA Par-
titur-Editor ein weiteres Mal. (Gehen Sie nicht (iber File = New, da mit dem Offnen einer neuen Datei
immer das Schliel3en der zuvor bearbeiteten Datei einhergeht.)

File > Open recent

Ermdglicht den vereinfachten Zugriff auf die zuletzt bearbeiteten Transkriptionen.

File > Restore

Offnet die letzte gespeicherte Fassung der aktuell gedffneten Transkription. Alle Anderungen seit dem
letzten Speichern werden damit verworfen. Dieser Menlpunkt ist nur aktiviert, wenn eine letzte gespei-
cherte Fassung vorliegt.
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File > Save E]
(auch Uber die Tastenkombination [Strg+S| auf dem PC bzw. [s8]+S] auf dem Macintosh)

Speichert die aktuell gedffnete Transkription unter ihrem derzeitigen Namen. Wenn die Transkription
noch keinen Namen hat, in der Titelleiste also ,untitled.xml“ steht, wird automatisch der ,Save as..."-
Dialog gedffnet (s. u.).

File > Save as...

% Save a basic transcription ko file |
Speichern in: I@ Testzet j I
A5 PMIC TROPF _Format?
A5 _Foarmat xml PMWC_Format xml TROPF_Formatd
% BABEL xml PMIC_Fortnat 2 <ml TROPF_Formats

(%] BABEL_Format.xm
(2] BABEL_Format2 xml
] BEISPIEL i

o) BEISPIEL2 xrrl

(%] BEISPIEL2_Farmat xml
(2] BEISPIEL_Farmat sml
@ FALSCH_Transkript2 xml TROPF il

R ADOMM S, il TROPF _Formst xml
19 MADOMMA_Format sl TROPF _Format2 xenl

Kl LT
Dateiname: I Speicherh |
Diateityp: IEx‘tensibIe Markup Language (XhiL) ﬂ Abbrechen |

Speichert die aktuell gedffnete Transkription unter einem neuen Namen. Es wird der Standard-Datei-
Dialog des jeweiligen Systems angezeigt und alle Dateien mit der Endung ,.xml“. Das Start-Verzeichnis
entspricht normalerweise demjenigen, das beim letzten Abspeichern einer Transkription verwendet wur-
de. Wahlen Sie das Verzeichnis, in dem die Transkription gespeichert werden soll, geben Sie den ge-
wulnschten Namen ein (das Suffix ,,.xml“ wird automatisch angehangt, wenn Sie nicht selbst ein Suffix
eingeben) und klicken Sie auf Speichern. Um die zugehdrige Formatierungstabelle zu speichern, siehe
.Format > Save format table as...“.

TELIA il
TELIA_Format.xml
TELIA_Format2 xml
Test.xml

TIMMS ral
TIMMS_Forrmat.xml
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File > Meta Information...

x
+ Fixed sttributes
| Project narme: EXMARaLDA Beispiels 1ir die Homepage
Transcription name: Tropfsteinhihle
Transcription convertion: HIAT
Referenced file: Ihelge.wav Browse. .. |

| User defined attributes

[ atrbute | Value [

Add sttribute

Remove attribute

Up Diowen

Template...

Comment

3ketch von Helge Schneider wmit zahlreichen BEispielenﬂ
“|far "ins Wort fallen™. Die non-werbale Eommunikation
wrde "hinzuqedich:et".‘

|
[ ok | comes |
Ruft einen Dialog auf, in dem die Meta-Information zur Transkription, also z. B. Angaben zum Transkri-
benten, zur Aufnahme, zu den Konventionen etc. eingegeben oder bearbeitet werden kénnen. Die Meta-
Information ist als eine Menge von Attribut-Wert-Paaren organisiert. Einige davon sind fest vorgegeben:

" Project Name: der Name des Projektes.

] Transcription Name: der Name der Transkription. Bei der Ausgabe als HTML oder RTF wird dieser
Name als Dokument-Uberschrift verwendet.

" Transcription Convention: die verwendete Transkriptionskonvention.

" Referenced File: falls vorhandenen, die zugehérige digitalisierte Audio- oder Video-Datei. Ein Klick
auf den neben diesem Feld liegenden ,Browse...“-Button 6ffnet einen Dialog, mit dem diese Datei
gesucht und zugeordnet werden kann.

" Comment: ein freier Kommentartext zu Aufnahme und Transkription.
Zusatzlich kénnen beliebig viele benutzerdefinierte Attribute festgelegt werden. Um ein neues, benutzer-

definiertes Attribut hinzuzufiigen, klicken Sie auf Add attribute. In der Tabelle wird ein neues Attribut-
Wert-Paar hinzugefligt, dass Sie in den entsprechenden Textfeldern bearbeiten kénnen.

Mit einem Doppelklick markieren Sie den Inhalt einer Tabellenzelle, sodass Sie ihn anschlieRend per
Tastatureingabe iiberschreiben kdnnen. Beenden Sie die Eingabe stets mit [Enter].

Sollte der Platz unter ,Value® nicht ausreichen, klicken Sie auf den Button mit den drei Punkten (...), um
ein groleres Fenster zu erhalten, in dem Sie editieren kénnen.

Um ein benutzerdefiniertes Attribut zu entfernen, wahlen Sie es in der Tabelle aus und klicken Sie auf
Remove attribute.

Um die benutzerdefinierten Attribute aus einer anderen Transkription zu Ubernehmen, klicken Sie auf
Template und suchen Sie im dann erscheinenden Datei-Dialog die betreffende Transkription auf lhrem
Rechner.

Um die Reihenfolge der Attribute zu verandern, markieren Sie das Attribut, das Sie bewegen mdchten
und klicken Sie auf Up bzw. Down.

Um die gednderte Meta-Information zu Gbernehmen, verlassen Sie den Dialog, indem Sie auf OK klicken.
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File-Menu

File > Speakertable...

@

-é'_w Edit Speakertable

S

| Al speaker
Hlspra 511 —_—

ISPK2 [5-2] Retnove speaker

[Roes e =
properties

- | Fixed attribut
i Abbreviation: IL
1| |se [iate =l
[ Language:
| Language(s) used: GER

First languagels).
Second language(s):
Edit languzages

o | Catnment

horbar "auber Aten”™ (vermutlich aus
Aufrequng/Nervositat {ber den Unterrichtsbesuch
durch TIMSS bzw. die Videoaufzeichmanig).

Spricht relativ laut, nit bayerischem Akzent, ist d

[ User defined attribite:

T atrioute | Vale

Remove attribute

Up Down

Collect sttributes

Tetrplate. .

Ruft einen Dialog zum Eingeben und Editieren von Informationen Uber die Sprecher auf. Im obersten Teil
der Sprechertabelle sind die Sprecher aufgelistet. Um einen neuen Sprecher anzulegen, klicken Sie auf
Add speaker. Um einen vorhandenen Sprecher aus der Liste zu entfernen, wahlen Sie den entsprechen-
den Eintrag in der Liste aus und klicken Sie auf Remove speaker.

Um die zu einem Sprecher gehorenden Informationen einzugeben oder zu andern, wahlen Sie diesen
zunachst aus der Liste aus. Unter ,Speaker properties* werden dann die bereits vorhandenen Informatio-
nen angezeigt. Die Sprechertabelle ist als eine Menge von Attribut-Wert-Paaren organisiert. Einige davon

sind fest vorgegeben:

" Abbreviation: das Sprecher-Kirzel, das (bei aktivierter Option ,Auto®, siehe ,Tier > Edit Tier proper-

ties“) auch fur die Bezeichnung der Spuren (Spurlabel) verwendet wird.

" Sex: das Geschlecht des Sprechers.

" Languages: die Erst- (L1) und Zweitsprache(n) (L2) des Sprechers sowie die Sprache(n), die er in
der Transkription verwendet (,Languages used®).

" Comment: ein freier Textkommentar zum Sprecher.

Um die Eintrdge unter ,Languages” zu andern, klicken Sie auf Edit languages... . Sie erhalten folgenden

Dialog:

& Edit languages

&l lang

GED - Gade
GEE - Geez
GEG - Gengle

GEl - Gebe
GEJ - Gen-ghe
GER - Yiwam

GEM - Geman Deng
GED - Georgian
GEQ - Geme

GEH - German, Hutterite

GEL - Kag-fer-jiir-koor-ror-us-zuksun

rLanguagels) used

| Add >

Remove

GER

Femove

| ~First languagers)

Add > PAF
PAD

Remuove

~Secohd lahguagels)

GER

Cancel
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Um einem Sprecher eine Sprache zuzuordnen, wahlen Sie sie in der Liste links aus. Klicken Sie dann auf
den entsprechenden Add-Button. Um eine Sprache zu entfernen, wahlen Sie sie in der entsprechenden
Liste rechts aus und klicken Sie auf den zugehoérigen Remove-Button. (Bitte beachten Sie: Die in der
Liste zur Verfiigung stehenden Sprachcodes wurden von ,Ethnologue® (http://www.ethnologue.com/)
erarbeitet. Suchen Sie die Webpage auf, sofern Sie genauere Informationen Uber diese Liste wiinschen.)

Zusatzlich kénnen fir die Sprecher beliebig viele benutzerdefinierte Attribute festgelegt werden. Um ein
neues, benutzerdefiniertes Attribut hinzuzufiigen, klicken Sie auf Add afttribute. In der Tabelle wird ein
neues Attribut-Wert-Paar hinzugefiigt, dass Sie in den entsprechenden Textfeldern bearbeiten kdnnen.

Mit einem Doppelklick markieren Sie den Inhalt einer Tabellenzelle, sodass Sie ihn anschliefsend per
Tastatureingabe iiberschreiben konnen. Beenden Sie die Eingabe stets mit [Enter].

Sollte der Platz unter ,Value® nicht ausreichen, klicken Sie auf den Button mit den drei Punkten (...), um
ein groleres Fenster zu erhalten, in dem Sie editieren kénnen.

Um ein benutzerdefiniertes Attribut zu entfernen, wahlen Sie es in der Tabelle aus und klicken Sie auf
Remove attribute.

Um alle fiir andere Sprecher dieser Transkription bereits definierten Attribute flr den aktuellen Sprecher
zu Ubernehmen, klicken Sie auf Collect.

Um die benutzerdefinierten Attribute aus einer anderen Transkription zu tUbernehmen, klicken Sie auf
Template und suchen Sie im dann erscheinenden Datei-Dialog die betreffende Transkription auf Ihrem
Rechner.

Um die Reihenfolge der Attribute zu verandern, markieren Sie das Attribut, das Sie bewegen mochten
und klicken Sie auf Up bzw. Down.

Um die geanderte Sprechertabelle zu ibernehmen, verlassen Sie den Dialog, indem Sie auf OK klicken.

File > Page setup...

Seite einrichten H

— Papier
Ge ARG
Qugle: IAutomalisch auswahlen j_‘
—Augrichtung———  — Rander (rmm)
& Hochformat | | Links:  [25.4mm | Rechts: [25.4mm
" Querfomat DOben: |25,4mm Unter: I25,4mm

Ok I Abblechenl Drucker... |

Offnet einen Dialog zum Festlegen der Seitenmafe, die beim Drucken und bei der RTF-Ausgabe ver-
wendet werden. Aussehen und Funktionsweise dieses Dialogs variieren recht stark von Betriebssystem
zu Betriebsystem, entsprechen aber in etwa dem jeweils dort gebrauchlichen Standard-Dialog.


http://www.ethnologue.com/
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File = Partitur parameters...

Offnet einen Dialog zum Festlegen von Parametern fiir die Ausgabe als Partitur auf einem Drucker, als
RTF-Datei, als HTML-Datei oder als XML-Datei (siehe ,File - Visualize - ...“). Der Dialog ist in vier Un-
terpunkte unterteilt:

% Partitur Parameters x|

Gereral Output | RTF | HTmL |

iord boundaries

7 Respect word boundaries

Word Boundaries: [0 Change.. |

heasures

Horizontal Talerance:

Yertical Tolerance:

Additional label space: | | f ' 1 ' |
o] 10 20 a0

Miscellaneous

¥ Remove Ernpty Lines
IV hurmber Partitur Aress
[+ Smooth right boundaries
¥ Save Space

Cancel |

Unter dem Reiter ,Break® werden Parameter fur den Zeilen- bzw. Seitenumbruch festgelegt:

Respect word boundaries: legt fest, ob beim Umbruch auf Wortgrenzen (Leerzeichen, Apostroph,
Bindestrich) Ricksicht genommen werden soll, d. h. ob Umbriiche mitten im Wort verhindert werden
sollen.

Horizontal tolerance: legt einen Toleranzbereich fur die Umbruchbreite fest. Je grofRer dieser Wert
ist, desto weniger werden kleinere Einheiten beim Umbruch ,zerstiickelt’, desto mehr Partiturflachen
ergeben sich aber auch.

Vertical tolerance: legt einen Toleranzbereich fir den Seitenumbruch fest. Sollten Sie mit dem Sei-
tenumbruch Probleme haben (das kann z. B. in Abhangigkeit vom Drucker vorkommen), passen Sie
diesen Wert an.

Additional Label Space: legt einen zusatzlichen Leerraum zwischen den Spurlabels und dem ersten
Eintrag fest.

Remove Empty Lines: legt fest, ob durch den Umbruch entstandene Leerzeilen entfernt werden
sollen.

Number Partitur Areas: legt fest, ob die Partiturflachen (,Partitur Areas®) durchnummeriert werden
sollen.

Smooth right boundaries: legt fest, ob die rechten Partiturflachenbegrenzungen auf eine Linie ge-
glattet werden sollen (funktioniert nur bei Drucker- und RTF-Ausgabe, nicht bei HTML-Ausgabe).

Save space: legt fest, ob bei der Ausgabe nach Umbruch an Leerzeilen ,gespart” werden soll. Die
Partiturnummerierung wird in diesem Falle leicht eingertckt:

Option ,Save Space” deaktiviert: Option ,Save Space* aktiviert:
1
B A ] Dmeizmebmn Mlare anaf des toten Dlavoes Ficte,
- - A [en] Thirtea met ot the dead man's chest. |
E&nm Dreizebn M waf des toten Marmes Ficte. &
Afen]  Thirteenmen onthe deadman's chect. AR Teheiie ) Eoak, wi st Gt wisder & dar
A [en] (feriffe 1) Oy, mhat & smellhere dthe care.
[]

ARl [(schrdiffelt’)) Bosh, wrat. stirvdt dat wieder i der
A [en] (spatfe §) Oy, wehat a smme 1 beere & hoe caore,
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% Partitur Parameters <]
Bresk i General Output | RTFI HTML I
I

IV Include titmeling in autput

[V Put timeline outside frame

Fratne:
Sides: W Left ¥ Right ¥ Top ¥ Bottom

[5alid

Colaor:

Style: = |

Mizcelaneau:
’VIV Prepend meta-info & speakertable

et

Unter dem Reiter ,General Output® werden weitere Parameter festgelegt, die fiir alle Ausgabeformen

(also

Drucker, RTF, HTML und XML) gelten:

Include timeline in output: legt fest, ob die Eintrage in der Zeitachse (Nummerierung und/oder abso-
lute Zeitangaben) in die Ausgabe Gbernommen werden sollen.

Put timeline outside frame: legt fest, ob die Eintrdge in der Zeitachse bei der Ausgabe innerhalb
oder aulRerhalb der Partiturflache erscheinen sollen.

Frames: legt fest, wie die Partiturflachen umrahmt werden sollen. ,Left*, ,Right, ,Top®, ,Bottom® legt
fest, ob links, rechts, oben, unten eine Rahmenlinie gezeichnet wird. ,Colour” legt die Farbe dieser
Rahmenlinie fest (klicken Sie auf den Button, um einen Dialog zur Farbauswahl zu erhalten). ,Style®
legt fest, ob die Rahmenlinien durchgezogen (,Solid®), gestrichelt (,Dashed“) oder gepunktet (,Dot-
ted®) sein sollen.

Prepend Meta Information & Speakertable: legt fest, ob die Meta-Information und die Sprechertabel-
le mit ausgegeben werden sollen oder nicht (nur bei RTF- und HTML-Ausgabe). Beachten Sie, dass
fur die HTML-Ausgabe zusatzlich relevant ist, ob und welches Stylesheet in den Benutzereinstellun-
gen (siehe ,Edit > Preferences...“) unter ,Head to HTML" angegeben ist.

Beispiele:
o) 113 2[26] e e . . L
ax 1] D Fallst mir immerins Wort Die Eintrage in der Zeitachse wurden in die Aus-
ax[ny] gesniution ' gabe Ubernommen (auflerhalb des Rahmens).
om [v] Stimmt  ja gar nicht. Die Partiturflache ist mit einer durchgehenden
D Audio Verweiz1 Linie umrahmt.
ol 1113] 2[25] S . o
ax[v] D fillst mir immer ins Wort Die Eintrage in der Zeitachse wurden in die Aus-
ax[ny] gesthulion ' gabe Ubernommen (innerhalb des Rahmens). Die
om [v] Stimmt  ja gar nicht Partiturflache ist mit einer durchgehenden Linie
UD Audio-Verweis1 umrahmt.
Max [v]  Du i].rl'ﬂ mir immer ins Wort. Die Eintrage in der Zeitachse wurden nicht in die
Max [ny]  gesuiuliort _ _ _ Ausgabe bernommen. Die Partiturflache ist mit
f;‘;ﬁ; [v] Audio. Vereis1 Stimmt - ja gar nicht. einer gestrichelten Linie umrahmt.
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% Partitur Parameters x|

Bresk | General Cutput RTF | i |

[l
Critical Size percentage: 1 1 1 1 | R L%
90 91 92 93 94 95 96 97 94 93100
1
Right triatin buffer: H L T e (R B B R |
a 5 10 13 20

¥ Calculste Page Breaks

¥ Glue adiacert everts DAORD 971
[ Glue empty everts (WORD 971)
™ Use CellFit-Parsmeter OWORD 20020

cees |

Unter dem Reiter ,RTF* werden Parameter festgelegt, die speziell fur die RTF-Ausgabe verwendet wer-
den. Die RTF-Ausgabe ist insofern problematisch, als die Berechnungen von Java nicht hundertprozentig
mit den Berechnungen von MS Word Ubereinstimmen. Hierdurch kann es zu Verschiebungen und ,abge-
schnittenen® Zeichen kommen. Einige der hier aufgefiihrten Parameter dienen dem Zweck, diese Unge-
nauigkeiten auszugleichen (siehe hierzu auch den Abschnitt ,Exportieren einer Transkription in ein RTF-
Dokument® im Tutorium).

Critical Size Percentage: legt fest, ab wann die GroéRRe eines Eintrages in einer Partiturzeile als ,kri-
tisch“ zu behandeln ist, d. h. ab wann die Mechanismen zum Ausgleichen der Ungenauigkeiten an-
gewendet werden sollen. Die voreingestellten 95% haben sich als verniinftiger Wert erwiesen. Sie
kénnen diesen Wert aber bei Bedarf herauf- oder heruntersetzen.

Right margin buffer: legt einen Puffer am rechten Rand der Partiturflache fest, der geeignet ist, eini-
ge Ungenauigkeiten in der Berechnung auszugleichen. Wenn die Optionen ,Glue adjacent IT ele-
ments“ und ,Glue empty IT elements” (s. u.) deaktiviert sind, kann dieser Wert 0 betragen. Ansons-
ten sollte er auf einen Wert zwischen 5 und 20 gesetzt werden.

Calculate Page Breaks: legt fest, ob Seitenumbriiche fir das RTF-Dokument berechnet werden
sollen.

Glue adjacent events: legt fest, ob benachbarte Eintrage in der Partiturzeile zusammengelegt wer-
den sollen, sofern der erste die kritische GroRe erreicht hat. Fir MS Word 97 muss diese Option
gewahlt werden. Fir MS Word 2000 hat sie den kleinen Nachteil, dass sich die Synchronverhaltnis-
se moglicherweise um eine Winzigkeit verschieben, dafir aber den Vorteil, dass z. B. durch Syn-
chronisation ,auseinander gerissene” Worter wieder ,zusammengesetzt® werden. Verwenden Sie
diese Option unter MS Word 2000 jedoch nicht, wenn Sie mit Umrahmung von einzelnen Elementen
arbeiten.

Glue empty events: legt fest, ob leere Eintrage in der Partiturzeile mit dem vorangehenden Element
zusammengelegt werden sollen. Verwenden Sie diese Option nicht, wenn Sie mit farbiger Unterle-
gung oder Umrahmung von einzelnen Elementen arbeiten.

Use CellFit-Parameter: legt fest, ob der ,CellFit“-Parameter benutzt werden soll. Die Aktivierung
dieser Option hilft, Fehler zu vermeiden, die beim Lesen exportierter RTF-Dateien mit MS Word
2002 (= Word XP) auftreten.
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% Partitur Parameters E

Ereak' General Outputl RTF HTMLI

rHypertext
IV Make Links
p Make anchors

M Use java script

fickh

" Don't make line breaks

& Pixelwidth |10 v g
i 500 1000 1500 2000

0K | Cancel |

Unter dem Reiter ,HTML“ werden Parameter festgelegt, die speziell fir die HTML-Ausgabe verwendet
werden:

" Make links: legt fest, ob im Transkript vorgenommene Verknipfungen in HTML als Hyperlinks reali-
siert werden.

] Make anchors: legt fest, ob die Partiturflachen mit Ankern, also mit Verweiszielen fiir eine Referen-
zierung von aufden, versehen werden sollen. Um mit der Wortlisten-Ausgabe (s. u.) arbeiten zu kon-
nen, muss diese Option aktiviert sein.

. Use JavaScript: legt fest, ob JavaScript-Funktionen (zur Verkniipfung der Spurlabel mit der Spre-
chertabelle) verwendet werden sollen.

" Don’t make line breaks: Die Auswahl dieser Option erzeugt eine Endlos-Partitur, d. h. die Partitur
wird nicht in Zeilen umgebrochen.

" Pixel width: Die Auswahl dieser Option sorgt dafiir, dass die Partitur auf die angegebene Breite (in
Pixeln) umgebrochen wird. Fiir gangige Bildschirme ist ein Wert zwischen 400 und 600 geeignet.
Um mit der Wortlisten-Ausgabe (s. u.) arbeiten zu kénnen, muss die Partitur auf diese Weise um-
gebrochen werden.

File > Print...
(auch (iber die Tastenkombination [Strgl+P| auf dem PC bzw. [8]+[P] auf dem Macintosh)

Drucken H
— Dirucker
Hame: Eigenzchaften |
Status: Bereit
Tup AdobePS dorobat Digtiller
Standaort.  C:A\WINMTProfiles\all Users\Desktoph* pdf
Kommentar: ™ Ausgabe in Datei
— Diuckbersich Exemplare

' alle Azahl der Exemplare: |1 3:
(o SEE yo: |1 e |1
) Warkiemung @

0K | abbrechen |

Offnet einen Dialog zum Ausgeben der Transkription auf einen Drucker. Das Aussehen und die Funkti-

A-10
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onsweise des Dialogs variieren recht stark von Betriebssystem zu Betriebsystem, entsprechen aber in
etwa dem jeweils dort gebrauchlichen Standard-Dialog flir das Drucken.

File > Visualize > HTML partiture...
(auch Uber die Tastenkombination +[H| auf dem PC bzw. [8] + [H auf dem Macintosh)

| % Set the HTML file for export x|
Speichern i Iuﬁ Helge_neu LI E
|7 Meusr Ordner rFrame Cptions |
) phe
() wav

Helge_Audia il
Helge_Audio_p il
Heldge_Turn bt
Helge_|Litterance hitml
Helge_tard Html
Helgs_ord_|html
Helge_yord_t html

& No frames

" Frames

Dateiname: I Speichern |
Dateityp: IHypertext Markup Language (HThL) LI Abbrechen |

Offnet einen Dialog zum Exportieren der Transkription in eine Partitur in HTML. Es wird der Standard-
Datei-Dialog des jeweiligen Systems angezeigt und alle Dateien mit der Endung ,.html“. Das Start-
Verzeichnis entspricht normalerweise demjenigen, das beim letzten HTML-Export einer Transkription
verwendet wurde.

Wahlen Sie das Verzeichnis, in das der HTML-Export erfolgen soll und geben Sie den gewilinschten Na-
men ein (das Suffix ,.html“ wird automatisch angehangt, wenn Sie kein eigenes Suffix eingeben). Wahlen
Sie die Option ,Frames®, wenn Sie mdchten, dass in der Transkription vorhandene Verknipfungen als
Hyperlinks in einem gesonderten Frame realisiert werden. Wahlen Sie die Option ,No Frames®, wenn lhre
Transkription keine Verknipfungen enthalt oder wenn Sie die Hyperlinks in einem neuen Fenster gedffnet
haben moéchten. Klicken Sie dann auf ,Speichern®, um den Export durchzufiihren. Sie kdnnen die Datei
anschliellend mit jedem beliebigen Browser 6ffnen.

Die Ausgabe von Meta-Informationen und Sprechertabelle kann Uber ein Stylesheet, das unter ,Edit >
Preferences - Stylesheets” als ,Head to HTML® angegeben ist, parametrisiert werden. Siehe dazu auch
Anhang D ,EXMARaLDA und Stylesheets*.

File > Visualize > Reexport HTML partiture...

Wiederholt den zuletzt durchgefiihrten Export in eine HTML-Partitur, d. h. die zuletzt exportierte HTML-
Datei wird durch die aktualisierte Version der Transkription ersetzt. Um das Ergebnis anzusehen, geniigt
es dann, auf den ,Aktualisieren®-Button des Browsers zu driicken.

File = Visualize > Send HTML partiture to browser... Q,
(auch Uber die Tastenkombination +[0] + H auf dem PC bzw. s8] + [] + [H| auf dem Macintosh)

Sendet die nach HTML exportierte Transkription direkt an lhren Standard-Browser, d. h. das vorherige
Abspeichern und anschlieRende Offnen der HTML-Datei entfallt auf diese Weise. Um die HTML-Datei
nachtraglich unter einem eigenen Namen abzuspeichern, benutzen Sie einfach die entsprechende Funk-
tion Ihres Browsers.
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File > Visualize & RTF partiture... ll

Offnet einen Dialog zum Exportieren der Transkription in eine RTF-Datei. Es wird der Standard-Datei-
Dialog des jeweiligen Systems angezeigt und alle Dateien mit der Endung ,.rtf*. Das Start-Verzeichnis
entspricht normalerweise demjenigen, das beim letzten RTF-Export einer Transkription verwendet wurde.
Wahlen Sie das Verzeichnis, in das der RTF-Export erfolgen soll und geben Sie den gewtlinschten Na-
men ein (das Suffix ,.rtf* wird automatisch angehangt, wenn Sie kein eigenes Suffix eingeben). Klicken
Sie dann auf ,Speichern®, um den Export durchzufiihren. Sie kénnen die Datei anschlieRend mit jedem
beliebigen Textverarbeitungsprogramm, das RTF-Dateien lesen kann (also vor allem MS Word), 6ffnen
und weiterbearbeiten.

File = Visualize = Free stylesheet visualization...

Wendet ein Stylesheet (siehe auch Anhang D) auf die Transkription an und 6ffnet einen Dialog zum Spei-
chern des Ergebnisses der Stylesheet-Transformation. Verwendet wird das Stylesheet, das unter ,Edit >
Preferences” im Reiter ,Stylesheets” unter ,Free stylesheet visualization“ angegeben ist.

File 2 Import 2> Simple EXMARaLDA...

Offnet einen Dialog zum Importieren einer Transkription im txt-Format, die nach den ,Simple
EXMARaLDA*-Vorgaben angefertigt wurde. Diese Vorgaben lauten wie folgt:

SIMPLE EXMARaLDA-Konventionen

1. Jede Zeile beginnt mit der Sigle des Sprechers der AuRerung, gefolgt von einem Doppelpunkt.
Zwei Sprecher dirfen sich nicht dieselbe Sigle teilen, und die GroR- und Kleinschreibung in den
Sprechersiglen ist relevant (d. h., dass beispielsweise ,Tom*“ und ,TOM* als zwei verschiedene
Sprechersiglen behandelt werden):

2.  Pro Zeile wird eine AuRerung transkribiert. Jede Zeile wird mit einem Zeilenendezeichen (carriage
return) beendet. Leerzeilen zur Ubersichtlicheren Strukturierung sind zulassig.

TOM: Hallo, Tim!
TIM: Hallo, Tom.

3.  Eine etwaige Transkription von non-verbalen Handlungen, die die AuRerung begleiten (d. h. paral-
lel zu ihr stattfinden), kann vor der AuRerung in eckigen Klammern vorangestellt werden.

TOM: [winkt] Hallo, Tim!
TIM: [winkt] Hallo, Tom.

4.  Eine etwaige Annotation der AuBerung (z. B. eine Ubersetzung) kann der AuBerung in geschweif-
ten Klammern nachgestellt werden. Dies geschieht in der gleichen Zeile, in der auch die dazugeho-
rige AuRRerung steht.

TOM: [winkt] Hallo, Tim! {Salut, Tim!}
TIM: [winkt] Hallo, Tom. {Salut, Tom!}

5.  Sich Uberlappende AuRerungsteile verschiedener Sprecher werden mit spitzen Klammern einge-
fasst. Der schlieRenden spitzen Klammer folgt eine beliebige Zeichenkette, der die Uberlappung
indiziert, und eine weitere schlieBende spitze Klammer. Die Indizierung sollte aus Griinden der
Lesbarkeit durch Zahlen erfolgen, diese missen jedoch nicht aufsteigend geordnet sein (sie mis-
sen noch nicht einmal Zahlen sein, notwendig ist nur, dass sie eindeutig sind). Fir eine bessere
Lesbarkeit, kénnen die sich (iberlappenden AuBerungsteile mittels Leerzeichen oder Tabulatoren
eingeruckt werden.
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TOM: [winkt] Hallo, <Tim!>1> {Salut, Tim!}
TIM: [winkt] <Hallo>1>, Tom. {Salut, Tom!}

6. Eckige, geschweifte und spitze Klammern dirfen nur in der oben definierten Art und Weise ver-
wendet werden und sollten sonst in der Transkription nicht vorkommen.

Wenn Sie eine Transkription nach diesen Vorgaben in einem Texteditor oder einem Textverarbeitungs-
programm angefertigt und dort als ,reinen Text* (in der vom System festgelegten Standardkodierung oder
einer Unicode-Kodierung) gespeichert haben, kdénnen Sie diese Textdatei u-
ber File 2 Import 2 Import Simple EXMARaLDA in den Partitureditor importieren. Suchen Sie dazu in
dem sich éffnenden Dialog die Datei, wahlen Sie die geeignete Kodierung aus und klicken Sie auf ,Off-

nen-.

ES Import a basic transcription from a Simple EXMARaLDA text file ﬂ
Suchen in: I[:I SimpleExmaralda LI IfF

Beispiell txt ~Char encoding

BefSpfe”am |isystem-Detaut) =
Recert Bieigpisl2 txt [System-Detautt]

Beispiel2_UTFS bt TE—

S 7-Bit-a5CI

=| Beispiel3_BEixt 150-8850-1 (Standsrd Latir)

Beispisl3_UTFa txt e

C e i LITF-16 (Eig Endian)

WAtk LITF-16 (Little Endian)

Dateiname: I Otfnen |
Deteityp:  |plaintext (TKT) | awbrechen |

Wenn der Import gelingt, erhalten Sie eine Partiturreprasentation Ihrer Transkription. Wenn der Import
misslingt, erhalten Sie eine Fehlermeldung der folgenden Art:

jexmaralda error : x|

File does nok seem ko be valid: Error at line 0.
Mo speaker separatar,

i Meine Rede

In der ersten Zeile wird die Zeilennummer der Originaldatei genannt, in der ein Fehler aufgetreten ist. Die
zweite Zeile benennt den Fehlertyp (hier: ,no speaker separator”, d. h. es wurde vergessen, die Spre-
chersigle mit einem Doppelpunkt abzuschlieRen) und die dritte Zeile gibt die fehlerhafte Zeile selbst wie-
der. Offnen Sie die Text-Datei in einem Texteditor, beheben Sie den Fehler, speichern Sie und versuchen
Sie anschlie3end erneut, die Datei zu importieren.

File 2> Import > TASX...

Offnet einen Dialog zum Importieren einer TASX-Datei. Suchen sie die zu importierende Datei in diesem
Dialog, und klicken Sie auf Offnen. Das Konvertieren erfolgt iiber XSL-Sheets und ist deshalb relativ
langsam. Bei sehr groRen Transkriptionen kann es mehrere Minuten dauern. Nach dem Konvertieren
erhalten Sie zunachst einen ,Cleanup-Dialog“, in dem Sie die TASX-Transkription nach bestimmten Krite-
rien bereinigen kénnen:
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£ Cleanup

¥ Remove empty events:

—1
v Eridge gaps zmaller than | H L L O L 3
1] 250 a00 Fal 1000

|7 Remove unused timeling tems

V¥ Remove gaps

Ok | Cancel

" Remove empty events: entfernt alle leeren Ereignisse, d. h. Ereignisse, die zwar vorhanden sind,
aber keinen Text enthalten.

. Bridge gaps: Uberbriickt kleinere Liicken zwischen Ereignissen. Die maximale GréRe der zu Uber-
brickenden Licken kénnen Sie Uber den Schieberegler auf einen Wert zwischen 0 und 1.000 Milli-
sekunden einstellen. Das Uberbriicken solcher Liicken verringert zwar etwas die Genauigkeit der
Transkription, ist aber fur die Darstellung als Partitur von Vorteil.

] Remove unused timeline items: Entfernt unbenutzte Zeitpunkte, d. h. Zeitpunkte, die weder An-
fangs- noch Endpunkt irgendeines Ereignisses sind, von der Zeitachse

] Remove gaps: Entfernt Licken in der Transkription, d. h. Intervalle, fur die keine Ereignisse einge-
tragen sind.

Unter Umstanden wird danach noch dieser Dialog angezeigt:

% Stratify Tier Ed
Tier TIES (type="a', category="eng']
iz not stratified. Please chooze a method for stratifying this tier.

" Stratity by distribution
Ok |

Dieser Dialog sagt Ihnen, dass sich in bestimmten Spuren Ereignisse befinden, die sich innerhalb einer
Spur Uberlappen (,the tier is not stratified“). Um Transkriptionen als Partitur darstellen zu kénnen, darf es
solche sich innerhalb einer Spur tUberlappenden Ereignisse aber nicht geben. Wahlen Sie eine der beiden
angebotenen Optionen:

" Stratify by deletion: 16scht jeweils eines (das zweite) von zwei sich Uberlappenden Ereignissen
" Stratify by distribution: verteilt jeweils eines (das zweite) von zwei sich Uberlappenden Ereignissen
auf eine oder notigenfalls mehrere neue Spuren.

Anschlieftend wird die Partitur im Editor angezeigt.

File > Import > Praat TextGrid...

Offnet einen Dialog zum Importieren einer in Praat erstellten Transkription. Wahlen Sie das zu importie-
rende TextGrid aus und klicken Sie auf Offnen. Die Transkription wird lhnen anschlieRend als Partitur im
Editor angezeigt.
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File 2 Import > ELAN...

Offnet einen Dialog zum Importieren einer in ELAN (EUDICO Linguistic Annotator) erstellten Transkripti-
on. Wahlen Sie die zu importierende Transkription aus (diese hat normalerweise die Endung .eaf) und
klicken Sie auf Offnen. Nach dem Konvertieren erhalten Sie zunachst einen ,Cleanup-Dialog®, in dem Sie
die Transkription nach bestimmten Kriterien bereinigen kénnen (siehe dazu ,File = Import > Import
TASX...). Anschlie®end wird Ihnen die Transkription als Partitur im Editor angezeigt.

File 2 Import - TEI...

Offnet einen Dialog zum Importieren einer Transkription, die gemaR den Richtlinien der Text Encoding
Initiative (TEI) in XML kodiert ist (siehe dazu Schmidt, Th. 2004: Time based data models and the TEI
Guidelines for Transcriptions of Speech. Erscheint als Arbeit zur Mehrsprachigkeit, Serie B.). Wahlen Sie
die zu importierende Transkription aus, und klicken Sie auf Offnen. Nach dem Konvertieren erhalten Sie
zunachst einen ,Cleanup-Dialog“, in dem Sie die Transkription nach bestimmten Kriterien bereinigen
kénnen (siehe dazu ,File > Import = Import TASX...“). Anschlielend wird die Transkription als Partitur
im Editor angezeigt.

File 2 Import = ,,Import“ HIAT-DOS...

Offnet einen Dialog zum ,Importieren von HIAT-DOS-Daten.

Beachten Sie bitte, dass die Anfiihrungszeichen rund um das Wort ,Import“ auf einen wichtigen
Umstand hinweisen sollen:

" Es ist prinzipiell nicht méglich, eine perfekte EXMARaLDA-Entsprechung fir ein gegebenes HIAT-
DOS-Datum zu finden. Mittels der ,Import‘-Funktion erhalten Sie nur eine Annaherung, die in der
Regel manuell nachbearbeitet werden muss.

" Die Funktion wurde fir die HIAT-DOS-Daten am Sonderforschungsbereich ,Mehrsprachigkeit* der
Universitat Hamburg entwickelt. Daraus erklaren sich z. B. die Ersetzungsregeln flir skandinavische
Sonderzeichen. Die am SFB erstellten HIAT-DOS-Daten arbeiten weder mit Intonationsspuren noch
mit Unterstreichungen. Insofern liegen keine Erfahrungen vor, was mit diesen Elementen beim ,Im-
port* passiert.

& "Import" HIAT-DOS x|

Drateien

Tranzkriptoate: || Browsze...
Infodatei: Browese...
Siglendate: Browwse...

Mehtode zur Berechnung der Synchronizationspunkte
™ Linke UND Rechte Grenzen verwenden

= plur linke Grenzen verwenden
Zonstiges

[ Lécher entfernen (hei nachbearbeitetern Umbruch)

Zeichen ersetzen: [AadoloRhadesE . Andern. |

Ik Cancel |

Um eine HIAT-DOS-Datei zu ,importieren®, fillen Sie die entsprechenden Felder aus:

] Transkriptdatei: Dies ist die Datei mit dem eigentlichen Transkripttext. HIAT-DOS gibt solchen Da-
teien standardmaRig die Endung ,.dat". Klicken Sie auf Browse... um die Datei mittels eines Datei-
Dialogs zu suchen. (Hinweis: Das ,Import‘-Ergebnis ist wesentlich besser, wenn Sie HIAT-DOS-
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Dateien verwenden, in die noch keine Umbriiche eingearbeitet sind.)

" Infodatei: Dies ist die Datei, die die Informationen aus dem Transkriptkopf enthalt. HIAT-DOS gibt
solchen Dateien standardmafig die Endung ,.inf. Klicken Sie auf Browse... um die Datei mittels ei-
nes File-Dialogs zu suchen. Wenn keine Datei angegeben wird, kann der ,Import* trotzdem durch-
geflihrt werden — der Transkriptkopf bleibt dann leer.

" Siglendatei: Dies ist die Datei, die die Namen und Siglen der Sprecher enthalt. HIAT-DOS gibt sol-
chen Dateien standardmaRig die Endung ,..sig”. Klicken Sie auf Browse... um die Datei mittels eines
Datei-Dialogs zu suchen. Wenn keine Datei angegeben wird, kann der ,Import* trotzdem durchge-
fuhrt werden — die Sprechertabelle wird dann automatisch generiert, Sprechersiglen und -namen
kénnen im Partitur-Editor nachgetragen werden.

] Methode zur Berechnung der Synchronisationspunkte: Bei der Berechnung der Synchronisations-
punkte konnen entweder nur die linken oder die linken und rechten Grenzen von Eintragen in den
HIAT-DOS-Spuren verwendet werden. Verlassliche Synchronisationspunkte sind eigentlich nur die
linken Grenzen. Wenn sie zusatzlich die rechten Grenzen verwenden, reduziert sich aber unter Um-
standen der Nachbearbeitungsaufwand.

" Locher entfernen: Diese (zeitaufwendige) Methode empfiehlt sich, wenn Sie eine HIAT-DOS-Datei
mit nachbearbeitetem Umbruch ,importieren“ méchten.

" Zeichen ersetzen: HIAT-DOS benutzt eine nicht ANSI-konforme Kodierungsmethode fiir deutsche
Umlaute. Diese Zeichen werden standardmafig ersetzt (aullerdem auch einige Ersatzzeichen fir
skandinavische Sonderzeichen). Wenn Sie die zu ersetzenden Zeichen andern mdchten, klicken
Sie auf Andem... , um folgenden Dialog angezeigt zu bekommen:

L (B297) s & (228
™ (3482 1w O (214)
“(8221) 1 (246)
5 (353w 1) (2209
O (129 » 0 (252)
4(225) » B (223) FETETE
81038) A (197) Remove all
T2k a (229) Standard
$ (36) @ (216) 4|
# (35) o @ (248)

+ (43) 1 /E (108)

% (37) s 28 (230)

& (655331 b 0 (252)

(82181 b & (233)

|
To be replaced: I_ (Enter clecimal Unicodz number
Replacement: I— (Enter dfecimal Unicode hmber)
Al |
Dk | Cancel |

In der Liste sind alle Ersetzungen aufgefliihrt, einmal als Glyph, dahinter in Klammern die zugehdrige
dezimale Unicode-Zahl. Um eine einzelne Ersetzung zu entfernen, markieren Sie diese in der Liste und
klicken Sie Remove. Um die gesamte Liste zu I6schen, klicken Sie auf Remove all. Um nur die deutschen
Umlaute und das ,R“ ersetzen zu lassen, klicken Sie auf Standard. Um eine Ersetzung hinzuzufligen,
geben Sie die entsprechenden dezimalen Unicode-Zahlen in die Felder ,To be replaced” und ,Replace-
ment“ ein und klicken Sie dann auf Add!. Verlassen Sie den Dialog liber OK, um die Anderungen zu -
bernehmen.
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File 2 Import < ,Import“ ExSync Data...

Offnet einen Dialog zum Importieren von Daten, die aus dem syncWRITER ausgelesen wurden (,Ex-
Sync Data). Die genaue Funktionsweise ist in Anhang A aufgefiihrt.

File > Export =2 Interlinear Text XML...

Exportiert eine XML-kodierte Fassung der Partiturdarstellung (,Interlinear Text) der aktuellen Transkripti-
on. Dabei werden die Einstellungen unter ,File > Partitur parameters...“ und die der aktuellen Formatie-
rungstabelle (siehe auch ,Format - Edit format table...) verwendet. Die XML-Kodierung erfolgt konform
zur DTD (,interlinear-text.dtd“), deren jeweils aktuelle Fassung Uber den Download-Bereich der EXMA-
RaLDA Homepage zuganglich ist. Diese Funktion ist fur viele Benutzer des Partitur-Editors vermutlich
eher uninteressant. Sie ist fir Benutzer gedacht, die (mit XSL-Stylesheets oder Ahnlichem) eigene Visua-
lisierungen entwickeln mdchten.

File > Export > TASX...

Exportiert die aktuelle Transkription ins TASX-Format. Da die Konvertierung tber Stylesheets erfolgt, ist
sie relativ langsam und kann bei groRen Transkriptionen mehrere Minuten dauern. Die exportierte Datei
kann im TASX-Annotator gedffnet und weiterbearbeitet werden. Bitte beachten Sie, dass ein solcher Ex-
port nur dann sinnvoll ist, wenn Sie zumindest einige Punkte der Zeitachse mit absoluten Zeitwerten ver-
sehen haben (nicht vorhandene absolute Zeitangaben werden interpoliert).

File > Export > Praat TextGrid...

Exportiert die aktuelle Transkription ins Praat-Format. Die exportierte Datei kann in Praat gedffnet und
weiterbearbeitet werden. Bitte beachten Sie, dass ein solcher Export nur dann sinnvoll ist, wenn Sie zu-
mindest einige Punkte der Zeitachse mit absoluten Zeitwerten versehen haben (nicht vorhandene absolu-
te Zeitangaben werden interpoliert).

File > Export = ELAN...

Exportiert die aktuelle Transkription ins ELAN-Format. Die exportierte Datei kann mit ELAN ge6ffnet und
weiterbearbeitet werden. Bitte beachten Sie, dass ein solcher Export nur dann sinnvoll ist, wenn Sie zu-
mindest einige Punkte der Zeitachse mit absoluten Zeitwerten versehen haben (nicht vorhandene absolu-
te Zeitangaben werden interpoliert). Aulerdem sollten Sie unter der Meta-Information eine zugrunde lie-
gende Mediendatei angegeben haben (siehe ,File > Edit Meta Information®).

File > Export 2> AIF...

Exportiert die aktuelle Transkription ins Atlas Interchange-Format. Die exportierte Datei kann mit den
Werkzeugen aus dem AG-Toolkit, also z. B. TableTrans, gedtffnet und weiterbearbeitet werden.

File - Exit

Schliel3t die aktuelle Transkription und beendet den Partitur-Editor. Sofern in der Transkription bzw. in der
Formatierungstabelle Anderungen vorgenommen wurden, wird jeweils abgefragt, ob die Anderungen in
der Transkription bzw. in der Formatierungstabelle gespeichert werden sollen.
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Edit-Menu

B. Edit-Menii

Edit “iew Tier Ewent Timeline F

Hnjl Copy Skrg+C
@ Paste Skrg+Y
ﬂ' L | Skrg+s

Selection b
Exktras ]
[T

- Preferences...

Edit > Copy

Untermentii ,,Selection

[ Seleckion ko new

Left part to new

Right part ko new

W | Selection ta RTF...

@ Selection bo HTML, ..

Untermenii ,,Extras”

Fattes 3lug branscriptions. ..

=
S’ ExSync Event Shrinker .,

s ] i1
%,
%

Clean up. ..

(auch (iber die Tastenkombination + [C] auf dem PC bzw. [38] + [C| auf dem Macintosh)

Kopiert den momentan markierten Text in die Zwischenablage. Von dort aus kann er in jede andere An-
wendung, die Uber eine entsprechende ,Einfiigen“-Funktion (,Paste®) verfligt, eingefligt werden. Text in

verschiedenen Spuren wird dabei durch getrennt.

Beispiele:

Markierung im Editor

ooy |I|I_'|j 18|

Bax f] |Lm fillst nur imemer [ins Wort.

Blax [nv] | sestikuliert

Stianmt  ja zar mcht.

Tom [ma]

AUD Andio-Varwas1

1[13) 118

stopir inumer ins Wort.

RSSOV 13 mar tucht.

Inhalt der Zwischenablage nach Copy text

Stimmt ja gar nicht.

Du fdllst mir immer ins Wort.
gestikuliert

Stimmt

Audio-Verweisl
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Edit-Menl

Markierung im Editor

ooy

|I|I.‘|j 125 :||

Max f] [[n 55

Max [na] | pesikuliert

Tom p]

St [ja zar mucht.

Tom ]

AlUD Andio-Verwes1

Edit > Paste

(auch Uber die Tastenkombination + M auf dem PC bzw. [33] + V] auf dem Macintosh)

t mmirfiheey |1115 Wort. :I

=l

Inhalt der Zwischenablage nach Copy text

fallst mir

Flgt Text aus der Zwischenablage an der momentanen Cursorposition ein.

Edit > Cut

(auch Uber die Tastenkombination +[X auf dem PC bzw. [33] + [X| auf dem Macintosh)

Schneidet den momentan markierten Text aus und legt ihn in die Zwischenablage.

Edit = Search in events...

Offnet einen Dialog, um Ereignisse nach bestimmten Zeichen bzw. Zeichenketten zu durchsuchen:

% Search in events

Search string: das

Search Ares |

|7 Caze zenzitive search

IHIAT

Ll (0] 41 |L[V]

~Result

11 tems found.

[rn] L [2up] L [v] L [akz] [Bilder] L [ny] L [K] 51 [sup] 51 [v] 5-1 [akz] 5-2 [sup] 5-2 [v] 5-2 [akz] 5-3

L

I =

[+ ]

L[
L[]
L[
L[
L[]

Jetzt russ ich nachschauen, wie ﬁ genau i
D-fark als ¥, und dann hamer M was die M
Dfark als ¥, *und dann hamer das, was die b
Javwolll Das letzte. Und haben jetzt nicht a
Das soll ¥ sein. Und wie wiel D-Mark ich zahle, |
Und jetzt midchte ich mal wissen: Wie ist 1
Stephan, wie rechnest Ou

L [nv] notier m Gesprochene gleichzeitig stichwor
L [m] tippt auf|[das] Tafelbild

L [rv] notiertesprochene gleichzeitig stichwar

S-2[W] Ja ne Gebdhr! = » DafLir man s urntausch

I 1L

zoto

Save..

Close |

Das zu suchende Zeichen bzw. die zu suchende Zeichenkette wird im Feld ,Search string“ eingegeben.
Nutzen Sie das virtuelle Keyboard, um Zeichen einzugeben, die nicht Gber die Tastatur zuganglich sind.

,Search area“ bezeichnet die zu durchsuchenden Spuren. Beim Offnen des Such-Dialogs bestehen diese
standardmaRig aus allen nicht ausgeblendeten Spuren. Um den Suchbereich zu verandern, klicken Sie

auf Search area: . Sie erhalten folgenden Dialog:
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i Select Tiers x|
Unzelected Tiers Selected Tiers =
[An] (TIES) -1 [zup] (TIE3O)

= |
[Bilder] (TIE4) o | S [akz] (TIE3)
L [akz] (TIES) 5.2 [sup] (TIE2)
L [rw] (TIE1 D) 5-2 [v] (TIEZ)
L [sup] (TIEG) 5.2 [akz] (TIE33)
L [K] (TIEF) " | 53 [2up] (TIET1)
L[] (TIE) 53 [v] (TIES)
53 [akz] (TIES)
5.4 [sup] (TIE14)
S-4 [v] (TE12)

S-4 [akz] (TIE13)
S5 =ml (TIFTRY ll

Ok | Cancel

In der linken Liste sind die nicht zu durchsuchenden Spuren (,Unselected tiers®) aufgefihrt, in der rechten
Liste die zu durchsuchenden Spuren (,Selected tiers®). Klicken Sie auf die einfachen Pfeil-Buttons
(> bzw. <), um einzelne Spuren von einer Liste in die andere zu transferieren. Klicken Sie auf die doppel-
ten Pfeil-Buttons (>> bzw. <<), um alle Spuren einer Liste in die andere zu transferieren. Beenden Sie
den Dialog, indem Sie auf OK klicken (nur dann werden Anderungen (ibernommen).

Uber ,Case sensitive search® wird festgelegt, ob bei der Suche GroR- und Kleinschreibung berlicksichtigt
werden soll. (Ist die Option mit einem Hakchen versehen, wird Gro3- und Kleinschreibung bericksichtigt.)

Klicken Sie auf Search, um die Suche gemaf den festgelegten Parametern durchzufiihren. Das Ergebnis
der Suche wird in der Liste ,Result* angezeigt. Die gefundenen Vorkommen werden dabei in roter Schrift
und mit einer Umrahmung kenntlich gemacht.

Um zu einem gefundenen Vorkommen in der Partitur zu springen, markieren Sie dieses in der Liste und
klicken Sie auf Go fo.

Um alle Suchvorkommen in einer Text-Datei abzuspeichern, klicken Sie auf Save... . Sie werden aufge-
fordert, einen Dateinamen festzulegen. Die Datei mit diesem Namen kénnen Sie anschlieend mit jedem
Unicode-fahigen Texteditor 6ffnen. Um den Such-Dialog zu schlieRen, klicken Sie auf Close.

Edit > Replace in events...

Offnet einen Dialog, zum Suchen und Ersetzen von Zeichen bzw. Zeichenketten in Ereignissen.

% Replace in events x|

das

Search string:

des

Replace string:

Search Area: | [hn] L [sup] L [+] L [akz] [Bilder] L [mv] L [K] 5-1 [sup] S-1 [¥] 5-1 [akz] 5-2 [sup] 5-2 [v] 5-2 [akz] 5-3

searchl |

Replace zll | 11 terns found,

~Result

L [v] Jetzt muss ich nachschauen, wie genau ws

L[] Ddark als ¥, - und dann hamer m was die M
L [v] Odark als ¥. - und dann hamer das, was die M
L[] Jawoll! Das letzte, Undhabenjetztnichta
L [v] Dassall™ sein. Und wie viel D-Mark ich zahle, |
L [v] Und jetzt mdchte ich mal wissen: Wie ist 1
L [v] Stephan, wie rechnestDu I
L [nv] notierd m Gesprochene gleichzeitig stichwor Goto

L [nv] notierd m Gesprochene gleichzeitig stichwor™——
L [rv] tipptaufTaferiId

5% [v] Ja. ne Gebdihr! = » Dafﬂrmansumtausch

IHIAT

¥
o

]

Replace

T — b

Cloze |
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Das zu suchende Zeichen bzw. die zu suchende Zeichenkette wird im Feld ,Search string“ eingegeben,
das Zeichen bzw. die Zeichenkette, die sie ersetzen soll, im Feld ,Replace String“. Die Festlegung der
.>earch Area“ erfolgt wie oben (,Edit > Search in events...”) beschrieben.

Suchen und Ersetzen erfolgt immer unter Beriicksichtigung der Gro3- und Kleinschreibung.

Um zu einem gefundenen Vorkommen in der Partitur zu springen, markieren Sie dieses in der Liste und
klicken Sie auf Go fo.

Um einzelne Vorkommen zu ersetzen, klicken Sie zunachst auf Search! . Die Vorkommen werden in der
Liste ,Result* aufgefiihrt. Um ein einzelnes Vorkommen zu ersetzen, markieren Sie dieses und klicken
Sie auf Replace.

Um alle Vorkommen zu ersetzen, klicken Sie auf Replace all! . Bitte beachten Sie: Dieser Vorgang lasst
sich nicht riickgangig machen! Es empfiehlt sich daher, die Transkription vor dem Ersetzen zu speichern
und den Vorgang ggf. mittels File = Restore (s. 0.) wieder aufzuheben.

Edit = Selection

Dieses Untermen( enthalt Funktionen, die sich auf einen zuvor ausgewahlten Bereich (,Selection®) der
Transkription beziehen. Grundsatzlich besteht die Selektion aus allen eingeblendeten Spuren. Sie lasst
sich auf zwei verschiedene Arten (auch kombinierbar) reduzieren: Ganze Spuren entfernen Sie aus der
Selektion, indem Sie sie mittels der Funktion Tier - Hide tier ausblenden. Sollen nur ganz bestimmte
Zeitpunkte in die Selektion aufgenommen werden, markieren Sie den entsprechenden Ausschnitt in der
Zeitachse mit der Maus (klicken und ziehen).

Beispiel:

Ausgangstranskription:

Die Selektion umfasst alle Zeitpunkte der sieben Spuren.

o || 1 |:| 4 3 6 7 ES 9|

KLA ] Oh, da kommt |einer. Eommt noch |ei.r|er. [(mstet])) Wal? Ol dat kann ja nich wahy sein. Ja, ({Panse]) halla ;I
KLA [eng] |oh, comehody's coming, | Another one coming. | ((roughs)) Whit ? (h, that can't be toze.

KLA [nv]

ERW p] [lastet]). Och nee, dat jowet ja nich. Hallo Elans, wat machs du denn hier |inna Tropfiteinhéhle?

ERW [eng] [ougksT) Ohimo, T dome't believe 1. Hello Elas , what are o dodng here i the cave?

EREW [nv] | |

i | | =

Nach dem Ausblenden der non-verbalen Spuren und Ubersetzungsspuren:

Die Selektion umfasst alle Zeitpunkte der verbliebenen drei Spuren

o 1 |1 1 4 3 5 7 ES 9|

KLA ] Oh, da komumt |einer. |K.ommt noch |einer. |((lnstet)) Wal? Oh, dat kann ja nich wahy sein. Ja, ({Panse]) halla ;I
FRW ] ((lmstet)). Och nee, dat jpret ja nich. Hallo Klans, wat machs da denn hier |inma Tropfiteinhshle?
| (el | [~

Nach dem Markieren eines Abschnitts auf der Zeitachse:

Die Selektion umfasst nur die Zeitpunkte 4 bis 6 der drei verbliebenen Spuren

o 1 |1 1 L] 3 3 |
KLA k] Oh, da kommt |einer. |K.ommt noch |einer. [{8 y O, dat kann ja nich wahy sein. Ja, ({Panse)) hallo ;I
EEW k] ((lmstet)). Cich nee, dat jparet ja nich. Hallo Klans, wat machs &1 denn hier |inma Tropfiteinhéhle?
[aud] |

L

In einem zweiten Schritt wird nun festgelegt, was mit der zuvor getroffenen Selektion geschehen soll. Hier
bietet der Partitur-Editor insgesamt flnf verschiedene Optionen:
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Edit > Selection = Selection to new

Macht aus der momentanen Selektion eine neue Transkription. Fur das obige Beispiel ¢) also:

[ I 2 b] |
ELA p] | (iloastet)) Wal? Oh, dat kanm ja rmch wahy sein. ;I
ERW ] Cich nee, dat jraret ja rach.

[aud] =

Edit > Selection > Left part to new

Teilt die Transkription an der aktuellen Cursorposition oder Markierung und macht aus dem links davon
stehenden Teil eine neue Transkription.

Edit > Selection 2 Right part to new

Teilt die Transkription an der aktuellen Cursorposition oder Markierung und macht aus dem rechts davon
stehenden Teil eine neue Transkription.

Edit = Selection = Selection to RTF

Exportiert die momentane Selektion in eine RTF-Partitur (siehe ,File 2> Visualize > Export
RTF partiture...).

Edit > Selection = Selection to HTML

Exportiert die momentane Selektion in eine HTML-Partitur (siehe ,File > Visualize > Export
HTML partiture...”).

Edit > Extras 2 Glue transcriptions...

Hangt eine zweite Transkription an das Ende der derzeit im Editor gedffneten Transkription an. Sie wer-
den zunachst aufgefordert, die anzuhdngende Datei auszuwahlen. AnschlieRend wird ein Dialog ange-
zeigt, mit dem Sie die Zuordnung von Spuren in der vorhandenen (,Transcription 1’') und der anzuhan-
genden Transkription (,Transcription 2’) vornehmen kénnen. Die einander zugeordneten Spuren werden
im rechten Textfeld (,Mappings’) angezeigt.

% Glue transcriptions x|
Transcription 1 Tranzcrigtion 2 Mappings

HLA [v] =-= KL& [¥]
KLA [akz] HLA [akz] HL& [akz] =-= KLA [akz]
LA [en] HLA& [en] et HL& [en] =-» KLA [en]
WL, [fr] WLA [1r] Remove WLA& [fr] =-= KL& [fr]
ERMY ] ERA [+] ERY [v] =-= ERWY [v]
ERVY [akz] ERY [akz] ey ERVY [akz] =-= ERY [akz]
ERIA [eh] ERMY [2h] ! AutocPostion || EFW[en] =-= ERW [en)]
ERAY [fr] ERAA [r] ERAY [fr] =-= ERAY [fr]
KLA [k] KLA [K] Auta (Cortent) LA [K] <-= KLA [K]
[aud] [@Ld] [aud] =-= [aud]
(k] [kha] [pho] =-= [phal

Ok Cancel

Um die Zuordnungen einzeln (,per Hand“) vorzunehmen, nutzen Sie die folgenden Funktionen:

" Add: Um einzelne Zuordnungen vorzunehmen, markieren Sie je einen Eintrag in den beiden linken
Textfeldern und klicken Sie dann auf Add, um dieses Paar dem rechten Textfeld hinzuzufligen.
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" Remove: Um eine Zuordnung riickgangig zu machen, markieren Sie den betreffenden Eintrag im
rechten Textfeld und klicken Sie dann auf Remove.

" Clear: Um alle Zuordnungen zu I6schen, klicken Sie auf Clear.

Um die Zuordnungen automatisch vorzunehmen, gibt es zwei Méglichkeiten:

" Auto (Position): Nimmt eine Zuordnung der Spuren gemaR ihrer Position vor, d.h. Die erste Spur in
Transkription 1 wird der ersten Spur in Transkription 2 zugeordnet, die zweite Spur in Transkription
1 der zweiten Spur in Transkription 2, usw.

" Auto (Content): Nimmt eine Zuordnung der Spuren gemal ihrer Eigenschaften vor, d.h. Spuren mit
gleichem Sprecherkiirzel und gleicher Kategorie werden einander zugeordnet.

Es ist moglich, die manuelle und die automatische Zuordnung miteinander zu kombinieren. Wenn Sie die
Zuordnung vollstandig vorgenommen haben, klicken Sie auf OK, um die beiden Transkriptionen zusam-
menzufihren.

Edit > Extras - ExSync Event Shrinker

Schrumpft nach dem Import eines ExSync-Dokumentes die Ereignisse automatisch gemaf ihrer typogra-
phischen Ausdehnung (siehe Anhang A ,Importieren von syncWRITER-Daten®).

Edit > Extras > Clean up...

Offnet einen Dialog, der einige Optionen zum automatischen Bereinigen (,Clean up®) der Transkription
anbietet:

_éft Cleanup 5'

— |
)% g0 0 g o0 ngo 0 | @B
o 250 =00 750 1000

v EBridge gaps smaller than

[V Remove unused timeling tems

IV Remove Qaps

e |

" Remove Empty Events: Aktivieren Sie diese Option, wenn Sie leere Ereignisse, d. h. Ereignisse die
keinen Text enthalten, aus allen Spuren entfernen mochten.

" Bridge gaps smaller than: Aktivieren Sie diese Option, wenn Sie die Zeitachsen-Eintrage durchgan-
gig mit absoluten Zeitwerten versehen haben und in der Zeitachse Liicken schlieBen mochten, die
kleiner als ein vorgegebener Wert in Millisekunden sind. Um diesen Wert einzustellen, bewegen Sie
den Schieberegler auf den gewtinschten Wert.

" Remove unused timeline items: entspricht dem Menlpunkt ,Timeline > Remove unused timeline
items* (s. u.).

" Remove gaps: entspricht dem Menupunkt , Timeline > Remove gaps® (s. u.).

Edit & Preferences...

Offnet einen Dialog zum Festlegen von benutzerdefinierten Standard-Formatierungen. Der Dialog ist in
zwei Unterpunkte unterteilt:
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Edit-Menl

Unter dem Reiter ,Fonts“ werden Default-Schriftsatze festgelegt:

% Preferences

Stylesheetsl Auto Savel

X
Change... |
[ S |

Defautt tier font: Tirmes Mew Roman
Default general purpose font: Arial Unicode MS Change...
QK | Cancel |

Der ,Default tier font* ist der Standard-Schriftsatz, den neue Spuren automatisch zugewiesen bekommen

bzw. in dem eine gedffnete Transkription zunachst formatiert wird.

Der ,Default general purpose font“ ist der Schriftsatz, der standardmafRlig zur Anzeige der Zeichen im
virtuellen Keyboard und im Textfeld tber der Partitur verwendet wird. Hier sollte ein Schriftsatz ausge-
wahlt werden, der mdglichst viele Unicode-Bereiche abdeckt. Am besten erfiillt diese Voraussetzungen
derzeit der Schriftsatz ,Arial Unicode MS*. Eine Freeware-Alternative dazu, die allerdings bzgl. einiger
Unicode-Bereiche noch liickenhaft ist, ist der vom ,Summer Institute of Linguistics” entwickelte ,,Gentium*®

(vgl. http://www.sil.org/~gaultney/gentium/).

Klicken Sie auf Change, um einen Dialog angezeigt zu bekommen, in dem Sie einen anderen Schriftsatz

(,Font*) auswahlen kénnen.

£ Set the default tie

Chooze a font:

Arial Black

Arial Marrow

Arial Unicode M
Batang

Book Articua
Bookman Old Style
Century

X|

[

(84

Um die Anderung zu speichern, beenden Sie Ihre Eingabe mit OK. (Die Einstellungen werden beim Be-
enden des Editors gespeichert und beim nachsten Start wieder geladen.)


http://www.sil.org/%7egaultney/gentium/
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Unter dem Reiter ,Stylesheets” werden verschiedene Stylesheets festgelegt (siehe auch Anhang D):

x
Farts § - Auta Savel
Head to HTML: | Change... |

Speakertable to transcription: I Change... |
Transcrigtion ta format takle: I Changs... |
Free stylesheet visualisation: I Change... |
HIAT Literance List to HTRML: I Change... |

QK | Cancel |

Im Einzelnen sind dies:

" Head to HTML: Das Stylesheet, das bei der HTML-Ausgabe zur Darstellung der Meta-Information
und der Sprechertabelle verwendet wird. Der Eintrag kann leer gelassen werden; es wird dann ein
internes Default-Stylesheet verwendet.

. Speakertable to transcription: Das Stylesheet, das unter dem Menipunkt ,File > New from spea-
kertable...” zur Generierung einer neuen Transkription aus einer Sprechertabelle verwendet wird.
Der Eintrag kann leer gelassen werden; es wird dann ein internes Default-Stylesheet verwendet.

= Transcription to format table: Das Stylesheet, das unter dem Menipunkt ,Format > Apply styles-
heet“ zur Formatierung der Transkription verwendet wird. Der Eintrag kann leer gelassen werden;
es wird dann ein internes Default-Stylesheet verwendet.

" Free stylesheet visualization: Das Stylesheet, das unter dem Menupunkt ,File - Visualization >
Free stylesheet visualization® zur Anwendung kommt.

" HIAT utterance list to HTML: Das Stylesheet, das unter dem Menipunkt “Segmentation > HIAT
Segmentation - Utterance List (HTML) zur Anwendung kommt.

Um die Eintrage zu andern, klicken Sie auf den jeweiligen Change...-Button. Sie erhalten einen Datei-
Dialog, in dem Sie das betreffende Stylesheet auswahlen kdnnen.

x|
Suchen in; Iﬁ HIAT_Styleshests ;I T ? =

HIAT_ES_FormatTabledBasic Transcription xsl
HIAT_ES_Infofenster xal
HIAT_FormatTabledBaszicTranscription.xs!
HIAT_Speakertable2BasicTranscription x sl

HIAT _Spkthl2BT_W_AKZ_K_MNY_SUP_PHO_MR x=l
HIAT_Spkthi2BT_W_AKT_K_SUP_MM.xsl
PAIDUS_FormstTabledBasicTranscription xsl

Dateiname: I Choose

Dateityp: I}(SL Stylesheets (* xal, * xst) j Abbrechen |

B-8
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Unter dem Reiter ,Auto save® kdnnen sie festlegen, ob Sie stets automatisch eine Sicherungskopie der
gerade in Bearbeitung befindlichen Transkription erstellen lassen méchten:

x

Fonts I Stylesheets I

[~ Enable Auto Save

Auto Save Filename: IEKMAR&LDA_AmDBackup

Auto Save Path: IC:'IDDkumente und Einstellungentannette Browse. .. |

Auto Save Interyal: [ HI LI T T T B I T O T Y B I 1711
a 10 20 30 40 a0 &0
], | Cancel |

Das automatische Erstellen einer Sicherungskopie schiitzt Sie im Falle eines Systemabsturzes vor gra-
vierenden Datenverlusten, da Sie das Transkript Gber die Sicherungskopie wiederherstellen kénnen. Es
handelt sich um eine universale Sicherungskopie, die jeweils beim Offnen einer Transkription mit den
aktuellen Daten eben dieser zurzeit gedffneten Transkription Gberschrieben wird.

Im Einzelnen kénnen Sie folgende Einstellungen vornehmen:

" Enable auto save: Das Erstellen automatischer Sicherungskopien wird aktiviert.
" Auto save file name: Akzeptieren Sie den vorgeschlagenen Dateinamen oder andern Sie ihn

" Auto save path: Akzeptieren Sie den vorgeschlagenen Speicherort der Sicherungsdatei oder wah-
len Sie Browse... , um den Speicherort zu verandern.

" Auto save interval: Das automatische Kopieren der Daten in die Sicherungskopie erfolgt in Interval-
len. Je kirzer die Speicherintervalle desto besser sind Sie vor Datenverlusten geschitzt, desto hau-
figer steht jedoch auch die Kapazitat lhres Arbeitsspeichers auf dem Prifstand. Der voreingestellte
»Zehn-Minuten-Takt“ hat sich als vernlinftig erwiesen. Sie kénnen diesen Wert aber bei Bedarf her-
auf- oder heruntersetzen.
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C. View-Meni

Yiew Tier Ewent Timeline Faorme

v Show grid
Show panels b Untermenii ,,.Show Panels*
v Kevboard
'::?% iZhange scale constant, .. .
Link panel
Show special characters Segmentation panel
v fudio panel
v Color emply events
Praat panel

View = Show Grid

Legt fest, ob Gitternetzlinien in der Partitur angezeigt oder ausgeblendet werden. Eingeblendete Gitter-
netzlinien erleichtern die Navigation in der Partitur und machen die Einteilung in Ereignisse deutlicher:

T 2 o 10 11

5 v |Det &rf e ja. |Detﬁrdstﬁrg:§tt och trikigt, raen alla dv glada fir vi har f8tt thop den |hi=.i.r |a.ff‘a'.mnnu!

5 [d] E: ist! ja. " |Es ist es ist gran und langareiliz, aber alle sind froh, weil wir jet=t diese Jache mistande gebracht haben!
5 [e] Lok

M ] i Stockholm idag? Rolig.
N [] in Stockholm? Lustig.

N [e]

[aud]

T

Ausgeblendete Gitternetzlinien verbergen die Tabellenstruktur der Benutzeroberflache und lassen sie so
Jpartiturférmiger erscheinen, insbesondere wenn zusatzlich als Hintergrundfarbe flr leere Ereignisse
weill gewahlt wird (siehe hierzu auch ,Format-Meni“ und ,View-MenU*):

7 2 o 10 11

5 Det &= ja. Diet & det 4 grdtt ach trikist, men alla &r glada for+i har fatt thop den by affiren no!
5[l Es istf ja. E; ist o5 ist gram und langareiliz, aber alle sind froly weil wir jet=t diess Sache mistande gebracht habenl
5 Il it
M ] 1 Stockboln 1 dag? Boliz,
M [d] nS5tockholn? Lustiz.
N [c]
[aud]

B

View - Show panels > Keyboard

Legt fest, ob das virtuelle Keyboard angezeigt oder ausgeblendet wird. Ausblenden lasst sich das Key-
board auch Uber das Kreuz in der rechten oberen Ecke seines Fensters.

View - Show panels > Link panel

Legt fest, ob das Panel zum Einrichten von Verknupfungen (,Link Panel“) angezeigt oder ausgeblendet
wird. Ausblenden lasst sich das Link Panel auch Giber das Kreuz in der rechten oberen Ecke seines Fens-
ters.
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View =2 Show panels > Segmentation panel

Legt fest, ob das Panel zum Uberprifen von Segmentierungen (,Segmentation Panel“) angezeigt oder
ausgeblendet wird. Ausblenden Iasst sich das Segmentation Panel auch Uber das Kreuz in der rechten
oberen Ecke seines Fensters.

View 2 Show panels - Audio panel

Legt fest, ob das Panel zum Abspielen von Audio-Dateien (,Audio Panel“) angezeigt oder ausgeblendet
wird. Ausblenden lasst sich das Audio Panel auch Uber das Kreuz in der rechten oberen Ecke seines
Fensters.

View = Show panels - Praat panel

Legt fest, on das Panel zur Kommunikation mit Praat (“Praat Panel”) angezeigt oder ausgeblendet wird.
Das Praat Panel ist generell nur unter Windows-Systemen verfiigbar; der Meni-Eintrag sollte in anderen
Systemen daher nicht erscheinen.

View =2 Change scale constant...

Zeigt einen Dialog zum Andern der Skalierungskonstante an.

% Scale constant Ed

i |
Su:aleu:u:unstant:§|||||||||||.H..|....|§
05 0 5 10

(8] | Cancel |

Die Skalierungskonstante ist der Wert, der fiir die Anzeige im Editor zur eingestellten Punktgrofie der
Schriften hinzuaddiert wird. Eine Skalierungskonstante von +5 flihrt zum Beispiel dazu, dass Text, der als
10 pt formatiert ist, in einer Grofle von 15 pt angezeigt wird. Benutzen Sie den Schieberegler, um die
Skalierungskonstante zu andern und klicken Sie dann auf OK. Die Partitur muss anschlielend neu forma-
tiert werden — dies kann unter Umstanden einige Sekunden dauern.

View - Show special characters

Zeigt Leerzeichen (Spatien) in der Partitur als kleine Punkte an (etwa wie in MS Word). Die Partitur muss
dazu neu formatiert werden. Dies kann einige Sekunden dauern. Bitte beachten Sie: Wenn diese Option
aktiviert ist, lasst sich die Partitur nicht editieren! Um wieder editieren zu kdnnen, deaktivieren Sie die
Option wieder, indem Sie die Funktion erneut tiber das Meni oder die Toolbar aufrufen.

Normalansicht
(Partitur ist editierbar):

N [v] God morgon "Morgonpasset” |
N [d] Guten Morgen "Morgenpasset”|

~Show special characters* aktiviert
(Partitur ist nicht editierbar):

N [¥] Godmorgon"MMorgonpasset"|-
N [d] Cuten-Morgen-"MWorgonpasset'l-
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View = Color empty events

Legt fest, ob die Stellen der Transkription, an denen kein Ereignis eingetragen ist, eine eigene farbliche
Unterlegung erhalten sollen. Die Berechnung dieser farblichen Unterlegung ist sehr zeitaufwendig. Fr
gréRere Transkriptionen empfiehlt es sich daher, diese Option zu deaktivieren — der Editor wird dadurch
wesentlich schneller.

Option ,,Color empty events® deaktiviert: Option ,,Color empty events* aktiviert:

ooy |I|I.‘Ij 1128 :|| Doy |I|I_'Ij 125 :||
Max [p] |Cu fillst mir immer |ins Wort. -] Max fv] |Du fillst mir imumer |ins Woat. ]
Max [now] | gestikuliert Max [nw] | sestikuiiart
Tom ] Stinunt  [ja gar nicht. Tom ] Htinunt  |ja gar micht.
Ton [ne] Tom [nv]
AUD | Audie-Verveisl | AUD  [Audic-Verwesl -]
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D. Tier-Meniu

Tier Ewent Timeline Format Segment:

E?' Add tier. .. Skrg+e
o—

+— | Insert Lier... Skrg+I
* Rermove tier

+

= | Move kier upwards  Strg+Oben

| Hide tier Strg-+alk+H

Remove emplby events

Die meisten Funktionen im Tier-Menu sind nur dann zuganglich, wenn Sie zuvor eine Spur markiert ha-
ben. Um eine Spur zu markieren, klicken Sie auf das zugehérige Sprecher-Label am Anfang der Spur:

ooy ||||:|] 128 :||
Max fe] |Du fillst mir immer |ins Wort. =]
Max [nv] | gestkulicrt

Sttt ja gar mcht.

Tom [n]

AUD Andico-Verweis1 lI

Tier = Tier properties...

Offnet einen Dialog zum Editieren der Eigenschaften der aktuell markierten Spur.

% Edit tier properties x|

Speaker:  |SPKO [ =
Type: T(ranscription] j
Categary:  |v
Display: [ [v] v uto
User defined attributes
Attribute Walue
4.10.2003
Al attribute
Femave attribute
Up Dioveey

Ok I Cancel

D-1
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Vier Attribute sind festgelegt:

" Speaker: der zugeordnete Sprecher. In der ComboBox werden alle in der Sprechertabelle definier-
ten Sprecher zur Auswahl angeboten. Wenn die betreffende Spur nicht sinnvoll einem Sprecher zu-
geordnet werden kann, wahlen Sie ,no speaker*.

" Type: der Spurtyp. Wahlen Sie , T(ranscritpion)“ flir verbale Spuren, ,D(escription)* fir non-verbale
Spuren, ,A(nnotation)* fir Spuren mit Annotationen (Ubersetzungen etc.), ,L(ink)“ fiir Spuren, die
vornehmlich Dateiverweise enthalten und ,U(ser) D(efined)" fiir sonstige Spuren. Die korrekte Zu-
ordnung des Spurtyps ist vor allem flir die Segmentierungsfunktionen wichtig.

" Category: die Spurenkategorie. Diese kann frei festgelegt werden oder auch leer bleiben. Sie sollten
eine Kategorie festlegen, wenn Sie fiir einen Sprecher mehr als eine Spur einrichten. Geben Sie
beispielsweise ,v* fur ,verbal®, ,nv* fir ,non-verbal®, ,k* fir ,Kommentierungen* oder ,ENG* flr eine
,englische Ubersetzung“ ein.

" Display: der Name der Spur, der bei der Ausgabe und im Partitur-Editor verwendet wird. Wenn die
Option ,Auto” aktiviert ist, wird dieser Name automatisch aus Sprecherkiirzel und Kategorie gene-
riert. Um einen davon abweichenden Spurnamen einzugeben, deaktivieren Sie die Option ,Auto”
und geben Sie den gewtinschten Namen ein.

Unter ,User defined attributes” konnen Sie zusatzlich benutzerdefinierte Attribut-Wert-Paare fiir die Spur
eingeben (zur Bedienung siehe ,File > Edit Meta Information®).

=
Tier > Add tier... il
(auch Uber die Tastenkombination +[A auf dem PC bzw. [33] + [A] auf dem Macintosh)

Offnet einen Dialog zum Anfligen einer neuen Spur am Ende der Transkription.

Speaker: SPED [] Edit speakertable. . |
Type: Tiranscription) j

Categary: |V

[ copy events from: ITIEEI 0 [w]) LI

(0] | Cancel |

Die Eintrage unter ,Speaker‘, ,Type“ und ,Category“ entsprechen den oben unter ,Tier >
Edit tier properties...“ beschriebenen. Wenn die Option ,Copy events from“ gewahlt ist, werden in der
neuen Spur leere Ereignisse an den Stellen eingetragen, an denen auch in der ,kopierten* Spur Eintrage
stehen (dies kann insbesondere flir Annotationsspuren nitzlich sein).

—3
Tier © Insert tier... ;"';l
(auch tber die Tastenkombination +[1] auf dem PC bzw. [8] +[1] auf dem Macintosh)

Offnet einen Dialog zum Einfligen einer neuen Spur oberhalb der aktuell markierten Spur. Der Dialog ist
identisch mit dem oben unter , Tier > Add tier...“ beschriebenen.

Tier » Remove tier... ')_(I

Léscht die momentan markierte Spur. Vorab wird eine Sicherheitsabfrage durchgefiihrt. Um eine Spur
nur zeitweise auszublenden statt sie endgliltig zu I6schen, verwenden Sie ,Tier - Hide tier”.
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t
Tier > Move tier upwards... ;-l
(auch Uber die Tastenkombination +[ 1] auf dem PC bzw. [38] + [ 1 | auf dem Macintosh)

Verschiebt die momentan markierte Spur eine Position nach oben.

Tier > Change tier order... f_*l

Offnet einen Dialog zum Verandern der Spurreihenfolge:

TIED (5 [v]) Move up
TIE4 (5 [d])
TIE1 (S [e])
TIEZ (M [+])
TIES (M [d])
TIE3 (M [c])
TIES ¢ [aud])

iove down

ok Cancel

Markieren Sie die Spur, die Sie bewegen mdchten, klicken Sie auf Move up, um sie nach oben bzw. auf
Move down, um sie nach unten zu verschieben. Um die Anderungen zu (ibernehmen, verlassen Sie den
Dialog, indem Sie auf OK klicken.

Tier 2 Hide tier ﬁl

Blendet die momentan markierte Spur aus.

i 1
Tier 2 Show all tiers El

Blendet alle ausgeblendeten Spuren wieder ein.

Tier > Remove empty events

Entfernt leere Ereignisse, d. h. Ereignisse, in die nur Leerzeichen eingetragen sind, aus der momentan
markierten Spur.
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E. Event-Meni

Event Timeline Format Segmentation  Help

Event propetties. .. Strg+Eingabe

ks | Shift charackers to the right  Strg+Umschalt+R,

E;" Shift characters to the left  Strg+Hdmschalt+L

N Merge events Strg+1
E Split Strg+2
Double split Shrg+3
E Remove Skrg+-D
g Extend to the right Strg+Umschalt+Rechts
g Extend to the left Strg+Umschalt+Links
g shrink, on Ehe right Strog+alk+Rechts
HEL chrink on the left Strg-alt+Links
“—* Mowve ko the right Strg+Rechts
bl Maove ko the |eft Strg+Links

Event > Event properties...

(auch Uber die Tastenkombination + auf dem PC bzw. [s§] + auf dem Macintosh sowie
mittels Klicken mit der rechten Maustaste in das jeweilige Ereignis)

Offnet einen Dialog zum Editieren des momentan markierten Ereignisses:

% Edit event |

Start . TO
Enil: T1

Evert description e

D fallst mir immer IH'AT Vl OREr... |

]
LI
]

=
Uzer defined sttributes
Attribute Yalue
a0 sttribute arrigiert am 24.10.
Remove attribute
L | Diorwwn

Ok I Cancel

Unter ,Event Description kann der Ereignis-Text bearbeitet werden — dies mag vor allem bei sehr langen
Beschreibungen komfortabler sein als das Bearbeiten in der Partitur selbst. Unter ,User defi-
ned attributes® kdnnen benutzerdefinierte Attribut-Wert-Paare fur das Ereignis eingegeben werden (zur

E-1
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Bedienung dieses Feldes siehe ,File > Meta Information®).

Event = Shift characters to the right
(auch Uber die Tastenkombination +[0] + Rl auf dem PC bzw. s8] + [1] + [R| auf dem Macintosh)

Verschiebt die Zeichen, die im aktuellen Ereignis rechts von der Cursorposition stehen, in das nachfol-
gende Ereignis.

Vorher:
0[0] 1[13] | 2[26]
Max [v] [Du fallst mir imkner|ins Wort. |

Nachher:
0[0] 1[1.3] 2[2.6]
Max [¥] [Du fallst mir imHmer ins Wort. |

Event = Shift characters to the left Aks
(auch Uber die Tastenkombination +[0] + | auf dem PC bzw. [8] + [¢] + || auf dem Macintosh)

Verschiebt die Zeichen, die im aktuellen Ereignis links von der Cursorpostion stehen, in das vorherge-
hende Ereignis.

Vorher:

Tom [v] | Stimmt  fjaar nicht. |

Nachher:
Tom [v] | Stimmt ja [gar nicht. |

m
Event > Merge events é
(auch (iber die Tastenkombination + 1] auf dem PC bzw. [¢] + [1] auf dem Macintosh)

Legt zwei oder mehr markierte Ereignisse innerhalb einer Spur zu einem Ereignis zusammen.

Vorher:
0 [0.] {13 2[26]
Max [v] |Du fallst mar immer|ins Wort. |
Markieren:
0[0.] 1[1.3] 1 [2.6]
YL B Do fallst mir immer ins Wort,
Nachher:

0[0.] 1013 2[2.6)

Max [v] |Du fallst mir immer ins Wort. |

E-2
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Event > Split
(auch Uber die Tastenkombination +[2| auf dem PC bzw. [33] + [ auf dem Macintosh)

Teilt das aktuelle Ereignis an der Cursorposition in zwei Ereignisse.

Vorher:
0[0.] 1[1.3] 2[26)
Max [v] [Du fallst mir |immer ins Wort. |

Nachher:
0[0.] 1[1.3] 2[2.6]
Max [v] IDu fallst mir||immer ins Wort. |

Wenn das aktuelle Ereignis nur eine Zeitspanne von einem Zeitpunkt bis zum nachsten umfasst, wird ein
neuer Zeitpunkt auf der Zeitachse eingefugt.

Wenn (wie im Beispiel) das Ereignis eine Zeitspanne von einem bis zum Ubernachsten Zeitpunkt, um-
fasst, wird es am dazwischen liegenden Zeitpunkt geteilt.

Wenn hingegen die Zeitspanne grofer ist, 6ffnet sich ein Dialog, in dem der Zeitpunkt, an dem das Er-
eignis zu teilen ist, ausgewahlt werden kann:

% Chooze a imeline item

2 T2 [2 EEEEEEEEEEEEEET]

Ok Cancel |

Event 2 Double split
(auch (iber die Tastenkombination + 3] auf dem PC bzw. [¢] + [3] auf dem Macintosh)

Teilt das aktuelle Ereignis gemaf der momentanen Text-Markierung in drei Ereignisse.

Vorher:
f | 1 |:

MAX fv] IDu fallst intner s Wort. | |

Nachher:
0 | 1 |3 |3 |4

M[‘-’]I]:)u fallat |er| itntmet ins Wnﬂ.| |

Wenn das betreffende Ereignis mehr als ein Zeitintervall umfasst, ist diese Funktion deaktiviert. Benutzen
Sie in diesem Falle stattdessen zweimal die Funktion Event = Split Event.
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Event > Remove ﬁ
(auch Uber die Tastenkombination + D] auf dem PC bzw. [¢] + D] auf dem Macintosh)

Entfernt das momentan markierte Ereignis.

Vorher: . .
Max [¥] |Du fallst mir immer|ins Wort, ‘

Nachher:
Max [v] |Du fallst mir immer (1ns Wort,
Max [nv]

Event > Extend to the right g

(auch Uber die Tastenkombination +[0] + [2] auf dem PC bzw. [8] + [¢] + [»] auf dem Macintosh)

Dehnt das momentan markierte Ereignis um einen Zeitpunkt nach rechts aus.

Vorher:
0[0] 1[L1.3] 2 [2.6]
Max [¥] |Du fallst mir imrmer | ins Wort,
Max [nv] gesﬁkufierﬂ
Nachher:
00 1[1.3] 2 [2.6]
Max [¥] |Du fallst mir imtmner | ins Wort.
Max [nv] |gestikudiert
Event > Extend to the left S

(auch (iber die Tastenkombination +[0] + [«] auf dem PC bzw. [38] + [¢] + [«] auf dem Macintosh)
Dehnt das momentan markierte Ereignis um einen Zeitpunkt nach links aus.

Event > Shrink on the right g

(auch (iber die Tastenkombination + [Alf + [#] auf dem PC bzw. [38] + [Alf + [] auf dem Macintosh)
Verklrzt das momentan markierte Ereignis rechts um einen Zeitpunkt.

Vorher:
0r0] 171.3] 2[2.4]

Max [¥] |Du fallst mir immer | ins Wort,

Max [nv] |gestkuliort
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Nachher:
0[0.] 1 [L.3] 2 [2.6]
Max [¥] |Du fallst mir imrmer | ins Wort.
Max [nv] |gesiikubior]
=
Event > Shrink on the left i

(auch (iber die Tastenkombination + [Alf + [«] auf dem PC bzw. [38] + [Alf + [«] auf dem Macintosh)

Verklrzt das momentan markierte Ereignis links um einen Zeitpunkt.

Event > Move to the right Q
(auch (iber die Tastenkombination + [»] auf dem PC bzw. [&¢] + [»] auf dem Macintosh)

Bewegt das momentan markierte Ereignis um einen Zeitpunkt nach rechts.

Vorher:
0[0] 1[1.3] 2[2.6]
Max [¥] |Du fallst mir immer |ins Wort.
Max [nv] |gesiikuliert
Nachher:
01[0] 1[1.3] 2 [2.6]
Max [¥] |Du fallst mir immer |ins Wort.
MMax [nv] gestikuliort
blll
Event = Move to the left s

(auch Uber die Tastenkombination +[«] auf dem PC bzw. 3] + [«] auf dem Macintosh)

Bewegt das momentan markierte Ereignis um einen Zeitpunkt nach links.
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F. Timeline-Meni

Timeline Format  Segmentation  Help

T e v
*{f:m | Edit timeline item. ..

.~5+ Insett timeline item

[EI] Remove gap

Femove all gaps
X | Remove unused timeling items

Make timeline consistent
Interpolate timeline

Femove inkerpolated times

Timeline = Edit timeline item... ﬂ]

Offnet einen Dialog zum Editieren des absoluten Zeitwertes des momentan markierten Zeitpunktes:

% Edit timeline item [ ]
Absolute Time Yalue:
Ho ralue
Enter number or hhipmiss. XXX
|or:0z332
Ok Cancel |

Der absolute Zeitwert kann wahlweise als Dezimalzahl (d. h. in Sekunden) angegeben werden, oder in
der Form hh:mm:ss.xxx. Beispielsweise bedeuten

181.23

00:03:01.23
03:01.230

jeweils das Gleiche, und zwar: ,3 Minuten, 1 Sekunde und 230 Millisekunden®.

o
Timeline 2 Insert timeline item E

Flgt links des momentan markierten Zeitpunktes einen neuen Zeitpunkt ein.

Vorher:

0[] 28] ﬂ
Max ] |Du fillst ruir ivarner -
Max [nw] | gesrifadias N
Tom f] jagar nicht. |
Tom [nv] B
ATD Andio-Verweis1 B |
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Nachher:
0[] 203 3 [246] 4|
Max fu] |Dou fallst i ivoney il ins Wort. =]
Max [nw] | ettt
Tom fr] Stiramt  |ja gar nicht.
Tom [nw] I
ATD Audic- Verweis1 =|

Timeline > Remove gap [ED

Entfernt die momentan markierte Licke aus der Zeitachse. Eine Llcke ist ein Raum zwischen zwei auf-
einander folgenden Zeitpunkten, Uber den sich kein Ereignis erstreckt. Beim Aufruf dieses Menilpunktes

wird der erste dieser beiden Zeitpunkte dann entfernt und der Rest der Transkription um einen Zeitpunkt
nach links gerickt.

Vorher:
0] |1[13] 2 [26] 4[]
Max ] |Dwu fillst rm.r].mmer|ms Wort.
Max [nv] | gesrindior
Tom fv] Stiramt  |ja gar racht. [ Ich rede nor, werm ich an der Beihe
Tom [nv]
AUD Andic- Verweis1
Nachher:

0] |1[13] 2[24] I[M4]
Max f] |Dwu fillst nﬁri.mmﬂr|ins Wart.

Max [m] | gestiiudiot

Tom ] Stirrnt  |jagar rdcht. |Ich rede nor, werm ich an der Beihe
Tom [nv]
ATD Andio- Verweis]

Timeline > Remove all gaps

Entfernt alle Liicken aus der Transkription.

Timeline > Remove unused timeline items ;:>:<n|

Entfernt alle unbenutzten Zeitpunkte aus der Transkription. Ein Zeitpunkt ist unbenutzt, wenn an ihm kein
Ereignis beginnt oder endet.

Vorher:

0] | 1 |:: 3 [26]
Max fr] Duf‘ei]lstnﬁrimmerhns Wort.
Max [nw] | sesninidien:
Tom fr] Stirnret  |ja gar nacht.
Tom [nv] |
ATD Audic-Verweis1
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Nachher:
0[] | 1 2 [26] |
Max ] | Dw fillst rar immer |ms Wort.
Max [nw] | sestibnadiers
Tom ] Stiraret  |ja gar nicht,

Tom [m]
ATD Andic-Verwsis1

Timeline > Make timeline consistent

Uberpriift die Zeitachse auf Konsistenz, d. h. nach aufsteigenden absoluten Zeitwerten. Absolute Zeitwer-
te, die nicht in eine monoton wachsende Folge passen, werden entfernt.

Timeline 2 Interpolate timeline

Interpoliert die Zeitachse, d. h. berechnet fir alle Zeitpunkte, denen kein absoluter Zeitwert zugeordnet
ist, einen absoluten Zeitwert. Dies geschieht durch lineare Interpolation zwischen dem nachsten vorher-
gehenden und dem néachsten nachfolgenden Zeitpunkt, denen ein absoluter Zeitwert zugeordnet ist. Bitte
beachten Sie, dass die so berechneten Werte in der Regel lediglich eine Naherung an die tatsachlichen
absoluten Zeitwerte der betreffenden Zeitpunkte darstellen. Dabei ist das Ergebnis der Interpolation umso
besser, je mehr Zeitpunkte mit korrekten absoluten Zeitwerten versehen waren.

Timeline > Remove interpolated times

Entfernt absolute Zeitwerte, die durch Interpolation (s. 0.) entstanden sind, aus der Zeitachse.
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G. Format-Meni

|Fn:urmat Segmentation  Help

@ Apply stvleshest

[Eﬁ Cpen Farmat table, ..

[Ell Save format table Strg+Umschalt+5
Ell Sawve format table as. ..

[@] Edit Format table, .,

E‘ Formak Lier. .. Skrg+F

] Format tier labels. ..

1] Farmat timeline. ..

Format timeline items. ..

Set Frame end

@ Fefarmmak

Im Format-Menu kdnnen Formatierungen bezuglich Schriftart, Schriftgrofe, Text- und Hintergrundfarben
etc. vorgenommen werden. Die Formatierungen verandern sowohl die Darstellung der Partitur auf dem
Bildschirm als auch die Darstellung in der Ausgabe (Ausdruck, RTF- oder HTML-Dokument). Formatie-
rungen wie SchriftgroBe oder Fettdruck sollten jedoch nicht als Trager linguistischer Informationen ge-
braucht werden. Diese werden im EXMARaLDA ausschliellich Uber die verwendeten Symbole bzw.
Symbolketten kodiert (siehe hierzu auch ,Segmentation-Meni®). Die Formatierungen sind somit nicht
Bestandteil der eigentlichen Transkription, sondern werden als zusatzliche Angaben behandelt, die nur
fur die Darstellung im Editor und fir die Ausgabe relevant sind. Sie werden ferner auch nicht mit der ei-
gentlichen Transkription, sondern als gesonderte Datei gespeichert.

Die Systemarchitektur sieht vor, dass nur ganze Spuren, bzw. alle Spur-Labels oder alle Zeitachsen-
Labels mit einer Formatierung versehen werden kénnen. Insbesondere ist es nicht méglich, einzelne
Abschnitte einer Spur, z. B. einzelne transkribierte Woérter, zu unterstreichen, fett zu drucken oder in eine
andere Schriftart zu setzen.

Der Grund dafir ist, dass sich derartige Formatierungen nur sehr eingeschrankt in andere Datei-Formate
Uberfihren lassen. Beispielsweise ist es nicht mdglich, Unterstreichungen oder Fettdruck als solche in
eine Datenbank zu tUbernehmen. Wenn Sie diese Mittel nur aus Griunden der Darstellung verwenden
mochten, kénnen Sie die gewlinschten Anderungen spater in einem exportierten RTF-Dokument vor-
nehmen. Wenn sie jedoch Bestandteil ihrer Transkriptionskonventionen sind (z. B. wenn Sie betonte Re-
deteile nach den Konventionen unterstreichen mussen), sollten Sie dariiber nachdenken, ob sich das so
markierte Phanomen nicht mit anderen, rein symbolischen Mitteln ausdricken Iasst.

Der Editor versieht jede Transkription automatisch zunachst mit einer Standardformatierung (zur Einstel-
lung der Standard-Schrift siehe ,Edit > Edit Preferences...“). Die Bearbeitung der Formatierung einer
Spur (oder der Sprecherlabels bzw. der Zeitachse) erfolgt immer tGber den folgenden Dialog, den Sie Uber
Format 2 Edit format table 6ffnen kdnnen:
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~Test Area

*Text* Text * Text *

Font:
Style:

Size:

~Formatting properties

Arial Unicode MS

ll Border: [ et [T Ricikt | Top [ Bottom

Flait

hd I Border colour: -

Text colour:

Background colour:

12

Edit...

ﬂ EBorder style: Isu:ulid

Height calculation: * Generaus Mizerly

" Fixed: |1|:| P

Alicjrrnerit:

|Lett

=l

[

] Font: legt die Schriftart fest.

K

Cancel

" Style: legt den Schriftschnitt fest (,Plain“ = Normal, ,Bold“ = Fett oder ,ltalic* = Kursiv).

" Size: legt die Schriftgrof3e (in Points) fest.

Beispiel:

ax [v]

ax [nv]

om [v]

D fallst mir immer ins Wort,
gras kil fard

Stimmt  ja

] Text colour: legt die Textfarbe fest.

Labels: »1imes New Roman, Bold, 10 pt*

Spur 1 und 3: ,Times New Roman, Plain, 12 pt*

Spur 2: ~Courier New*, Italic, 8 Pt"

" Background colour: legt die Hintergrundfarbe fest.

Die Auswahl der Farben erfolgt Gber einen vom System zur Verfligung gestellten Dialog:

& Choose a color [ <]

Wiusier | s | Res |

1
JjJJJJJJJJJJJJJJJH I
I

Aktuel:
o

“orschau

u - . Eeispictext Beizpistext

. . . Beispictext Beispietext -

Ok I Abbrechen | Zuriicksetzen |

G-2
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Beispiele:
ax ] Du fallst mir immer ins Wort, Spur 1 bis 3: Rote, blaue und griine Textfarbe
ax []w] gas bikul ierk
om [v] stimmt ja
ax[v] - Du fallst mir immer ins Wort. Spur 2: graue Hintergrundfarbe
ax [ny] Festiudiert _ ~ (z. B. um die Ausdehnung non-verbaler Ereignisse zu
om [v] stimmt  ja  verdeutlichen)

" Alignment: legt die Ausrichtung des Textes innerhalb einer Ereignisbeschreibung fest. Diese Einstel-
lung ist nur im Editor wirksam, bei der Ausgabe wird die Schrift grundsatzlich linksbiindig ausgerich-

tet.
Beispiel:
op] [2 2[26] il4
Max ] [Doy fallst #rir imrner |jns Wort. ~| Spur2: zentrierte Ausrichtung (,Centre)
Max [nw] gestiknlismnt
Tom ] |Stimmt ja gar nicht. -]

" Border: legt fest, ob und wo Ereignisse umrahmt werden sollen.
" Border colour: legt die Rahmenfarbe fest.

. Border style: legt den Rahmenstil fest (,solid“ = durchgezogene Linie, ,dashed” = gestrichelte Linie,
,dotted” = gepunktete Linie).

Beispiele:
ax bl Du fallst mir immer ins Wort. Spur 1 und 3: graue, durchgehende  Rahmenlinie
ax []“,] gras kil ierd rechts
om [v] stimmt  ja
ax [v] Du fallst mir immer ins Wort.  Spur2: blaue, gepunktete Rahmenlinie, links,
ax [ny] Festikidiers rechts, oben und unten
om [v] Stimmt  ja  (z. B. um die Ausdehnung non-verbaler Ereignisse zu

verdeutlichen)

" Height calculation: legt fest, nach welcher Methode bei der Berechnung der Spurhéhe verfahren
werden soll. Es stehen drei Alternativen zur Verfligung:

= Generous: Dies ist die Default-Einstellung. Die Spurhéhe richtet sich — wie in einer Textverarbei-
tung — nach dem grofstmaoglichen Zeichen im gewahlten Schriftsatz.

= Miserly: Wenn diese Option gewahlt ist, richtet sich die Spurhéhe nach dem grofiten tatsachlich
verwendeten Zeichen in der betreffenden Spur.

= Fixed: Wenn diese Option gewahlt ist, kann die Spurhéhe vom Benutzer fest vorgegeben wer-
den. Die MaReinheit sind Pixel (entspricht der Schrift-MaReinheit ,Points®).
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Format > Apply stylesheet

Generiert eine neue Formatierung flr die aktuelle Transkription aus einem Stylesheet (siehe auch An-
hang D). Verwendet wird das Stylesheet, das in den Benutzereinstellungen (siehe ,E-
dit > Preferences...“) unter ,Transcription to format table“ angegeben ist. Ist dort nichts angegeben, wird
ein internes Stylesheet verwendet.

k']

Format = Open format table... [Eni

Offnet eine gespeicherte Formatierungstabelle und wendet sie auf die momentan geéffnete Transkription
an.

Format > Save format table [E:d]
(auch Uber die Tastenkombination +[0] + [ auf dem PC bzw. [8] + [¢] + [S] auf dem Macintosh)

Speichert die momentane Formatierung unter ihrem aktuellen Dateinamen. Wenn die Formatierung noch
keinen Dateinamen erhalten hat, wird automatisch ,Save format table as...“ aufegrufen.

Format = Save format table as...

Speichert die momentane Formatierung unter einem neuen Dateinamen.

3
Format = Edit format table... H

Offnet einen Dialog zum Bearbeiten samtlicher Spur-Formatierungen:

% Edit format table |

(TIED) Acld format. .
(EMPTY)
(EMPTY-EDITOR)
(ROW-L ABEL)
(SUB-ROW-LAEEL)
(COLUMMN-LABEL)

Femove formst

~Test Area

* Text * Text * Text *

~Formmstting propertie:

Border: [ Leit [ Right I Top [ Bottom

Border colour: -
Eorder style: Isolid &7 I

Farit: Times Mew Rorman

Style: Plain

Sizer

12
Text colour: -

Background colour: Edit...

Height calculstion: % Generous © Misetly
" Fixed: [10  Px

Alignrernt: ILeﬂ

-
-
-
=
L8 | Cancel

Wahlen Sie aus der Liste diejenige Formatierung aus, die Sie bearbeiten méchten und nehmen Sie in der
unteren Halfte des Dialoges die entsprechenden Einstellungen vor. Im Feld , Test Area“ kdnnen Sie Pro-
betext eingeben. Beenden Sie den Dialog mit OK, um die Anderungen zu (ibernehmen.
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T
Format - Format tier... [El

(auch Uber die Tastenkombination + [F] auf dem PC bzw. [8] + [F] auf dem Macintosh)

Offnet einen Dialog zum Formatieren der momentan markierten Spur.

=
Format - Format tier labels... [El

Offnet einen Dialog zum Formatieren der Sprecher-Label.

1]
Format - Format timeline... [E‘

Offnet einen Dialog zum Formatieren der Zeitachse.

Format = Format timeline items...

Offnet einen Dialog zum Einstellen des Formates der Zeitpunkte auf der Zeitachse. Die Einstellungen
betreffen wiederum sowohl die Anzeige im Editor als auch die Ausgabe in eine RTF- oder HTML-Datei

oder auf einem Drucker.

% Edit timeline item format X|

Showy every n-th numbering:

Showy every n-th absolute time: 1

Absolute time formst:

Milizeconds digits:

Cancel |

1

Decimal =~ I

1

" Show every n-th numbering: legt fest, dass jede n-te Nummerierung in der Zeitachse angezeigt
werden soll. Geben Sie 0 ein, um gar keine Nummerierung anzuzeigen.

" Show every n-th absolute-time: legt fest, dass jede n-te absolute Zeitangabe in der Zeitachse ange-
zeigt werden soll. Geben Sie 0 ein, um gar keine absoluten Zeitwerte anzuzeigen.

" Absolute time format: legt fest, ob die absoluten Zeitwerte als Dezimalzahl (,Decimal®), d. h. in Se-
kunden, oder als Zeitangabe (,Time") in der Form hh:mm:ss.xxx angezeigt werden sollen. 183.21
(,Decimal“) und 03:03.21 (,Time") bedeuten beispielsweise das gleiche — namlich ,3 Minuten, 1 Se-

kunde und 230 Millisekunden®.

" Miliseconds digits: legt fest, wie viele Stellen nach dem Komma zur Anzeige von Millisekunden ver-

wendet werden sollen.

Beispiele:

00123 2] 1plass]  af

ax vl D fallst mir immer ins Wort.

ax [lll.f] gras kil daed

om [v] Stimmt ja
[01:35 340] OlEsss] @l

ax [v]  Du fallst mir immer ins Wort,

ax []“,] gras ikl ierd

om [v] Stimmt  ja

Show every n-th numbering: 1
Show every n-th absolute time: 1
Absolute time format: Time
Miliseconds Digits: 1

Show every n-th numbering: 0
Show every n-th absolute time: 1
Absolute time format: Time
Miliseconds Digits: 3
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0 [33 3] 1 2L

Show every n-th numbering: 1
Show every n-th absolute time: 2
Absolute time format: Decimal
Miliseconds Digits: 1

ax [v] D fallst mir immer ins Wort,
ax []“,] gras ikl feek

om [v] Stimmt  ja

Format = Set frame end

Legt fest, wo in der Ausgabe die Umrahmung der Partitur verlauft. Die Standard-Einstellung ist so ge-
wahlt, dass alle Spuren innerhalb des Partiturrahmens liegen. Wenn Sie dies andern wollen, sortieren Sie
die Spuren zunachst so, dass all diejenigen Spuren, die innerhalb der Umrahmung platziert werden sol-
len, oben angeordnet sind (siehe hierzu auch ,Tier > Change tier order”). Markieren Sie die letzte Spur,
die sich innerhalb der Umrahmung befinden soll, indem Sie auf das Spurlabel klicken und wahlen Sie erst
jetzt diesen Mentipunkt.

(Wo Sie den Partiturrahmen gesetzt haben, kénnen Sie anschlieRend am Bildschirm an den Spurlabels
erkennen: Die Labels der Spuren, die aulerhalb der Partitur liegen, haben einen anderen Rahmen.)

Beispiele:
ax [v] D fallst mir immer ins Wort. kein frame end®
ax []“r] gas bikud ierd ?
om [v] Stimmt  ja
beleidigt
ax [v] D fallst mir immer ins Wort. ,frame end“ nach der dritten Spur gesetzt
ax [m.r] gastikiliart
om [v] stimmt  ja
beleidit

Format 2 Reformat @9

Erzwingt eine Neuberechnung der Partitur-Formatierung. Dies kann z. B. dann notwendig sein, wenn Sie
die GroRle einzelner Intervalle auf der Zeitachse manuell verandert haben.
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H. Segmentation-Menu

Ein eigener Artikel Uber das Konzept, die Parameter und die technische Umsetzung der Segmentie-
rungsalgorithmen ist in Planung, aber noch nicht fertig gestellt. Bis auf weiteres sei stattdessen auf die
Folien des Vortrages ,Segmentieren von EXMARaLDA-Daten® verwiesen, der auf der Projekt-Homepage
(unter Dokumentation - Literatur > Vortrage) abgelegt ist.

E Export segmented transcription (=ML Untermenii HIAT Segmentation
@ Expart seqrent chain list (HTML) E Segmenked transcription (ML)
E Export segment chain lisk (ML) @ Ukterance list (HTML)

E Utterance list (=LY

@ ward list (HTMLY

@ Counk segments

HIAT segmentation
DIDA segrenkation
AT segrientation

“HAT segmenkation

- v v v v

TEI segmentation
Untermenii DIDA Segmentation

{‘g‘ Seqmented transcription (XML

@) word lst (HTML)

@ Count segments

Untermenii GAT Segmentation

E:g-' Seqmented Transcription (<ML

GAT Transcript (THT)

Untermenii CHAT Segmentation

.m ,_,' CHAT Transcript (CHA)

Untermenii TEI Segmentation

=TEl= TEI Transcripkion ML)

Einfliihrung

Das Segmentieren ist ein Arbeitsschritt, der in der Regel nach der Fertigstellung der Transkription auf
dieselbe angewendet wird. Das Segmentieren kann vielfaltigen Zwecken dienen, die sich — allgemein
gesprochen — unter den folgenden beiden Schlagworten zusammenfassen lassen:

= Die automatische Generierung zusatzlicher Darstellungsformen fiir eine Transkription, beispielswei-
se die Ausgabe einer Transkription als AuRerungsliste (vgl. z. B. Ausfiihrungen unter ,Segmentati-
on > HIAT-Segmentation - Utterance list (HTML)").

= Das Unterteilen der Transkription in relevante (sprachliche) Analyseeinheiten, die bei einer compu-
tergestltzten Auswertung einer Transkription oder eines Transkriptionskorpus zur Anwendung
kommen. Beispielsweise setzt das Analyseinstrument ,Alphabetische Wortliste® (vgl. z. B. Ausfih-

H-1




EXMARaLDA Partitur-Editor — Handbuch Segmentation-Menu

rungen unter ,Segmentation > DIDA-Segmentation - Word list (HTML)*) eine Segmentierung der
Transkription in Worter voraus, und auch das einfache Zahlen von Einheiten (vgl. z. B. ,Segmentati-
on 2> HIAT-Segmentation > Count segments®) erfordert, dass die zu zahlenden Einheiten vorher
segmentiert wurden.
Diese Einfiihrung erlautert die allgemeine Funktionsweise des Segmentierens. Fir eine detaillierte Be-
schreibung einzelner Menulpunkte im Segmentation-Menu sei auf die betreffenden Stellen in der nachfol-
genden Funktions-Referenz verwiesen.

Was wird segmentiert?

Zunachst ist festzuhalten, dass zu segmentierendes Material sich in aller Regel nur in Spuren des Typs
T(ranscription) befindet, also dort, wo normalerweise das verbale Handeln eines Sprechers nach ortho-
graphischer oder literarischer Umschrift beschrieben wird. Spuren des Typs D(escription), also z. B. Spu-
ren in denen non-verbale Handlungen, Gestik oder Mimik festgehalten wird, werden in der Regel ebenso
wenig segmentiert wie Spuren des Typs A(nnotation), in denen sich annotierende Elemente wie Uberset-
zungen, Kommentare etc. befinden. So sind in dem folgenden Transkriptionsausschnitt nur die erste und
dritte Spur Gegenstand der Segmentierung, wahrend die zweite und vierte Spur (die als Ubersetzungen
jeweils den Typ ,A“ haben) nicht berlicksichtigt werden:

1} 1 2 3 4 5 3 T
ELA ] by, da korarat ||ei.ner. Koment noch ||ei.ner. ((hustet)) War? Oh, dat kany ja xich wahy sein. |;|
KELA [eng] | Oh, somebody's coming. | Another one coming. |({ecughs)) What? Ik, that can't be trme. |
ERW fv] ((hustet)). Och nee, dat jiwet ja nich.
ERW [eng] ({eoughs) Ol no, [ dox't believe it =]

Innerhalb einer Spur des Typs ,T“ erfolgt die Segmentierung Schritt flir Schritt, anhand der Einheit der
Segmentkette (,segment chain®). Eine solche Segmentkette ist definiert als eine zeitlich ununterbrochene
Folge von Ereignissen. Im Editor lassen sich solche Segmentketten gut erkennen: Sie sind die (stan-
dardmaBig) weil® unterlegten Abschnitte zwischen zwei (standardmafig) grau unterlegten Abschnitten.
So enthalt das obige Beispiel genau vier Segmentketten:

KLA: Oh, da kommt einer. Kommt noch einer. ((hustet)) Wa/?
ERW: ((hustet)).

ERW: Och nee, dat jiwet ja nich.

KLA: Oh, dat kann ja nich wahr sein.

Die Unterteilung einer Spur in Segmentketten Iasst sich auch gut anhand des Segmentation-Panel nach-
vollziehen: Klickt man in obigem Beispiel etwa auf das Ereignis ,Kommt noch“ und wahlt dann Get seg-
ment chain im Segmentation Panel aus, so erscheint dort unter ,Segment chain text* der Inhalt der zuge-

horigen Segmentkette:

Segment chain text

Oh. da kommt einer. Kommt noch einer. [[hustet]) Wiar?

Finite State Machine

1] 1 2 3 4 5
KLA ] Oh, da kommt |ejner. e ((hustet)) Wal? IHIAT: Litterances and words LI QIpE... |
EKLA [en] | Ok, someons's conung. Annther one coming. [{conghs)) What? Messages

ERW v {(hustety). Och nee, d
ERW [en] | Ch, I don't bel
KTLA lextl I >

Wie wird segmentiert?

Die eigentliche Segmentierung erfolgt, indem auf die Segmentketten der zu segmentierenden Spuren
eine sog. Endliche Maschine (,Finite State Machine®) angewandt wird. Diese ist ein einfacher Algorith-
mus, der AuBerungsendzeichen, Worttrenner etc. ,erkennt‘ und anhand dieser Informationen Segment-
ketten in kleinere Einheiten zerlegt. Da sich die Benennung und Bedeutung solcher Einheiten von
Transkriptionssystem zu Transkriptionssystem unterscheidet (z. B. AuRerung in HIAT vs. Phrasierungs-

H-2
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einheit in GAT) und jedes Transkriptionssystem andere Endzeichen fir seine Einheiten verwendet (z. B.
die fiinf AuBerungsendzeichen in HIAT vs. finf Zeichen fir eine abschlieBende Tonhéhenbewegung in
GAT), enthalt der Partitur-Editor verschiedene Endliche Maschinen flir verschiedene Transkriptions-
systeme — auch das lasst sich am Segmentation Panel nachvollziehen, indem man unter ,Fini-
te State Machine® verschiedene Endliche Maschinen auswahlen kann:

Finite State Machine

HIAT, fterances and words LI DRE...

HIAT: Literances and wards
IO, Wiords
GAT: Intonation Units
CHAT: Literances

Die Endliche Maschine nutzt also die RegelmaRigkeiten der einzelnen Transkriptionssysteme, um Seg-
mentketten in kleinere Einheiten zu zerlegen. So kann z. B. in dem gegebenen Beispiel Uber die HIAT-
Segmentierung anhand der verwendeten Punkte und Fragezeichen (die gemaR HIAT eine AuRerung
abschlieRen) eine Unterteilung der Segmentketten in AuRerungen erfolgen:

KLA: Oh, da kommt einerD

ERW: ((hustet))[/]

KLA: Kommt noch einerD

KLA: ((hustet)) Wa/[7]

ERW: Och nee, dat jiwet ja nichD

KLA: Oh, dat kann ja nich wahr seinD

In gleicher Weise wird anhand der doppelten runden Klammern erkannt, dass die eingeschlossenen Zei-
chenketten nicht-phonologisches Material beschreiben:

KLA:

ERW: @hustet@.

KLA: ...
KLA:  [((hustet]))] wa/?

Das vollstandige Ergebnis der Segmentierung, das beispielsweise beim Export in eine ,Segmented
Transcription“ verwendet wird, Iasst sich tber das ,Segmentation Panel“ einsehen:

|| sc:0Oh, da kommmt einer. Karmrmt noch einer. [[hustet)) wia?
+l- | HIAT:u: Oh, da kemmt einer.

=l | HI&T:u: Kemmtnoch giner.

HIaT e s Kammt

HIAT:ip :

HIaTww: noch

A sc =  Segmentkette (,segment chain®)

HIAT:ip - . HIAT:u AuRerung (,utterance®)

HIAT:ip : HIAT:w Wort (,word*)

AT ([hustet)) a? HIAT:ip Interpunktion (,punctuation®)
b HIAT:non-pho nicht-phonologische Einheit

HIAT:ip : [
HI&T:non-pho : hustet (,,@—pmnobgical Unit“)
HIA&T:ip : ]
HIA&T:ip : ]
HIAT:ip :
HIBT o 2 iila
HIAT:ip : %
HIaT:ip :

* e

I
Zeassese
non

L K B N N R R

Der Sprecherbeitrag ,,Oh, da kommt einer. Kommt noch einer. ((hustet)) Wa?“ wird hier — gemafl den
HIAT-Konventionen — in drei AuBerungen zerlegt. Diese AuRerungen zerfallen ihrerseits weiter in Worter,
Interpunktion und nicht-phonologische Einheiten.

Fehlerursachen beim Segmentieren
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Weil der Segmentierungsalgorithmus auf den RegelmaRigkeiten der Transkriptionssysteme beruht, kann
es zu Problemen beim Segmentieren kommen, wenn beim Transkribieren gegen diese Regelmafigkeiten
verstofRen wird — d. h. gewisse Transkriptionszeichen nicht gemaf der Konvention eingesetzt werden.

So ist im folgenden Beispiel die nicht-phonologische Einheit ,hustet®, deren Beginn in HIAT durch ein
Paar 6ffnender runder Klammer signalisiert wird, nicht konventionsgemaR, d. h. nicht durch ein korres-
pondierendes Paar schlieffiender Klammern, beendet worden:

07 %] |1[93] |2[1[Ij] |
ELA ] | Ok da korrat einer.  |Eommt noch einer. |((hustet) Wa?
I':Lﬂ [En] 11_’ sOMeEone's !'.'l:!l'ﬂ.'ll'lg Another one EDI'I:'L'L'I:'I.g. ((ED"Jg]:'ISI] What?

Beim Segmentieren erscheint daher folgende Fehlermeldung:
Fsmerrar x|

Errar: Only close parenthesis allowed
Processed Cutput;
...10h, da kommt einer. Kommt noch einer. ((husket)

TLI: O
Tier: TIEQ

Diese enthalt folgende Angaben:

" Error: die Ursache des Fehlers. ,Only close parenthesis allowed®, bedeutet, dass an der betreffen-
den Stelle nur eine schlieRende (Doppel-)Klammer stehen darf.

" Processed Output: die bis zum Auftreten des Fehlers bearbeitete Ausgabe. ,...Oh da kommt einer.
Kommt noch einer. ((hustet)‘, deutet darauf hin, dass der beanstandete Fehler nach der ersten
schliefenden runden Klammer aufgetreten ist.

" TLI/Tier: der Ort des Fehlers in der Partitur bzw. die Segmentkette, an dem der Segmentierungsfeh-
ler aufgetreten ist.

Durch Klicken auf OK wird die Partitur automatisch an diese Stelle ,gerollt*, so dass der Fehler dort korri-
giert werden kann.

Solche Fehler beim Segmentieren lassen sich ebenfalls im Segmentation-Panel nachvollziehen, indem
dort versucht wird, die betreffende Segmentkette Uber Parse segment chain zu segmentieren. Die ent-
sprechende Fehlermeldung erscheint dann im Fenster ,Messages*:

Meszages

Welche Fehlermeldungen genau auftreten kénnen, hangt nattrlich wiederum von der verwendeten
Transkriptionskonvention ab. Anhang B gibt dazu eine genauere Beschreibung.

Probleme beim Exportieren von Listen

Folgende Funktionen des Partitur-Editors nutzen die Segmentierung, um darauf aufbauend listenférmige
Ausgaben zu generieren:
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" Segmentation - HIAT Segmentation - Utterance List (XML)

" Segmentation - HIAT Segmentation - Utterance List (HTML)

" Segmentation > GAT Segmentation > GAT transcript (TXT)

" Segmentation > CHAT Segmentation > CHAT transcript (CHA)

Zusatzlich zu den eigentlichen Segmentierungsfehlern (s. 0.) kdnnen dabei Probleme auftreten, wenn die

einzelnen Einheiten der Liste (z. B. AuRerungen in HIAT, Utterances in CHAT und Phrasierungseinheiten
in GAT) sich nicht eindeutig zeitlich anordnen lassen. Man betrachte dazu das folgende Beispiel:

1] 1 2 |
ARl 5o geht's janicht.  |Also... Ich meine. ..
B ] Ja. Witklich?

Dieses lasst sich zwar problemlos — gemaR HIAT — in insgesamt finf AuRerungen segmentieren:

1) A: So geht’s ja nicht.
2a) A: Also...

2b) A: Ich meine...

2¢c) B: Ja.

2d) B: Wirklich?

Diese fiinf AuRerungen lassen sich aber nicht in eine eindeutige zeitliche Abfolge bringen, denn die In-
formation, ob z. B. die AuRerungen 2b) und 2d) einander folgen oder gleichzeitig stattfinden, wird in der
Transkription nicht gegeben. Der Partitur-Editor gibt daher in solchen Fallen eine Warnung aus:

& The list cannok be completely ordered,

Cancel | Edit |

Es werden drei Optionen angeboten:

" Continue: Der Vorgang wird fortgesetzt. Diejenigen Elemente, fiir die es ein Problem mit der zeitli-
chen Anordnung gibt, werden dann jedoch in der Ausgabe entsprechend unzuverlassig platziert.

" Cancel: Der Vorgang wird abgebrochen.

] Edit: Der Vorgang wird abgebrochen, und es wird eine Liste der problematischen Elemente ange-
zeigt. So fiir obiges Beispiel:

x|

i

Ja.
Izh meine. ..
Wirklich'?

Goto |

Durch Klicken auf Go fo wird die Partitur an die betreffende Stelle gerollt, sodass das Problem dann
dort unmittelbar bearbeitet werden kann.

H-5
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Im obigen Beispiel kann das Problem z. B. dadurch behoben werden, dass die betreffenden AuRerungen
durch geeignetes Teilen der Ereignisse zueinander angeordnet werden:

0 1 2 3
AP S0 geht's ja nicht.  |Also... | Ich meine.
B v Ta | Wirklich?

Probleme beim Markieren von Uberlappungen in Listen

In folgenden Funktionen des Partitur-Editors werden in der auszugebenden Liste Uberlappungen mittels
Klammerung markiert:

" Segmentation > GAT Segmentation > GAT transcript (TXT)
" Segmentation > CHAT Segmentation > CHAT transcript (CHA)

Zusatzlich zu den eigentlichen Segmentierungsfehlern und den Problemen beim zeitlichen Anordnen der
Einheiten (s.0.) kdnnen dabei Probleme auftreten, wenn Uberlappende Einheiten nicht eindeutig zueinan-
der in Beziehung zu setzen sind. Man betrachte dazu das folgende Beispiel:

i |1 2 3
AP alzo 5o was-
B ] |was ist denn |jetzt schon wieder?

Dieses lasst sich zwar problemlos — gemall GAT — in insgesamt zwei Phrasierungseinheiten segmentie-
ren, und diese Phrasierungseinheiten lassen sich als Ganze auch eindeutig zeitlich zueinander anordnen:

001 A: also so was-
002 B: was ist denn jetzt schon wieder?

Dabei ist aber anhand der Transkription nur festzustellen, dass die beiden Einheiten sich teilweise Uber-
lappen, wahrend die genaue Auspragung der Uberlappung (,An welcher Stelle der Einheit von Sprecher
A setzt B mit seiner Phrasierungseinheit ein?) nicht feststellen Iasst. Folglich kdnnen in der Ausgabe an
dieser Position keine Klammern gesetzt werden. (Die Ursache hierfur ist, dass das Ereignis in der Spur
von Sprecher A sich Uber mehr als ein Zeitintervall erstreckt.). Der Partitur-Editor gibt daher in solchen
Fallen eine Warnung aus:

& There are events in tiers of bype 't spanning more than one inkerwval,

Cancel | Edit |

Es werden drei Optionen angeboten:

] Continue: Der Vorgang wird fortgesetzt. Diejenigen Elemente, fir die es ein Problem mit der Markie-
rung von Uberlappungen gibt, werden dann jedoch in der Ausgabe entsprechend unzuverlassig be-
handelt.

" Cancel: Der Vorgang wird abgebrochen.

" Edit: Der Vorgang wird abgebrochen, und es wird eine Liste der problematischen Elemente ange-
zeigt. So fir obiges Beispiel:
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Goto |

Durch Klicken auf Go fo wird die Partitur an die betreffende Stelle gerollt, sodass das Problem dann
dort unmittelbar bearbeitet werden kann.

Im obigen Beispiel kann das Problem z. B. dadurch behoben werden, dass das betreffende Ereignis an
der geeigneten Stelle geteilt wird, sodass der Einsatzpunkt der Uberlappung festgestellt werden kann:

b1 2 3
AR Glsh |50 was-
B ] was izt denn |jetzt schon wieder?

001 A: also [so was- ]
002 B: [was ist denn ]jetzt schon wieder?

Segmentation > Export segmented transcription (XML)

Exportiert eine segmentierte Transkription in eine XML-Datei, die konform zur EXMARaLDA-DTD ,seg-
mented-transcription.dtd” ist. Es erscheint ein Dialog, in dem der Speicherort und der Dateiname der zu
exportierenden XML-Datei festgelegt werden kdnnen.

(Bei dieser Funktion werden lediglich Ereignisse zu Sprecherbeitragen zusammengefasst. Um eine Seg-
mentierung nach weiteren Einheiten und gemaR einer bestimmten Transkriptionskonvention in eine XML-
Datei zu exportieren, wahlen Sie die entsprechende Funktion aus einem der Untermen(s.)

Segmentation > Export segment chain list (HTML)

Exportiert eine Liste von Sprecherbeitrdgen in ein HTML-Format. Dies geschieht unabhangig von der
verwendeten Transkriptionskonvention.

Segmentation > Export segment chain list (XML)

Exportiert eine Liste von Sprecherbeitrdgen in eine XML-Datei, die konform zur EXMARaLDA-DTD ,list-
transcription.dtd® ist. Dies geschieht wiederum unabhangig von der verwendeten Transkriptionskonventi-
on.

Segmentation > HIAT segmentation > Segmented transcription (XML)

Exportiert eine segmentierte Transkription in eine XML-Datei, die konform zur EXMARaLDA-DTD ,seg-
mented-transcription.dtd” ist. Dabei werden Segmentketten gemaR den HIAT-Konventionen in AuRerun-
gen, Worter, Interpunktion und nicht-phonologische Einheiten segmentiert. Wenn die Segmentierung
aufgrund nicht-konventionsgemaliem Gebrauch von Zeichen misslingt, wird — wie oben beschrieben —
eine entsprechende Fehlermeldung ausgegeben und der Prozess abgebrochen. War die Segmentierung
hingegen erfolgreich, erscheint ein Dialog, in dem der Speicherort und der Dateiname der zu exportieren-
den XML-Datei festgelegt werden kénnen.
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Segmentation - HIAT segmentation = Utterance list (HTML)

Exportiert eine Liste von AuBerungen in eine HTML-Datei. Die Auerungen werden dabei gemaR den in
den HIAT-Konventionen festgelegten AuRerungsendzeichen ermittelt. Wenn die Segmentierung aufgrund
nicht-konventionsgemaRem Gebrauch von Zeichen misslingt, wird — wie oben beschrieben — eine ent-
sprechende Fehlermeldung ausgegeben und der Prozess abgebrochen. War die Segmentierung hinge-
gen erfolgreich, erscheint ein Dialog, in dem der Speicherort und der Dateiname der zu exportierenden
HTML-Datei festgelegt werden kénnen.

Unter Umstanden verlauft zwar die Segmentierung erfolgreich, die segmentierten AuRerungen lassen
sich aber nicht alle eindeutig zeitlich zueinander anordnen. In diesem Falle wird folgende Warnung aus-
gegeben:

warning x|

& The list canmat be completely ardered.

Cancel | Edit |

Naheres dazu ist oben unter ,Fehlerursachen beim Segmentieren® ausgefuhrt.

Die Ausgabe kann Uber ein Stylesheet, das unter ,Edit > Preferences... > Stylesheets” als ,HIAT utte-
rance list to HTML" angegeben ist, parametrisiert werden. Siehe dazu auch Anhang D ,EXMARaLDA und
Stylesheets®.

Segmentation > HIAT segmentation - Utterance list (XML)

Exportiert eine Liste von AuRerungen in eine XML-Datei, die konform zur EXMARaLDA-DTD list-
transcription.dtd” ist. Diese Funktion unterscheidet sich von der oben beschriebenen Funktion ,Segmen-
tation > HIAT Segmentation - Utterance List (HTML)“ nur im Format der Ausgabe.

Segmentation > HIAT segmentation > Word list (HTML)

Exportiert eine (alphabetisch sortierte) Wortliste in eine HTML-Datei, die mit der Originaltranskription ver-
knUpft ist. Die Segmentierung nach Wértern ergibt sich durch die Verwendung von Wortbegrenzern ge-
manR den HIAT-Konventionen. Wenn die Segmentierung aufgrund nicht-konventionsgemafiem Gebrauch
von Zeichen misslingt, wird — wie oben beschrieben — eine entsprechende Fehlermeldung ausgegeben
und der Prozess abgebrochen. War die Segmentierung hingegen erfolgreich, erscheint ein Dialog, in dem
der Speicherort und der Dateiname der zu exportierenden HTML-Datei festgelegt werden kdnnen.

Die Formatierung der ausgegebenen Partitur richtet sich nach den im Editor festgelegten Formatierungs-
parametern (siehe auch ,Format > Edit format table...“ und ,File - Partitur parameters...“).

Eine Wortliste, verknupft mit der zugehdrigen Transkription in Partiturnotation, wirde beispielsweise wie
folgt aussehen.



EXMARaLDA Partitur-Editor — Handbuch Segmentation-Meni

'3 C:AWINNT\Profiles\Thomas\DESKTOPADUT _html - Microsoft Internet Explorer von Carl Hanser Yerlag. Munchen

Datei  Bearbeiten  Ansicht  Favorten  Extras 7 n
o > ¥ = = = = B
%] A el (d 3 B = e B
Abbrechen  Aktualisieren  Startseite Suchen Favoriten Werlauf E-Mail Drucken  Bearbeten Diskussion
Go glt" - | j %%Web-Suche
Adresse |@ C:MWINMNT WProfilesh Thomas\DESKTOPYWOUT html ﬂ o Wwiechseln zu
1] da
dat
""""""""""""""""""""""""""""""""""""""""""""""""""""""""""" dat
KLA fv] Oh, dakommt einer Komemtnoch einer. ((hustet)) Wa'? Oty dat katn ja fic] sinar
ELA [eng] Ch, somebody’s coming. Another one coraing. {{coughs)) What? Ok, that can't be true siner
ERW [v] ((hastet). Och niee, dat jiwet ja nich. ja
ERW [enz] {{coughsy) Ohno, T dor't belisve it. Ia
"""""""""""""""""""""""""""""""""""""""""""""""""""""""""""" | jiwet
|| kann
| L kommt [
€] 5 Arbeitsplatz

Segmentation > HIAT segmentation - Count segments

Segmentiert die Transkription gemaf HIAT-Konventionen und zahlt die dabei entstehenden Segmente.
Wenn die Segmentierung aufgrund nicht-konventionsgemafiem Gebrauch von Zeichen misslingt, wird —
wie oben beschrieben — eine entsprechende Fehlermeldung ausgegeben und der Prozess abgebrochen.
War die Segmentierung hingegen erfolgreich, erscheint ein Dialog, in dem das Ergebnis der Zahlung
angezeigt wird.

% Count Result

tribution_Utterance
fname HIAT:ip
e HIAT:u
HIAT non-pho

81,4 Save...

Klicken Sie auf Save... , falls Sie den Inhalt des Dialogfensters in einer Text-Datei abspeichern mdchten.
Das Suchergebnis...
Tier KLA [V]

Segmentation SpeakerContribution Utterance Word
385 segments of name HIAT:ip

49 segments of name HIAT:u

15 segments of name HIAT:non-pho

19 segments of name sc

230 segments of name HIAT:w

... besagt beispielsweise, dass in der mit ,KLA [v]“ bezeichneten Spur

385 Segmente als Interpunktion (,HIAT:ip"),
49 Segmente als AuRerungen (,HIAT:u),
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15 Segmente als nicht-phonologische Einheiten (,HIAT:non-pho*),
19 Segmente als Sprecherbeitrage (,HIAT:sc") und
230 Segmente als Worter (,HIAT:w*)

segmentiert wurden.

Segmentation > DIDA segmentation > Segmented transcription (XML)

Exportiert eine segmentierte Transkription in eine XML-Datei, die konform zur EXMARaLDA-DTD ,seg-
mented-transcription.dtd® ist. Dabei werden Segmentketten gemafl den DIDA-Konventionen in Woérter,
Interpunktion und nicht-morphemisierte AuRerungen segmentiert. Wenn die Segmentierung aufgrund
nicht-konventionsgemaRem Gebrauch von Zeichen misslingt, wird — wie oben beschrieben — eine ent-
sprechende Fehlermeldung ausgegeben und der Prozess abgebrochen. War die Segmentierung hinge-
gen erfolgreich, erscheint ein Dialog, in dem der Speicherort und der Dateiname der zu exportierenden
XML-Datei festgelegt werden koénnen.

Segmentation - DIDA segmentation > Word list (HTML)

Exportiert eine (alphabetisch sortierte) Wortliste in eine HTML-Datei, die mit der Originaltranskription ver-
knipft ist. Die Segmentierung nach Woértern ergibt sich durch die Verwendung von Wortbegrenzern ge-
maf den DIDA-Konventionen. Wenn die Segmentierung aufgrund nicht-konventionsgemafiem Gebrauch
von Zeichen misslingt, wird — wie oben beschrieben — eine entsprechende Fehlermeldung ausgegeben
und der Prozess abgebrochen. War die Segmentierung hingegen erfolgreich, erscheint ein Dialog, in dem
der Speicherort und der Dateiname der zu exportierenden HTML-Datei festgelegt werden kénnen.

Die Formatierung der ausgegebenen Partitur richtet sich nach den im Editor festgelegten Formatierungs-
parametern (siehe auch ,Format > Edit format table...“ und ,File > Partitur parameters...“).

Eine Wortliste, verknlpft mit der zugehoérigen Transkription in Partiturnotation, wirde beispielsweise wie
folgt aussehen.

Datei  Bearbeiten  Ansicht  Favoriten  Extras 7 ﬁ
4= Zuriick. - = - @ at | @Suchen [Fe] Favoriten @ | %v = ﬂ - &
Go gle - I j| fpweb-Suche - | @ | s blackiert | EOptionen »
Adresse I@ C:iDokumente und EinstellungenithomasiDeskboplout, html j @Wechseln Zu
o || wesitzen |
0o 10 2141 hesonders
GD:[.] krise. <we"nn man sagt * das spiel war enttin schend.> ** danm ist eindeutig n bisschen zu wenig, wennme || Pesser =
K BLICKT M DIE EAMERS hesser
K+ EFGIOVDER VIDEGDATES hesser
hessere
[ heste
hetraffen
- 3] 4] heurteilung
GD: dass es richtig frustrierend dann ist es z0 pa"ssiv” * wenn man sagt das war wieder mal * sin a"haoluter never tiefpunkt™ * trifft es d hewegt
K WENDET DEH EOPF ZU7 GH hewerten
GN: hewertet
K+ TOTAIR hewundert
heziehungsweise
[ bi
hin
o 6[17] 708] hin
‘GN: tiefpunkt und * ich versteh die spieler auch nicht mum schluss jetzt auch noch ke gel- * waram sagen sie nicht einfach das warn sch hin
K WENDETDENKEOPFHACHLIMES ~ WENDETDEHE! bin
|| hin -
‘ | i T o
|®j l_ ’_ ’_ |@‘ Arbeitsplatz 4

Segmentation > DIDA segmentation > Count segments

Segmentiert die Transkription gemafy DIDA-Konventionen und zahlt die dabei entstehenden Segmente.
Wenn die Segmentierung aufgrund nicht-konventionsgemaflem Gebrauch von Zeichen misslingt, wird —
wie oben beschrieben — eine entsprechende Fehlermeldung ausgegeben und der Prozess abgebrochen.
War die Segmentierung hingegen erfolgreich, erscheint ein Dialog, in dem das Ergebnis der Zahlung
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angezeigt wird.

Tier GN 4]

OK | Save... |

Klicken Sie auf Save... , falls Sie den Inhalt des Dialogfensters in einer Text-Datei abspeichern mdchten.

Das Suchergebnis...
Tier GD [Vv]

Segmentation SpeakerContribution Word
1 segments of name DIDA:ref

48 segments of name DIDA:pause

413 segments of name DIDA:ip

314 segments of name DIDA:w

2 segments of name DIDA:om

8 annotations of name k

... besagt beispielsweise, dass in der mit ,GD [v]* bezeichneten Spur

1 Segment als Referenzzeichen (,DIDA:ref),
48 Segmente als Pausen (,DIDA:pause®),

413 Segmente als Interpunktion (,DIDA:ip®),

314 Segmente als Worter (,DIDA:w")

2 Segmente als Auslassungen (,DIDA:om*) und
8 Segmente als Annotationen des Typs kK’

segmentiert wurden.
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Die GAT-Segmentierung ist in der derzeitigen Version eine ,Proof of concept‘-Implementierung. D.h. sie
dient in erster Linie dazu, potentielle Moglichkeiten von EXMARaLDA und dem Partitur-Editor aufzuzei-
gen und ist noch nicht umfassend in der Praxis getestet worden. Hinweise Uiber Probleme oder Verbesse-
rungsvorschlage sind jederzeit herzlich willkommen.

Segmentation > GAT segmentation > Segmented transcription (XML)

Exportiert eine segmentierte Transkription in eine XML-Datei, die konform zur EXMARaLDA-DTD
~.Ssegmented-transcription.dtd” ist. Dabei werden Segmentketten gemall den GAT-Konventionen
in  Phrasierungseinheiten segmentiert. Wenn die Segmentierung aufgrund nicht-
konventionsgemalRem Gebrauch von Zeichen misslingt, wird — wie oben beschrieben — eine ent-
sprechende Fehlermeldung ausgegeben und der Prozess abgebrochen. War die Segmentierung
hingegen erfolgreich, erscheint ein Dialog, in dem der Speicherort und der Dateiname der zu ex-
portierenden XML-Datei festgelegt werden kdnnen.

Segmentation > GAT segmentation > GAT Transcript (TXT)

Segmentiert die Transkription gemaR GAT nach Phrasierungseinheiten und gibt auf dieser
Grundlage ein GAT-Transkript in Zeilennotation als Textdatei aus. Dabei wird zunachst gepriift,
ob die Klammerung Uberlappender Passagen zuverlassig markiert werden kann (s.o. unter ,,,Feh-
lerursachen beim Segmentieren®). Ist dies nicht der Fall, wird folgende Warnung ausgegeben:

& There are events in tiers of bype 't' spanning more than one inkerwval,

Cancel | Edit |

Anschlielend wird die eigentliche Segmentierung vorgenommen. Wenn die Segmentierung auf-
grund nicht-konventionsgemaRem Gebrauch von Zeichen misslingt, wird — wie oben beschrieben
— eine entsprechende Fehlermeldung ausgegeben und der Prozess abgebrochen. War die Seg-
mentierung hingegen erfolgreich, wird als nachster Schritt die Uberfiihrung in eine Liste ausge-
fuhrt. Auch dabei kann es — falls diese Liste sich nicht eindeutig ordnen lasst — zur Anzeige einer
Warnung kommen (siehe wiederum oben unter ,Fehlerursachen beim Segmentieren®).

SchlieBlich wird ein Dialog angezeigt, in dem der Name der zu speichernden Textdatei festgelegt
werden kann:

% Set the text file for expork il
Speichern in; Im Desktop ;I Ifi(

@ Eigene Dateien Char encoding
E—EJ_, Arbeitsplatz
Metzveerkumgebung

[:I Eclipse

|[System-Detaut] =

[:I LiteraryaLinguistic Computing 11,2002 |50-8559-1 (Standard Latin)
1 bl i

Arnazon_Gutschein txt LITF-16 (Big Enclian)
Ed ey UTF-16 (Little: Erclian)

test bt

Dateinarme: I Speichern |

Dateityp: Ip|ain text (TKT) LI Abbrechen
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Dabei kann unter ,Char encoding” die zu verwendende Zeichenkodierung festgelegt werden. Die
so exportierte Textdatei lasst sich mit jedem Texteditor (z.B. Notepad) oder Textverarbeitungs-
programm (z.B. Ms Word) 6ffnen:

& test.txt - Editor =101 x|
Datei  Beatbeiten Format 7

o1 s1i: dar: B
ooz [.) die VIERziger generationh sSo:=

oo =das=z: 'WA:HW!sinnig wviele die =zich da hamw [JCHEIden] lasse[n.=]

o004 32: [Ja: 1]

0as [hr, ]

006 S1: =oder scheiden lassen UEERhaupt.

oo7? S2:  hm,
oos  S1: heute noch-

oo9 [Z2.1)2=1iz der UMbruch.

oio 32 1 besonders GUtes heispiel das warn mal unsere NACHbDarn.

011 (1.0)&lm (1.0) DREISsig jahre werheiratet,

o1z [——)das letzte Kind (.) endlich aus m HLUS,

o1z zurn StubIERN,

014 [--1 WEGgegangen, ‘:J

Die CHAT-Segmentierung ist in der derzeitigen Version eine ,Proof of concept“-Implementierung. D.h. sie
dient in erster Linie dazu, potentielle Méglichkeiten von EXMARaLDA und dem Partitur-Editor aufzuzei-
gen und ist nicht umfassend in der Praxis getestet worden. Hinweise tber Probleme oder Verbesse-
rungsvorschlage sind jederzeit herzlich willkommen.

Segmentation > CHAT segmentation > CHAT Transcript (CHA)

Segmentiert die Transkription gemaR CHAT nach AuRerungen (,Utterances) und gibt auf dieser
Grundlage ein CHAT-Transkript in Zeilennotation als Textdatei aus. Dabei wird zunachst gepruft,
ob die Klammerung Uberlappender Passagen zuverlassig markiert werden kann (s.o. unter ,,,Feh-
lerursachen beim Segmentieren®). Ist dies nicht der Fall, wird folgende Warnung ausgegeben:

& There are events in tiers of type 't spanning more than one inkerwval,

Cancel | Edit |

Anschlieflend wird die eigentliche Segmentierung vorgenommen. Wenn die Segmentierung auf-
grund nicht-konventionsgemaRem Gebrauch von Zeichen misslingt, wird — wie oben beschrieben
— eine entsprechende Fehlermeldung ausgegeben und der Prozess abgebrochen. War die Seg-
mentierung hingegen erfolgreich, wird als nachster Schritt die Uberfiihrung in eine Liste ausge-
fuhrt. Auch dabei kann es — falls diese Liste sich nicht eindeutig ordnen lasst — zur Anzeige einer
Warnung kommen (siehe wiederum oben unter ,Fehlerursachen beim Segmentieren®).

SchlieBlich wird ein Dialog angezeigt, in dem der Name der zu speichernden Textdatei festgelegt
werden kann:
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X

% Set the text file for export

Speichern ir: I:ﬂ Desktap ;I rj(
@ Eigene Dateien ~Chat encoding
Arbeftsplatz I[S\_.fstem-Defaurt] LI
Metzwerkumaebung 5
D Eclipze

[ Literary&Linguistic Computing 1 2002

1 huel

..... ITF-5

E Armazon_Zutschein txt UITF-16 (Big Encian)

=] GaTid UITF-16 (Little Enclian)

=] testixt

Dateinatne: I Speichern
Dateftyp:  [prain texd (TxT) v|  abbrechen |

Dabei kann unter ,Char encoding” die zu verwendende Zeichenkodierung festgelegt werden. Die
so exportierte Textdatei 18sst sich mit dem CLAN-Editor, aber auch mit jedem Texteditor (z.B. No-
tepad) oder Textverarbeitungsprogramm (z.B. Ms Word) &ffnen:

TClan - [test.cha] -10] x|
gm File Edit Wew Tiers Mode Window Help _|E’|
Xl

D|=(E]| #|=(8| S(2)

Ready

|[@E=gin ;I
@FParticipant=s: MOT, CHI

*MOT : Who== boolk iz that?

=_HT : Hine.

*CHT : Mv boolk: .

WEnd

o

Y

Segmentation > TEl segmentation > TEI Transcription (XML)

Strukturiert die Transkription in Segmentketten und gibt davon ausgehend eine Transkription in TEl-
konformem XML aus (siehe dazu Schmidt, Th. 2004: Time based data models and the TEI Guidelines for
Transcriptions of Speech. Erscheint als Arbeit zur Mehrsprachigkeit, Serie B.).
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. Help-Menii

Help > About

Zeigt einen Info-Dialog an, dem Sie entnehmen kdnnen, mit welcher Version des Editors Sie momentan
arbeiten. Aullerdem werden die Version der verwendeten Java-Laufzeitumgebung (,Java version®) und
das verwendete Betriebssystem (,Operating system®/,0S Version®) angegeben:

8

W I EXNMARaLDA

PARTITUR-EDITOR

Wersion 1.3, (01l-%ep-2004)
(C) E001, zooz, Z003, 2004 by Thomas Schmide.
thomas . schwidt@ani -hawmburg. de
http: S fwmr rrz . oani-hawburg. defexmaralda
http: S fwmnr rrz . oani-hawburg. de /S2FEEZE
Thank= to all beta tester= and bug reporters.

Please do not copy, redistribute etc.

Java Wersion: 142 05
Operating system: Windoses 2000
IS wersion: 5.0

K I
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V. PANELS

A. Virtuelles Keyboard

Das virtuelle Keyboard dient der Eingabe von Zeichen, die unter Umstanden nicht Uber die Tastatur zu-
ganglich sind. Sollte Ihre Tastatur mit den jeweiligen Zeichen ausgestattet sein, kdnnen Sie die Eingabe
auch uber die Tastatur vornehmen. Falls das virtuelle Keyboard nicht automatisch auf lhrem Bildschirm
erscheinen sollte, wahlen Sie View 2 Show Panels 2 Keyboard, um es anzeigen zu lassen.

S Keyboard

Um ein Zeichen aus dem virtuellen Keyboard in die Partitur einzufigen, bewegen Sie den Cursor an die
entsprechende Stelle in der Partitur und klicken Sie mit der Maus auf das gewlnschte Zeichen. Um einen
anderen als den momentan im virtuellen Keyboard angezeigten Zeichensatz zu erhalten, wahlen Sie
mittels Klick auf die Pfeiltaste aus der oberen Liste aus. Bitte beachten Sie:

" Eine Reihe von Zeichen im virtuellen Keyboard steht nur in wenigen Schriftsdtzen zur Verfigung,
die eine groRe Anzahl an Unicode-Bereichen abdecken (z. B. ,Arial Unicode MS*). Welcher Schrift-
satz im Keyboard selbst verwendet wird, kdnnen Sie Uber ,Edit > Edit preferences” festlegen Wenn
Sie statt des gewilnschten Zeichens in der Partitur nur ein Rechteck erhalten, missen Sie die
betreffende Spur in diese Schriftart umformatieren (siehe auch ,Format - Edit format table®).

" Sollten Sie Zeichen vermissen oder die Reihenfolge der Zeichen in einem Zeichensatz als unzu-
l&nglich empfinden, schreiben Sie bitte eine kurze E-Mail an thomas.schmidt@uni-hamburg.de.
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B. Link Panel

Das Link Panel dient der Verknupfung von Ereignisbeschreibungen mit externen Bild-, Ton-, Video- oder
Text-Dateien. Falls das Link Panel nicht auf lhrem Bildschirm erscheinen sollte, wahlen Sie View 2 Show
Panels 2 Link Panel, um es anzeigen zu lassen.

% Link Panel i X
= ~Ewvent description
Bild1
~Link Medium
liesor Beraich st fiir Ilmage LI
das Steigenlassen
van Leakdrachen ~Link URL

ISturmekachent erauht,
deglize by sin ol
this:ﬂl!l: Rtkeicn |||"RH.
SRR E e e
T s

||as'l.l»{rimsl'(rams'lﬂilder'l."-.f'erbuﬂ jpc Browse. . |

Um ein Ereignis mit einer externen Datei zu verkniipfen, wahlen Sie das betreffende Ereignis in der Parti-
tur aus, stellen Sie unter ,Link Medium*® ein, ob es sich um ein Bild (Image), eine Ton-Datei (Audio), eine
Video-Datei oder eine Text-Datei handelt. Geben Sie dann unter ,Link URL" den Speicherort der zu ver-
knipfenden Datei ein. Klicken Sie auf Browse... um einen Dialog zu 6ffnen, mit dem Sie die jeweilige
Datei auf lhrem Rechner suchen kénnen. Wenn es sich bei dem Verweis um ein Bild handelt, so wird
dieses in der linken Halfte des Link Panels angezeigt. Audio-, Video- und Textverweise werden hingegen
im Partitureditor selbst nicht angezeigt, sondern erst bei einem Export in ein HTML-Dokument (s. o.).

C. Segmentation Panel

Das Segmentation Panel dient der Uberpriifung der Segmentierung, d. h. beispielsweise der gemaR HIAT
gliltigen Verteilung von AuBerungsendzeichen und Wortendzeichen, die die Voraussetzung fiir den Ex-
port von AuRerungs- und Wortlisten und fiir den Export einer segmentierten Transkription ist. Falls das
Segmentation Panel nicht automatisch auf lhrem Bildschirm erscheinen sollte, wahlen Sie View = Show
Panels 2 Segmentation Panel, um es anzeigen zu lassen.

% Segmentation Panel x|
et zpeaker cortribution Parze speaker contribiution
—Speaker Contribution Text ~Parzed Result
Oreizehn Mann auf des toten Mannes Kiste, [[schniffelt]] _| sc: Oreizehn Mann auf des toten Mannes Kiste. [[sch;
Eoah, wat stinkt dat wiederin der Tropfsteinhdhle. Oh, da _| HI&T:u - Oreizehn Mann auf des toten Mannes Ei
st Gl Lol weed stuel ([ ives ] HIST:u : [[schniiffelt]) Boah, wat stinkt datwieder
= | HIAT:u : Oh, da kemmt einer.
- ; & HIATxw : Oh
~Finite State Machine L HIAT:ip:,
HIAT: Utterances and words - | DRt | — % HIAT:p:
— 4 HIATww: da
~Mezzages — & HI&T:ip b
— 4 HIATw : kornmt
— 4 HIAT:ip:
— 4 HIATw : ciner 7
Rl | »
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Die Uberpriifung der Segmentierung erfolgt immer sprecherbeitragsweise. Ein Sprecherbeitrag ist defi-
niert als eine zusammenhangende Folge von Ereignissen in einer Spur vom Typ ,T(ranscription)® (siehe
hierzu auch ,Segmentation-Men(*).

Um einen Sprecherbeitrag auf die giiltige Verteilung von AuRerungs- und/oder Wortendzeichen hin zu
Uberprifen, klicken Sie zunachst in der Partitur in ein beliebiges Ereignis, das Teil dieses Sprecherbei-
trags ist. Wahlen Sie dann Get speaker contribution im Segmentation Panel. Der Text des Sprecherbei-
trags wird nun links oben angezeigt (oder eine Fehlermeldung unter ,Messages®, falls Sie sich in einem
leeren Ereignis oder nicht in einer Spur vom Typ , T“ befinden). Wahlen Sie anschlieRend eine die Endli-
che Maschine (,Finite State Machine*) aus, mit der der Sprecherbeitrag segmentiert werden soll:

" HIAT: Utterances and Words: ist die Grundlage aller Segmentierungsfunktionen des Untermenis
-HIAT Segmentation” des Segmentation-Mends.

" Generic: Words: ist eine experimentelle Endliche Maschine, die derzeit noch nicht mit korrespondie-
renden Segmentierungsfunktionen versehen ist.

" CHAT: Utterances: ist ebenfalls eine experimentelle Endliche Maschine, die derzeit noch nicht mit
korrespondierenden Segmentierungsfunktionen versehen ist.

Klicken Sie anschlieRend auf Parse speaker contribution. Der Sprecherbeitrag wird entweder erfolgreich
in AuRerungen und/oder Worter zerlegt (in diesem Falle erscheint unter ,Messages“ die Meldung ,Spea-
ker contribution parsed successfully“ und im rechten Teil des Panels wird der Resultat in Baumform an-
gezeigt) oder der Sprecherbeitrag kann nicht mit der gewahlten Endlichen Maschine zerlegt (,parsed®)
werden. In diesem Fall erhalten Sie unter ,Messages” eine entsprechende Fehlermeldung. Suchen und
beheben Sie den Fehler in der Partitur und wiederholen Sie dann den hier beschriebenen Vorgang.

D. Audio Panel

Das Audio-Panel dient dem Abspielen einer digitalisierten Aufnahme und dem Zuordnen von absoluten
Zeitwerten aus dieser Aufnahme zu Punkten der EXMARaLDA-Zeitachse. Falls das Audio Panel nicht
automatisch auf lhrem Bildschirm erscheinen sollte, wahlen Sie View = Show Panels 2 Audio Panel,
um es anzeigen zu lassen.

x|

% Audio Panel

;ﬂl JHelge_neuihelge war

Start
_I IF NG M
Stop
1 ™ ame 4]l
Fosition
a | [ |

0.0 304 F55 ag5.a 1194 szec

O | = |

Playback started.
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Das Audio-Panel enthalt die folgenden Bedienungselemente:

% Audio Panel

~Fosition \

9 119.4 sec

Playback stérted,

@V o] ) [12

Normalerweise wird versucht, die Audio-Datei zu laden, die in der momentan im Editor getffneten
Transkription als ,Referenced file* (unter Meta-Information) angegeben ist. Sollten Sie eine andere Audio-
Datei verwenden wollen, klicken Sie auf den ,Datei 6ffnen“-Button (1), und wahlen Sie anschlielend die
zu 6ffnende Datei aus.

Die drei Schieberegler zeigen die Start- und Endposition sowie die aktuelle Position in der Audio-Datei
an.

Der Start-Schieberegler (2) legt fest, an welcher Position in der Datei das Abspielen beginnen soll. Der
entsprechende numerische Wert (Sekunden ab Dateibeginn) wird in der Zahlenreihe unter den Schiebe-
reglern in gruner Farbe angezeigt.

Der Stop-Schieberegler (3) legt fest, an welcher Position in der Datei das Abspielen enden soll. Der ent-
sprechende numerische Wert (Sekunden ab Dateibeginn) wird in der Zahlenreihe unter den Schiebereg-
lern in roter Farbe angezeigt.

Wahrend des Abspielens zeigt der Positions-Schieberegler (4) die Position in der Datei an. Der entspre-
chende numerische Wert (Sekunden ab Dateibeginn) wird in der Zahlenreihe unter den Schiebereglern in
schwarzer Farbe angezeigt.

Das Abspielen einer Datei wird Uber den Start-Button (10) gestartet und kann anschliel3end tber den
Pause-Button (11) angehalten und wieder aufgenommen werden oder Gber den Stop-Button (12) beendet
werden. Wenn die Stop-Position oder das Ende der Datei erreicht ist, wird das Abspielen automatisch
beendet.

Es gibt mehrere Mdglichkeiten, Start- und Stop-Zeit fir das Abspielen zu andern:

" Betatigen der Start- und Stop-Schieberegler (2 und 3)

] Ubertragen der momentan ausgewahlten Zeitwerte aus der Transkription: Beim Klicken auf die mit
(8) bezeichneten Buttons werden die absoluten Zeitwerte ermittelt, die der momentanen Auswahl in
der Transkription im Editor entsprechen und auf den Start- bzw. den Stop-Schieberegler Gbertragen.

] Synchronisieren der Start- und Stopzeiten mit der Auswahl in der Transkription. Wenn die sync-
Optionen des Start- und Stop-Schiebereglers (7) ausgewahlt sind, wird die Ubertragung der mo-
mentan ausgewahlten Zeitwerte aus der Transkription (s.0.) automatisch vorgenommen, d.h. die
Start- und Stopzeiten werden fortwahrend an die Auswahl in der Transkription im Editor angepasst.
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] Ubertragen der Pausenzeit: Wenn die Aufnahme (iber den Pause-Button angehalten wurde, kann
die aktuelle Position mit den Buttons (9) auf den Start- bzw. den Stop-Schieberegler tbertragen
werden.

Uber die mit (5) bezeichneten Buttons kénnen die aktuellen Werte des Start-, Stop- und Pause-

Schiebereglers auf einen in der Transkription markierten Zeitpunkt Gbertragen werden. Wenn kein Zeit-
punkt in der Zeitachse der Transkription markiert ist, sind diese Buttons deaktiviert.

E. Praat Panel

Bitte beachten Sie: Das Praat Panel ist nur unter Windows verflgbar. Die Verwendung des Praat-Panels
setzt voraus, dass die Programme PRAAT und SENDPRAAT auf lhrem Rechner installiert sind und der
Systempfad auf das Verzeichnis zeigt, in dem diese Programme liegen.

Das Praat-Panel dient dem Abspielen einer digitalisierten Aufnahme und dem Zuordnen von absoluten
Zeitwerten aus dieser Aufnahme zu Punkten der EXMARaLDA-Zeitachse. Falls das Praat Panel nicht
automatisch auf Ihrem Bildschirm erscheinen sollte, wahlen Sie View - Show Panels 2 Praat Panel,
um es anzeigen zu lassen.

% Praat Panel x|

FaY ¥l .
Start Praat SeEtings...

g‘ﬂ Chooze. . @ [Relload
% Set @ et

| Synchronize with selection

Meszages

Dossst Beizpie... neuhelge waw
Start: En:

Damit das Praat-Panel funktionieren kann, missen Sie auf lnrem Rechner die Programme PRAAT und
SENDPRAAT installiert haben. Die jeweils aktuellste Version von PRAAT erhalten Sie Uber die Website

http://www.praat.org.

Die jeweils aktuellste Version von SENDPRAAT liegt ebenfalls dort, und zwar unter der Adresse.

http://www.fon.hum.uva.nl/praat/sendpraat.html

Laden Sie beide Programme auf lhren Rechner in das gleiche Verzeichnis (z.B. c:\Programme\Praat).
Richten Sie anschlie3end Uber die Systemeinstellungen (z.B. unter Windows 2000: Start - Einstellungen
- Systemsteuerung - System - Erweitert > Umgebungsvariablen) den Systempfad so ein, dass er
dieses Verzeichnis enthalt. Nur so kann der EXMARaLDA Partitur-Editor mit einer laufenden Instanz von
PRAAT kommunizieren.

Wenn Sie diese Einstellungen einmal vorgenommen haben, kénnen Sie Uber den ,Start Praat“-Button
PRAAT aus dem Partitur-Editor heraus starten. Dies nimmt einige Sekunden in Anspruch — warten Sie,
bis das Programm vollstandig gestartet ist, und bestatigen Sie anschlieRen den ,Starting Praat...“-Dialog,
der im Partitur-Editor angezeigt wird, mit OK.
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Starting Praat... x|

& Press Ok when Praat is up and running.

Wenn in den Meta-Informationen der aktuell im Partitur-Editor geladenen Transkription eine Audio-Datei
unter ,Referenced File* eingetragen ist, so wird diese standardmaRig vom Praat-Panel als in Praat zu
ladende Datei eingesetzt. Wenn dort nichts angegeben ist oder Sie eine andere Audio-Datei in Praat
laden mochten, verwenden Sie den ,Choose...“-Button.

Das eigentliche Laden der Datei erfolgt dann tber den ,(Re)load“-Button. Nach Betatigen dieses Button
sollte PRAAT ein ,Long Sound“-Fenster gedffnet haben, das ein Oszillogramm und moglicherweise wei-
tere Visualisierungen der Audio-Datei anzeigt:

i LongSound helge ] 4
File Edt Query “iew Seleck Spectrum  Pitch  Inbensity  Formant  Pulses Help

20047509

O L LSS . e M, Lt

05817

-0.675
5000 Hz|

100 4B

0 Hz|

3.787589 3.702401

26.250000 |2E.250000 Mizible part 7.500000 s2conds 32750000 25655714
Total duration 119 405714 seconds
all | outI ze |ﬂ I jpﬁmup

Arrangieren Sie dieses Fenster so auf dem Bildschirm, dass Partitur, Praat-Panel und Long Sound-
Window gleichzeitig zuganglich sind.

Um den in PRAAT angezeigten Ausschnitt der Audio-Datei zu bestimmen, gibt es zwei Mdglichkeiten:

1) Wahlen Sie im Partitur-Editor einen Ausschnitt aus der Transkription aus. Betatigen Sie dann den
~Set“-Button im Praat-Panel. Die zum Ausschnitt gehoérigen absoluten Zeitwerte aus der Zeitachse in der
Transkription werden als Start- und Endwerte des in PRAAT angezeigten Ausschnitts verwendet.

2) Aktivieren Sie die Option ,Synchronize with selection“ im Praat-Panel. Die Auswahl im Partitur-Editor
wird dann automatisch mit dem angezeigten Abschnitt der Audio-Datei in Praat synchronisiert.

Wahrend der ,Set“-Button also Zeitwerte aus dem Partitur-Editor an PRAAT (ibermittelt, dient der ,Get"-
Button der Kommunikation in der umgekehrten Richtung. Wenn im Partitur-Editor ein Punkt der Zeitachse
markiert ist, kann Uber den ,Get“-Button diesem Zeitpunkt der absolute Zeitwert zugeordnet werden, an
dem sich der Cursor in PRAAT (die rote Linie in der obigen Abbildung) befindet. Siehe dazu auch Anhang
F.
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VI.ANHANG A: IMPORTIEREN VON SYNCWRITER-DATEN

A.

B.

Technische Voraussetzungen

Mac OS X (10.2.: Jaguar) mit Java 1.3.1.

Lauffahige Version des syncWRITERs (Getestet wurde mit Version D1-2.0.2. Ob andere Versionen
sich anders verhalten, ist nicht bekannt.)

EXMARaLDA Partitur-Editor in der jeweils aktuellsten Version
Apple-Skript ExSync
Apple-Skript CountEntries

Anleitung

Vorbereiten des zu konvertierenden syncWRITER-Dokuments

1.

Offnen Sie das zu konvertierende Dokument im syncWRITER und schlieRen Sie alle anderen Do-
kumente im syncWRITER.

Léschen Sie ferner alle Bild-, Film- und Skriptspuren, da diese nicht tberfiihrt werden kénnen.

Falls nicht schon vorhanden: Tragen Sie einen syncTab am Anfang des Dokuments ein und syn-
chronisieren Sie den Beginn jeder Spur mit diesem syncTab.

Wenn eine Spur in einer nicht standardmafig kodierten Schriftart formatiert ist (also z. B. und insbe-
sondere ,HIAT Times*), markieren Sie die gesamte Spur ( + @) und weisen Sie ihr iber den Me-
ndpunkt ,Schrift im Menu ,Text* diese Schriftart zu. So stellen Sie sicher, dass die gesamte Spur
einheitlich formatiert ist.

Starten Sie das Skript ,CountEntries®. Sie erhalten einen Dialog, der lhnen anzeigt, wie viele Eintra-
ge die einzelnen Spuren enthalten:

Track AU: 2 entries.

Track A: 260 entries.

Track D: 255 entries.

Track P : 105 entries.
Track 5: 2 entries.

Track : 18 entries.

Track : 98 entries.

SchlieRen Sie den Dialog, indem Sie auf OK klicken.

Tragen Sie in der Spur mit den meisten Eintrdgen (im Beispiel oben also die Spur ,A*) so viele
syncTabs nach wie méglich. Gehen Sie zu diesem Zweck alle syncTabs durch. Falls die betreffende
Spur an einem syncTab keinen Eintrag aufweist,

= markieren Sie diesen ,Sync-Tab“,
= setzen Sie den Cursor an das Ende des nachstgelegenen, vorherigen Eintrags in der Spur und
= wahlen Sie Sync 2 Mit Ziel-syncTab verbinden (oder driicken Sie die Tabulator-Taste).

Speichern Sie das syncWRITER-Dokument unter einem neuen Namen und schlief3en Sie es, ohne
den syncWRITER zu beenden.
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Auslesen des syncWRITER-Dokumentes

9.  Starten Sie das Skript ,ExSync*.

10. Sie werden aufgefordert, das auszulesende syncWRITER-Dokument festzulegen. Suchen Sie das
eben bearbeitete Dokument.

11. Sie werden aufgefordert, den Namen der Ausgabedatei festzulegen. Suchen Sie den gewlinschten
Ordner und geben Sie einen Namen ein. Hangen Sie diesem das Suffix ,,.xml* an.

12. Das Dokument wird ausgelesen. Dies kann mehrere Minuten dauern. Wahrend des Auslesens wird
ein runder schwarz-weilter Cursor angezeigt — solange dieser zu sehen ist, sollten keine anderen
Aktionen am Rechner durchgefihrt werden, da dies das Auslesen u. U. zum Absturz bringt. Wenn
das Auslesen erfolgreich war, erhalten Sie folgende Nachricht:

Auslesen der syncWriter-Datei erfolgreich!

€ ok )

Importieren des ausgelesenen Dokumentes in EXMARaLDA

13. Starten Sie den EXMARaLDA Partitur-Editor

14. Wahlen Sie File 2 Import 2 “Import” ExSync Data... .

15. Suchen Sie das in den Schritten 9-12 ausgelesene Dokument und klicken Sie auf Offnen. Das Do-
kument wird importiert, und Sie erhalten einen Dialog mit Nachrichten Uber den Verlauf des Imports:

(e ExSync Import Messages

Getting entries of track HEL

Entries not integrated:

[Mahlzeit!

1 entries of 7 not integrated in track HEL

Ok ‘ f Save...

Im Idealfall steht dort fur jede Spur (,Track®): ,0 entries of n not integrated in Track xxx“. Das bedeu-
tet: Alle Eintrége aus dem syncWRITER-Dokument konnten in die EXMARaLDA-Basic-Transcription
integriert werden.

Sollte dies nicht der Fall sein, werden die Eintrage, die nicht integriert werden konnten, aufgefuhrt.
In diesem Fall:
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= Wenn nur wenige Eintrage nicht integriert werden konnten, klicken Sie auf Save... und spei-
chern Sie die Nachrichten in einer Text-Datei. Sie kdnnen diese dann mit einem (Unicode-
fahigen) Text-Editor 6ffnen und die nicht integrierten Eintrage per ,Copy & Paste® in die impor-
tierte Transkription an den betreffenden Stellen einfligen.

= Wenn hingegen viele Eintrage nicht integriert werden konnten, ist dies ein Anzeichen dafir, dass
bei der Vorbereitung des auszulesenden syncWriter-Dokuments Fehler unterlaufen sind. Wie-
derholen Sie in diesem Fall den betreffenden Schritt.

16. Beenden Sie den Dialog mit OK. Die importierte Transkription wird nun im Partitur-Editor angezeigt
und kann dort nachbearbeitet werden.

Nachbearbeiten

Sprechertabelle

Der syncWRITER kennt keine Sprechertabelle. Beim Import wird daher versucht, eine solche aus den
Spurbenennungen zu konstruieren. Uberpriifen Sie das Resultat und korrigieren Sie es, sofern erforder-
lich, Uber File - Edit Speakertable.

Zuordnen von Spuren zu Sprechern, Typen und Kategorien

Spuren in EXMARaLDA miussen einem Sprecher, einem Typ und einer Kategorie zugeordnet werden.
Nehmen Sie diese Zuordnung Uber Tier - Edit tier properties vor. Beachten Sie dabei folgende Grund-
satze:

" Verbale Spuren erhalten den Typ ,T(ranscription)“.
" Non-verbale Spuren erhalten den Typ ,D(escription)®.
" Ubersetzungsspuren o. A. erhalten den Typ ,A(nnotation)*.

] Die externe Kommentarspur ist eigentlich mit der EXMARaLDA-Logik nicht vereinbar, da sie mehre-
ren Sprechern und mehreren Kategorien gleichzeitig zugeordnet ist. Weisen Sie ihr den Typ
,U(ser) D(efined)“ und keinen Sprecher zu.

ExSync Event Shrinker

Die syncTabs im syncWRITER markieren jeweils den Beginn einer Synchronpassage. Es ist theoretisch
moglich, auch das Ende von Synchronpassagen mit einem syncTab zu markieren. In der Praxis wird dies
aber nicht immer gemacht. EXMARaLDA-Transkriptionen brauchen jedoch zwingend einen solchen End-
punkt. Beim Konvertieren wird deshalb bei Abwesenheit eines End-syncTabs einfach der nachste sync-
Tab in der betreffenden Spur verwendet. Folgende Struktur im syncWRITER (syncTabs sind durch rote
Striche angedeutet) ...

0 1 2 3

==

a. Ja.
C FNe in.

... fuhrt deshalb zu folgender Struktur im EXMARaLDA Partitur-Editor:

Ich rede und]gede und rede und rede und rede und rede und rede und rede und rede, habe aber nix zu sagen.
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]

I | 1

1

Ich rede und

rede und rede und rede und rede und rede |u.ndredeundredeundrede,

habe aber mix = sagen.

Ta |

Ta.

A
B
C

|Hei11.

Der erste Eintrag in der Spur von Sprecher B erstreckt sich tiber mehrere Zeitpunkte bis zum nachsten
Eintrag in der gleichen Spur. Der ,ExSync Event Shrinker“ kann dies teilweise beheben. Er berechnet auf
der Grundlage der typographischen Ausdehnung solcher Spureintrage, ob das betreffende Ereignis mit
einem friheren Endpunkt versehen werden kann. Das obige Beispiel wirde nach Aufruf des ,Ex-
Sync Event Shrinkers“ so aussehen:

D

1

1

Izh rede und

rede und rede und reds und rede und rede

und reds und reds und reds,

habe aber nix =1 sagen.

Ja.

_Ta.l

A
B
c Hein.

Dies entspricht immer noch nicht der angestrebten Struktur. Da dieser Schritt aber auf die gesamte Parti-
tur vollautomatisch angewendet werden kann, wird der Nachbearbeitungsaufwand auf diese Weise be-
reits deutlich reduziert. Gehen Sie wie folgt vor:

1. Formatieren Sie zunachst die EXMARaLDA-Partitur so, dass die SchriftgréRen in den Spuren anna-
hernd den Schriftgréen im Original-syncWRITER-Dokument entsprechen.

2.  Wahlen Sie dann Edit - Extras 2 ExSync Event Shrinker... . Sie erhalten folgenden Dialog:

% ExSync Event Shrinker x|
-
Percentage: | | | | |
100 125 150 173 200

ol |

3. Der Dialog fragt nach einem Wert der festlegt, ab wann ein Ereignis nicht weiter geschrumpft wer-
den soll. Beispiel: wenn der vorhandene Platz fiir ein Ereignis kleiner ist als 110 % der typographi-
schen Ausdehnung des betreffenden Eintrages, wird das Ereignis nicht weiter geschrumpft. Norma-
lerweise sollte der voreingestellte Wert von 105 % adaquat sein.

Beenden Sie den Dialog mit OK. Die Partitur wird zunachst einmal neu formatiert. Anschliefend
wird der ,ExSync Event Shrinker angewandt, und die Partitur wird ein weiteres Mal formatiert. Bei
umfangreichen Transkriptionen nimmt dieser Vorgang eine Weile in Anspruch.

Weiteres Nachbearbeiten von Endpunkten

Im obigen Beispiel gibt es immer noch Ereignisse, deren Epdpunkte nicht mit den tatsachlichen zeitlichen
Verhaltnissen korrespondieren. Beispielsweise endet die Aullerung ,Ja" des Sprechers B mit Sicherheit
lange Zeit bevor Sprecher C mit der AuRerung ,Nein“ einsetzt:

1

ade nnd

tede 1nd rede und rede und rede und rede

nnd rec

Ia.
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Um dies zu korrigieren missten Sie im Idealfall die Originalaufnahme abhdéren, um den Endpunkt der
AuRerung von Sprecher B relativ zum zeitlichen Verlauf der AuRerung von Sprecher A zu bestimmen. Oft
wird dies nicht moéglich sein. In diesem Falle kdnnen Sie wie folgt eine ungefahre Korrektur vornehmen:

1. Platzieren Sie den Cursor in die AuRerung von Sprecher A, und zwar ungefahr dort, wo — der typo-
graphischen Ausdehnung nach — das Ereignis von Sprecher B endet (im Beispiel also z. B. vor das

erste ,und):
1 2
1dfrede ind rede und rede und rede und rede und re
Ja.
Nein.

2. Wahlen Sie Event =2 Split Event (oder den entsprechenden Button in der Toolbar). Das Ereignis
wird an der Cursor-Position geteilt:

1 2

drede jund rede und rede und rede und rede |

Ja.

3. Setzen Sie den Cursor in das Ereignis von Sprecher B und wahlen Sie Event 2 Shrink event on the
right. Die rechte Ereignisgrenze wird an den neu eingefugten Zeitpunkt verschoben:

1 2 3
idrede |und rede und rede und rede und rede |unc
Ja.‘
Ne:
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VII. ANHANG B: SEGMENTIERUNGS-ALGORITHMEN

A. Segmentierung: ,,HIAT: Utterance and Words*

Alle Zeichen, die nicht in der folgenden Tabelle aufgefihrt sind, werden im EXMARaLDA Partitur-Editor
als Bestandteile von Wortern behandelt (sofern sie nicht Teil eines nicht-phonologischen Datums sind).

Name Standard-Werte Erlauterung

Markieren das Ende einer AuRerung (optional
gefolgt von einem Leerzeichen).

Markiert das Ende eines Wortes oder folgt auf

UtteranceEndSymbols . | ! ?

SpaceSymbols ,AuBerungsendzeichen“ bzw. auf ,lbrige Inter-
punktion®.
Markieren den Beginn und das Ende von Rede-
Quote " wiedergaben. AuRerungsendzeichen innerhalb

von Redewiedergaben werden ignoriert.

Doppeltes Auftreten markiert den Beginn eines
OpenParenthesis ( nicht-phonologischen Segments. Einfaches Auf-
treten wird wie ,Ubrige Interpunktion“ behandelt.

Doppeltes Auftreten markiert das Ende eines
CloseParenthesis ) nicht-phonologischen Segments. Einfaches Auf-
treten wird wie ,Ubrige Interpunktion® behandelt.

. .. Markieren intrasegmentale Phdnomene und
MiscellaneousPunctuation ' : ; , -  _ — / : .
werden als Interpunktion segmentiert.

Markiert Pausen und wird als nicht-

PauseSymbols *le phonologisches Datum segmentiert.

Beispiel:

Die zweite Segmentkette von Sprecher A wird mit der Segmentierung: ,HIAT: Utterance and Words* ...

0 1 2 3 4 i
A ]| Guten Tag. Wie = geht es Dr? | Alles | ((kustet)) klar?
B Hallo, Zut.

... folgendermaRen in AuRerungen, Wérter (W), Interpunktion (IP) und nicht-phonologische Segmente
(Non-pho) segmentiert:

Segmentkette
AuBerung AuBerung
w IP | Non-|IP | W P| W |IP| W |IP w IP| Non- [ IP| W IP
Pho Pho
Wie . geht es Dir ? | Alles | (( | hustet | )) | klar ?
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Mogliche Fehler

Ursache Beispiel Fehlermeldung

Sprecherbeitrag beginnt mit | ) Ich mache eine AuBerung Error: No parentheses

schlieRender Klammer. closing, No utterance end
symbol, No end of input
allowed

Sprecherbeitrag beginnt mit | ! Ich mache eine AuBerung Error: No parentheses

AuBerungsendzemhen_ closing, No utterance end
symbol, No end of input
allowed

SchlieRende Klammer folgt | Ich mache eine (AuRerung.) Error: No closed parenthe-

auf AuRerungsendzeichen. sis, no further utterance

end symbol allowed

AuRerungsendzeichen folgt
auf AuRerungsendzeichen.

Ich mache eine AuRerung.!

Error:
sis,

No closed parenthe-
no further utterance

end symbol allowed

SchlieRende Klammer folgt

Ich mache eine (AuRerung. )

Error:

No close parenthe-

auf  AuRerungsendzeichen sis, no utterance end sym-
und Leerzeichen. bol allowed

AuRerungsendzeichen folgt | Ich mache eine AuRerung. ! Error: No close parenthe-
auf  AuRerungsendzeichen sis, no utterance end sym-

und Leerzeichen.

bol allowed

Pausensymbol innerhalb von | Ich ((geht « zur Tir)) hau ab. Error: No end of input, no

doppelten runden Klammern. open parenthesis, no pause
symbol allowed

Dritte 6ffnende runde Klam- | Ich ((geht (oder rennt) zur Tir)) | Exrror: No end of input, no

mer. hau ab. open parenthesis, no pause
symbol allowed

Sprecherbeitrag endet, ohne | Ich hab Husten ((hustet. Error: No end of input, no

dass doppelte runde Klam- open parenthesis, no pause

mern geschlossen wurden. symbol allowed

Nach doppelter gedffneter | Ich ((hustet)mache eine AuRe- | Error: Only close paren-

Klammer folgt auf eine | rung. thesis allowed

schlieende Klammer etwas
anderes als eine weitere
schliefende Klammer.

Innerhalb eines Wortes be- | Ich mach”e eine AuRerung." Error: No opening quote

ginnt eine Redewiedergabe. allowed

Sprecherbeitrag endet, ohne | Und er sagt: "Ich mache eine | Error: No end of input al-
AuRerung lowed

dass eine begonnene Rede-
wiedergabe durch ein zwei-
tes Anflhrungszeichen ab-
geschlossen wurde.
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B. Segmentierung: ,,DIDA: Words*“

Alle Zeichen, die nicht in der folgenden Tabelle aufgefihrt sind, werden im EXMARaLDA Partitur-Editor
als Bestandteile von Wortern behandelt (sofern sie nicht Teil eines nicht-phonologischen Datums sind).

Name Standard-Werte Erlauterung
A B CDEFGH I J | Nur zur Beschreibung nicht-

CAPITALS KLMNGOP Q R morphemisierterAuBerungen, nicht
UV WXYZAO I"J als Bestandteil von Wortern.
PLUS " Markiert einen schnellen Anschluss

am Beginn einer Segmentkette.

Nur als Bestandteile von Zeitanga-
NUMBERS AND COMMA (01 2 3456 789, ben (als Teil einer Pause oder einer
unverstandlichen Passage).

Markiert Beginn und Ende von Pau-
sen.

Zeichen fir suprasegmentale Pha-
WORD_SEPARATORS - 1| <>-/ nomene, sind nicht Bestandteile von
Woértern.

Markiert eine Verschleifung oder
EQUALS_SIGN = steht innerhalb einer nicht-
morphemisierten Auflerung.

Leerzeichen, kann an verschiede-
nen Stellen auftreten, markiert oft
den Anfang oder das Ende eines

Segmentes.

Markiert den Beginn einer unver-
OPEN_PARENTHESIS ( standlichen oder schwer verstéandli-
chen Passage.

Markiert das Ende einer unverstand-
CLOSE_PARENTHESIS ) lichen oder schwer verstandlichen
Passage.

Markiert den Beginn einer Auslas-
sung.

Markiert das Ende einer Auslas-
sung.

Doppeltes Auftreten markiert einen
AMPERSAND & Referenzbereich in einer Sprecher-
zeile.

Nur innerhalb unverstandlicher Pas-
sagen.

Entweder innerhalb eines Wortes
COLON : (als Dehnungszeichen) oder inner-
halb einer Zeitangabe.

PAUSE *

SPACE

OPEN_SQUARE_BRACKET |

CLOSE_SQUARE_BRACKET |

PERIOD_OR_ELLIPSIS

Beispiel:

Die folgende Segmentkette von Sprecher X wird mit der Segmentierung: ,DIDA: Words* ...

0 |1
X P2 HISTET (was) denn *1,5* sonst] |

.. folgendermafen in Wérter (W), Interpunktionszeichen (IP), nicht-morphemisierte AuRerungen (NMA)
und Pausen (PAUSE) segmentiert:
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Segmentkette
W IP NMA IP IP w IP IP w IP | PAUSE | IP w IP
ja:“ HUSTET ( was ) denn *1,5" sonst | 1
Mogliche Fehler

Ursache Beispiel Fehlermeldung

Grofbuchstaben  innerhalb | jA Error: Nicht erlaubt:

von Wortern GroBbuchstabe, offene
Klammer, geschlossene
Klammer, Punkt oder El1-
lipse, Zahl oder Komma

Kleinbuchstaben  innerhalb | Ich mache] eine Auferung. Error: Nicht erlaubt: of-

nicht-morphemisierter AuRe- fene Klammer, geschlosse-

rungen ne Klammer, Zahl oder
Komma, Doppelpunkt, Punkt
oder Ellipse, Pausenzei-
chen, Prosodiezeichen,
Wortbestandteil
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C. Segmentierung: ,,GAT: Intonation Units*

Name Standard-Werte Erlduterung

Markiert abschlieRend die Tonhdhenbewegung einer
Phrasierungseinheit

Markiert Beginn einer Pause oder einer schwer ver-
standlichen Passage. Punkte zwischen runden
Klammern werden nicht als Endzeichen einer Phra-
sierungseinheit behandelt.

Markiert Ende einer Pause oder einer schwer ver-
standlichen Passage. Punkte zwischen runden
Klammern werden nicht als Endzeichen einer Phra-
sierungseinheit behandelt.

Markiert Ende einer Kommentarannotation
(z.B.: <lachend< was?>)und kann hinter dem

IU_END_SYMBOLS 20,013

OPEN_PARENTHESIS (

CLOSE_PARENTHESIS )

CLOSE_ANGLE ~ abschlieBenden Zeichen einer Phrasierungseinheit
auftreten.
SPACE Kann hinter dem abschlieRenden Zeichen einer

Phrasierungseinheit auftreten.

Markiert eine Verschleifung zweier Phrasierungsein-
heiten. Bei doppeltem Auftreten wird das erste Zei-
chen der ersten, das zweite Zeichen der zweiten

EQUALS = Phrasierungseinheit zugeordnet. Bei einfachem Auf-
treten entscheidet die Verwendung eines Leerzei-
chens darlber, welcher Phrasierungseinheit das
Zeichen zugeordnet wird.

Beispiel:

Die folgende Segmentkette von Sprecher S1 wird mit der Segmentierung: ,GAT: Intonation Units® ...
0 1 2 3 4

S1p\ia: () die VIERziger generation so;=|=das=g: I'WAHNsinnig viele die sich da ham |SCHEIden |lasse n.= |=oder scheiden lassen UBERhaupt.

52 bl » fim, h

T R

5 L]

... folgendermafen in Phrasierungseinheiten (PE) segmentiert:

Segmentkette

PE PE PE PE

jas; (.) die VIERziger generation | =das=s: IWA:HN!sinnig viele die sich da ham | =oder scheiden lassen UBERhaupt.
S0;= SCHEIlden lassen.=
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D. Segmentierung: ,,CHAT: Utterance*

Name Standard-Werte
PERIOD .
QUESTION_MARK ?
EXCLAMATION_MARK !

SPACE

Erlauterung: Alle AuRerungsendzeichen in CHAT (also sowohl die ,Basic Utterance terminators® als auch
die ,Special Utterance Terminators®, vgl. MacWhiney 2000: 60 und 66ff) setzen sich aus Zeichenketten
zusammen, die mit einem Punkt, einem Fragezeichen oder einem Ausrufezeichen enden. Der Segmen-
tierungs-Algorithmus erlaubt zusatzlich ein (optionales) Leerzeichen hinter diesen AuRerungsendzeichen.

Beispiel:
Die folgende Segmentkette von Sprecher CHI wird mit der Segmentierung: ,CHAT: Utterance® ...

0 |1
CHI [‘-’]II‘-JIununj.r! [ want something+ . Something to drink Can 7 I

... folgendermalen in AuRerungen (U) segmentiert:

Segmentkette

U V) U V)

Mummy! | | want something+... | Something to drink. Can I?
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VIIL.

ANHANG C: HINWEISE ZUM RTF-EXPORT

Betriebssystem

Anwendung

Beobachtungen und Hinweise

Windows 98, MS Word 2000 Bei dieser Konstellation sind im Testbetrieb keine Probleme

Windows NT, aufgetreten, d. h. Unicode-Zeichen werden korrekt angezeigt

Windows 2000, und es gibt keine ungewollten Umbrtche innerhalb von Ta-

Windows XP bellenzeilen.

Windows 98, MS Word 2002 Die Darstellung von Unicode-Zeichen funktioniert. Um unge-

Windows NT, (= Word XP) wollte Umbriiche zu vermeiden, sollte die Option ,U-

Windows 2000, se CellFit-Parameter” gewahlt werden (s. u.).

Windows XP

Windows 98, MS Word 97 Die Darstellung von Unicode-Zeichen funktioniert. Aber um

Windows NT, ungewollte Umbriche zu vermeiden, muss unbedingt die

Windows 2000, Option ,Glue adjacent” und ,Glue empty” gewahlt werden

Windows XP (s. u.).

Windows 98, Open Office 1.1.0 Die Darstellung von Unicode-Zeichen funktioniert. Vereinzelt

Windows NT, wird der Inhalt von Zellen abgeschnitten. Um dies zu vermei-

Windows 2000, den, kann die Option ,Glue adjacent* und ,Glue empty“ ge-

Windows XP wahlt werden.

Mac OS 9.x MS Word 2001 Mac OS 9.x unterstitzt Unicode nicht. Unicode-Zeichen, die
nicht im ASCII-Bereich liegen, werden deshalb falsch oder
gar nicht angezeigt. Weitere Probleme sind bislang nicht
bekannt.

Mac OS X MS Word X Obwohl Mac OS X Unicode unterstutzt und Office X eigent-
lich eine native Mac OS X-Anwendung sein sollte, wird Uni-
code (zumindest in RTF-Dokumenten) nicht vollstadndig un-
terstitzt. Unicode-Zeichen, die nicht im ASCII-Bereich lie-
gen, werden deshalb unter Umstanden falsch oder gar nicht
angezeigt. Weitere Probleme sind bislang nicht bekannt.

Mac OS X TextEdit TextEdit kann zwar grundséatzlich RTF-Dokumente lesen
(und unterstiitzt auch Unicode), es ignoriert jedoch die Ta-
bellenattribute und ist deshalb fur die Ausgabe von Partituren
ungeeignet.

Mac OS X Potenzieller Kandidat: | Ab Betriebssystem-Version 10.3. soll Open Office vermittels

Open Office eines X-Servers auch auf dem Macintosh lauffahig sein.
Entsprechende Tests sind in Planung.
LINUX Potenzieller Kandidat: | Textverarbeitungsprogramme, die unter LINUX arbeiten und
Open Office RTF-Dokumente lesen kénnen wurden bisher noch nicht
getestet. Entsprechende Hinweise sind daher sehr willkom-
men.
UNIX Potenzieller Kandidat: | Textverarbeitungsprogramme, die unter UNIX arbeiten und

Open Office

RTF-Dokumente lesen kénnen wurden bisher noch nicht
getestet. Entsprechende Hinweise sind daher sehr willkom-
men.
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IX.ANHANG D: EXMARALDA UND STYLESHEETS

Was ist ein Stylesheet?

Ein Stylesheet ist ein XML-Dokument, das Anweisungen enthalt, die von einer dafir ausgelegten Soft-
ware (einem Stylesheet-Prozessor) ,verstanden® und umgesetzt werden kénnen. In aller Regel wird ein
Stylesheet dazu benutzt, um aus einem gegebenen XML-Dokument ein anderes XML- oder ein HTML-
Dokument zu erzeugen. Weil EXMARaLDA-Daten immer XML-Daten sind, ist die Stylesheet-Technologie
gut geeignet, um mit vergleichsweise wenig Programmieraufwand ein hohes Mal} an Flexibilitdt in der
Datenverarbeitung zu erreichen. Es ist nicht notwendig, die Details dieser Technologie zu verstehen, um
Stylesheets bei der Arbeit mit dem Partitur-Editor effektiv nutzen zu kénnen. Auf eine detaillierte Ausfiih-
rung soll daher in diesem Handbuch verzichtet werden. Interessierte seien stattdessen auf eine der zahl-
reichen Einflhrungen in diesen Gegenstand verwiesen:

Michael Fitzgerald (2003): Learning XSLT. O’Reilly.
Wozu dienen Stylesheets?

Innerhalb von EXMARaLDA dienen Stylesheets dazu, solche immer wiederkehrenden Aufgaben beim
Transkribieren zu Gbernehmen, die einerseits regelmaRig genug sind, um automatisiert zu werden, deren
genauer Ablauf aber andererseits von Parametern abhangt, die sich von Benutzer zu Benutzer stark un-
terscheiden konnen. Da es kaum maoglich ist, alle denkbaren Parameter einer solchen Aufgabe vorherzu-
sehen und (z.B. in Form eines Dialogs) direkt in den Partitur-Editor zu integrieren, enthalt der Partitur-
Editor einige Funktionen, die sich mittels Stylesheets benutzerdefiniert parametrisieren lassen.

Beispiele fir solche Aufgaben sind:

(1) Beim Anlegen einer neuen Transkription soll fur jeden Sprecher automatisch eine bestimmte Menge
von Spuren angelegt werden. Die Parameter dieser Aufgabe kdnnen beispielsweise von der verwen-
deten Transkriptionskonvention abhangen — z.B. soll fir eine Transkription nach den HIAT-
Konventionen fir jeden Sprecher eine verbale Spur, eine Spur fir besondere Betonung und eine
Spur fir den externen Kommentar angelegt werden, wahrend fiir eine DIDA-Transkription lediglich
eine verbale Spur und eine Kommentarspur pro Sprecher sowie eine globale Kommentarspur erfor-
derlich sind. Durch die Verwendung eines geeigneten Stylesheets zusammen mit der Funktion ,File
- New from speakertable” kann diese Aufgabe automatisiert werden:

K|
vy
' = DIDA- —
. : < Stylesheet
HIAT- T
Stylesheet x|
\ _ ![
|
MAX [ | |
TOM |

(2) Eine vorhandene Transkription soll in Abhangigkeit von den Spurtypen automatisch formatiert wer-
den, z.B. sollen alle Spuren der Kategorie ,v* mit ,Arial, 12pt, fett und alle Spuren der Kategorie ,nv*
mit ,Times, 10pt, kursiv* formatiert werden.

(3) Eine HIAT-AuRerungsliste soll als HTML-Datei ausgegeben werden, die einzelnen AuRerungen sol-

len nummeriert werden und alle Annotationen und Deskriptionen aus der Darstellung ausgeblendet
werden.
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Woher kommen die Stylesheets?

Es gibt drei Méglichkeiten, Stylesheets fir den Gebrauch mit dem Partitur-Editor zu erhalten:

(1) Download eines gebrauchsfertigen Stylesheets von der EXMARaLDA-Website:
Auf der EXMARaLDA-Website werden einige gebrauchsfertige Stylesheets zum Download angebo-
ten. Die Mehrzahl davon ist auf die Arbeit mit den Transkriptionssystemen HIAT und DIDA ausgelegt.

(2) Anpassen eines vorhandenen Stylesheets:

Der eigentliche Zweck eines Stylesheets — die benutzerabhangige Parametrisierung einer automati-
sierbaren Aufgabe — kann nur dann vollstandig erfiillt werden, wenn der Benutzer die betreffenden
Stylesheets selbst erstellt. Fir viele Benutzer wird das Erstellen eines Stylesheets ,von Grund auf*
jedoch einen zu hohen Aufwand bedeuten. Oft genligt es aber, einfach ein vorhandenes Stylesheet
(z.B. eines der auf der EXMARaLDA-Website angebotenen) den eigenen Bedurfnissen anzupassen.
Dass dies wesentlich einfacher als das Erlernen der gesamten Stylesheet-Sprache sein kann, zeigt
das folgende Beispiel: Der linke Ausschnitt stammt aus einem Stylesheet von der EXMARaLDA-
Website, das dem Generieren einer Format-Tabelle dient. In ihm ist festgelegt, dass Spuren mit der
Kategorie ,v’ in ,Arial, normal, 16pt, schwarz* formatiert werden sollen. Eine Modifizierung des Sty-
lesheets (siehe rechter Ausschnitt) kann den grofiten Teil der Anweisungen unberihrt lassen und le-
diglich an den gelb hervorgehobenen Stellen Anderungen vornehmen:

<!-- Format fiir verbale Spuren --> <l-- Format fiir verbale Spuren -->
<xsl:when test="@category="'v"> <xsl:when test="@category="'v">
<xsl:element name="tier-format"> <xsl:element name="tier-format">
<xsl:attribute name="tierref"> <xsl:attribute name="tierref">
<xsl:value-of select="@id"/> <xsl:value-of select="@id"/>
</xsl:attribute> </xsl:attribute>
<property name="font-name">Arial</property> <property name="font-name">Times</property>
<property name="font-face">Plain</property> <property name="font-face">Italic</property>
<property name="font-size">16</property> <property name="font-size">12</property>
<property name="font-color">black</property> <property name="font-color">blue</property>
</xsl:element> </x§i;element>
</xsl:when> </xsl:when>
Arial Times

(3) Erstellen eigener Stylesheets
Die umfassendste, aber auch die aufwandigste Methode zum Einsatz von Stylsheets besteht im
Erstellen eigener Stylesheets. Dazu muss Uber den Programmcode des Partitur-Editors nichts be-
kannt sein, es genugt eine Kenntnis der Strukturen der EXMARaLDA-XML-Dateien.

Stylesheets im Partitur-Editor nutzen

Um Stylesheets innerhalb des Partitur-Editors nutzen zu kénnen, missen die zu nutzenden Stylesheets
zunachst unter ,Edit > Preferences - Stylesheets” festgelegt werden. Anschlielend kdnnen die betref-
fenden Funktionen aufgerufen werden. Es gibt finf Funktionen im Partitur-Editor, die sich mittels Styles-
heets parametrisieren lassen:

(1) File > New from speakertable

Dies ist die oben illustrierte Moéglichkeit, die Spuren einer neuen Transkription automatisch aus der
Sprechertabelle generieren zu lassen.

(2) File = Visualize - HTML partiture
Hierbei kann ein Stylesheet verwendet werden, um Meta-Informationen und Sprechertabelle (der sog.
Transkriptionskopf) in einer benutzerdefinierten Form auszugeben. Beispielsweise kdnnen verschie-

dene Stylesheets verwendet werden, um Ausgaben der Attributnamen in verschiedenen Sprachen
vorzunehmen:
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Ohne Stylesheet:

Rudi Voller

Meta Information

Project
nan’]le Universitat Hamburg, SFB 538 (Zh), Test EXMARaLDA 1.2 6
Referenced
file
Bei dem transkribierten Video handelt es sich um einen Ausschnitt aus einer Sportreportage der ARD
Comment anlasslich des Fukball-EM-Qualifikationsspiels |sland - Deutschland in Reykjavik am B September
2003.
Speakertable
Sex m
Languages
GER
used
L1 GER
GN
Name MNetzer

Ginter Metzers Sprache (Tonfall) wie auch Mimik zeichnen sich durch gine ungewahnliche
Comment Langsamkeit und Gleichmatigkeit aus. Er verzieht kaum eine Miene - selbst dann nicht, als er
affensichtlich versrgert ist

Mit “Head2HTML de.xsl*:

Rudi Voller
Meta-Information

Projektname Universitat Hamburg, SFE 938 (Zb), Test EXMARaLDA 1.2.6

Medien-
Datei
Kommentar Bei derm transkribierten Video handelt es sich um einen Ausschnitt aus einer Spartrepartage der ARD
anlisslich des Fukhall-EM-Qualifikationsspiels Island - Deutschland in Reykjavik am 6. Septernber 2002
Sprechertabelle
Geschlecht m
Benutzte
Sprachen GER
L1 GER
GN
Name Netzer

Glnter Metzers Sprache (Tonfall) wie auch Mimik zeichnen sich durch eine ungewdhnliche
Kommentar Langsamkelt und Gleichmakigkeit aus. Er verzieht kaum eine Miene - selbst dann nicht, als er
offensichtlich verargert ist,

(3) File = Visualize - Free stylesheet visualization

Hierbei wird ein Stylesheet auf die gesamte Basic-Transcription angewendet. So kénnen beispiels-
weise Darstellungen der Transkription in Partitur- oder Spaltennotation oder als Liste von Ereignissen
generiert werden:

Mit “BT2ColumnHTML.xsl:

KLA [v] KLA [en] KLA [fr] ERW [v] | ERW [en] ERW [fr] KLA [ext]| [aud] | [pho]

1 Dreizehn Mann auf des  [Thirteen men on the Lrif;eh;gn“mhs;;u;

toten Mannes Kiste dead man's chest.

maort.

1 [({schniffelty)
— = sniffs)) Ch, what a Sh. comme ca pue

Boah, wat stinkt dat g A Gap
2 \wieder in der dans cette grotte AUDION

cave
Tropfsteinhdhle. leise

Oh, someong's

3 Oh, da kommt einer. ) Oh, quelgu'un vient
coming

E gL'
4 [Kommt noch einer. wnother one caming nore quelgiLn

wient.
5 [qthustaty wa? [itcoughsy wihat? [(itousse)) quoi?
’l? ‘Och nee, dat jiwet ja ni (on, | don't Oh, c'est
[ oo ‘ch beliewve it! incrayable
— § Oh, ga peut pas étre
. h, dat kann ja nich wahe  (Oh, that can't be true tal

sein.
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Mit “BT2PartiturHTML.xsI*:

o [ B B
‘KLA [v]: |Dreizehn Wann auf des toten Mannes Kiste. |((Schnt]ﬁe\t)) ‘Boah, wiat stinkt dat wieder in der Tropfsteinhdhle, m
‘KLA [en] : |Thirteen men on the dead man's chest. |((snif'fs)) Oh, what a smell here inthe cave. Ch, st
‘KLA [fr] : |Treize hommes sur la bofte de homme mort, |OhJ comme ¢a pus dans cette grotfte. Ch, g

ERW [v] :

ERW [en] :

ERW [fr] :

[KLA [ext] : |leise
[aud]:  [auDion

[pho] :

Mit “BT2EventListHTML.xsl*:

1

KLA [v] : Dreizehn Mann auf des toten Mannes Kiste,
KLA [en] : Thireen men onthe dead man's chest,
KLA [fr] : Treize hommes sur la boite de 'homme mort,
KLA [ext] : leise

[aud] : AUDIOT

2

KLA [v] : ((schn(ffelty)

KLA [en] : ({sniffz)) Oh, what a smell here in the cave.
KLA [fr] : Ch, comme ¢a pue dans cette grofte.

3
KLA [v] : Boah, wat stinkt dat wisder in der Tropfsteinhidhle,

4
KLA [¥] : Oh, da kommt iner.
KLA [en] : Th, someone's coming.
KLA [fr] : Oh, quelgu'un vient.

(4) Format > Apply Stylesheet

Hierbei wird aus der Transkription mittels eines Stylesheets eine Formatierungstabelle erzeugt und
diese anschliel®end im Editor angewendet.
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Stylesheets

(5) Segmentation > HIAT segmentation - Utterance list (HTML)

Hierbei wird ein Stylesheet auf eine AuRerungsliste — d.h. eine List-Transcription, die gemaR HIAT in
AuBerungen segmentiert ist — angewendet:

Ohne Stylesheet:

ELA

ELA

ELA

ELA

ELA

ERW

Dreizehn MWann auf des toten Iannes Kiste.

{Thirtesn rmen on the dead man's chest.
Treize hommes sur la boite de Thorome mort.

leize}
{{schruffelt)) Boah, wat stinkt dat wieder in der Tropfstemnhéhle.

{l{sniffe)) Ok, what a smell here in the cave.
Oh, comme ga pue dans cette grotte.

leise}

Oh, da kommt emer.
{0k, someons's cotaing.
O, cpuelyn'on wient.
leise

Eommt noch emer.
{another one coming.
Encore cuuelgu'an vient.
leise}

{((hustet)) "Wa?
{i(coughs]) What?

({tousse)) Quoi?

leize}

Och nee, dat jiwet ja nichl
10h, T don't belisve it!

Ok, c'est incroyable. }

Mit “HIAT PlainUtteranceList Tbl.xsl*:

1 KLA: Dreizehn Mann auf des toten Mannes Kiste.

2 KLA: i{schniffelt) Boah, wat stinkt dat wieder in der Tropfsteinhdhle,
3 KLA: Ch, da kommt einer,

4 KLA: Kommtnoch siner,

5 KLA: ((hustet) Wa?

& ERW: Qch nee, dat wet ja nichl

7 KLA: Qoh, dat kann ja nich wahr sein,

8 ERW: Hallo Klaus, wat machs du denn hier inna Tropfsteinhdhle?

Mit “HIAT PlainUtteranceList Txt.xsl":

1 KLA:
2 KLA:
3 KLA:
4 KLA:
5 KLA:

7T KLA:

5 ERW:

3 ERW.

Dreizehn Mann auf des toten Mannes Kiste.

{(schnlffelt)) Boah, wat stinkt dat wieder in der Tropfsteinhdhle,

Oh, da kommt einer.
Kommt noch einer,
((hustet)) Wwa?
Och nee, dat jiwet ja nichl
Qoh, dat kann ja nich wahr sein.
Hallo Klaus, wat machs du denn hier inna Tropfsteinhdhle?

Mit “HIAT ColoredUtterancelist.xsl“:

6 ERW:

1 KLA: Dreizehn Mann auf des toten Mannes Kiste.

2 KLA: ((schniffelt)) Boah, wat stinkt dat wieder in der Tropfsteinhahle.
3 KLA: Oh, da kammt einer.

4 KLAZ Kommt noch einer.

5 KLA: [(hustety)iifa?

7 KLA: QOoh, dat kann ja nich wahr sein.
9 ERW: Hallo Klaus, wat machs du denn hier inna Tropfsteinhahle?
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X. ANHANG E: UBERSICHT UBER DIE TASTENKOMBINATIONEN

Tastaturbeschriftungen sind herstellerabhangig. Fur die folgenden Tastenkombinationen gilt:

[Strg| 2 [Ctrl & [s]

Menii: Tastenkombination: Funktion:
Menii ,,File“: + = New
+[0] = Open
+ = Save
+[P| = Print
+[R = Export RTF partiture...
+ = Export HTML partiture...
+ + = Send HTML partiture to browser
Menii ,,Edit“: Strg| + = Copy
+M = Paste
Strg + X = Cut
Menii , Tier: +[A = Add tier
+[1 = Insert tier
+ = Move tier upwards
Strg| + Al + H] = Hide tier
Menii ,Event: Strg + D] = Delete event
+ = Merge events
Strg| + = Split event
+ = Double split event
Strg| + |1t Shiff + E| = Shift characters to the right
+ + = Shift characters to the left
+ + = Extend event to the right
Strg| + |T Shift) + = Extend event to the left
+ Al + = Shrink event on the right
+ A + = Shrink event on the left
Strg| + = Move event to the right
+ = Move event to the left
+ = Edit event properties
Menii ,,Format*: Strg + = Format tier
+ [ Shiff + = Save format table
Sonstiges: Strg| + = Jump to start (an den Anfang der Transkription)
Strg| + m = Jump to end (an das Ende der Transkription)
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Synchronisieren Uber Praat

Xl. ANHANG

F

SYNCHRONISIEREN

EINER EXMARALDA-

TRANSKRIPTION MIT EINER DIGITALISIERTEN AUFNAHME
UBER PRAAT

A

1.

Vorbereitung

2. EXMARaLDA Partitur-Editor (Version 1.3.) starten

a.

auswahlen

b.
c.

Zu bearbeitende Transkription 6ffnen
Hauptfenster (Partitur) und Praat-Panel so arrangieren, dass sie sich nicht tGberlappen

Kopie der Audio-Datei (muss im aiff- oder wav-Format sein) auf die Festplatte legen.

Falls das Praat-Panel nicht angezeigt wird: ,View = Show panels > Praat panel*

und ein Teil des Bildschirmes (fiir Praat) frei bleibt, z.B.:

% EXMAHalDA Partitur-Edier 1.3, [PV 1) [(:Werporalf 5-SKOSI0. 1WEFEG4dt_Bin 0722 1_SK0_100203EF E04d1_Bin_0722_SKO.xmi]

.4 Start

“o Prast ohiects

Fie Ed View Ter Everd Tisolne Formal  Segmentalion  Help
Bar @9 AwE @  EiSE
SENEDNZ 1 o ] o ] EEyx
Ein [v]
Hin [wv]
Nes Iv] O%ay. Das klappt (2% Soo. '_((l.'ss)) Wir machen Jetzt das glefiche auf Deutsch. |((15)) Du hast Jetzt verhin ein Film
Nes [nv]
({Aafiag der Kaseatte, 541}
< »

< longound 0., | 2B Doburare - | B DSSHON

3. Meta-Informationen bearbeiten (,File > Meta-Information...

a.

D)

Neben ,Referenced File auf ,Browse...“ klicken und die Audio-Datei (siehe Schritt 1)

auf der Festplatte suchen und auswahlen, Dialog mit ,OK* beenden

% Edit Meta Information

~Fixed attribut

Froject name SKOE!

Transeription name: EFEQ4ct_Ein_0722_SKO_100203
Transeription convertion: | HIAT

> Refsrenced fls: | DoEs_ucionr2z_a.wav | Browse
~User defined atiribut
Aftribute Value
Add attribute Autr 100203 -
[ emove st oute versuch [EFED4t
Kindersigle Bin
Institution [Familie L]
Aufrahme durch [Esen
Down [ autrahmegera (SN AM-GXE70
— Kassstternnummer o722
SRt Beginn der Transkrigtion 180204 3
~Carmment
sie dic Farbe wnd dann den Wolf. Sie erzéhlt der Reihe mach &

was dort passiert ist, Die Interviewerin stellt zwischendurch
Fragen. Binnaz gibt auf jede Frage eine Antwort. Die
Interviewerin will wissen, was sie gern im Fernsehen anguckt.
sie sagr, dass sie lieber Deutsch redet als Tirkisch. Dann
komuen sie wieder zurick zum Maulwurf, $ie erzahlt das was sie
noch nicht erwahnt hatte. Dam war sie auch fertig.

oK Cancel

4. Praat starten und einrichten

a.

Im Praat-Panel auf ,Start Praat” klicken.

b. Warten, bis Praat lauft (d.h. bis der Welcome-Dialog von Praat...
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About

X

PrRAAT
doing phonetics by computer

version 4.2.06

WL praat. org

Copyright @ 1992-2004 by Paul Beersma and David Weenink
Sil Encaore Fords™: @ 1992-1998 Summer Institute of Linguistics

... verschwunden ist).

c. ,Starting Praat...“- Dialog mit ,OK* bestatigen:

[

Pane
. Start Prast M= o ettings

@ Choose... | % [Relload |

[

& Press QK when Praat is up and running,

CES_AudioWdF22 2 way
Start: 00 End: 105

d. Praat Picture Window schlief3en:

M Praat picture
File Edit Margins ‘World Select Pen  Fant

1 ' 2 ' 3
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5. Audio-Datei in Praat 6ffnen
a. Im Praat Panel auf ,,(Re)load” klicken
b. Warten, bis in Praat ein Editor fiir ,Long Sound [Dateiname]“ gedtffnet wird:

M L ongSound 0722 _A

File Edit Query Wiew Select Spectrum Pitch Intensity Formant  Pulses

0.55328 | |

Il

0.000000 Vizible part 30,000000 seconds 30000000 302 045806

Total duration 422.045886 seconds

o | | o] sl | | Group

Der Editor wird dann auch im Praat Object Window angezeigt:

M Praat objects E| El E|

Control  Mew Read  Write Help
Objects: LangSound help -
| ohgSound Wie
Flay part...
Query - |
Annatate - | e

Convert to Sound

Extract part... |

Rename... M Copy...
Remaove Inzpect - | | Llj

c. Praat Editor Window und Partitur-Editor so auf dem Bildschirm anordnen, dass alles
zu sehen ist:

EXMARALDA Bartifur £ dlise 1.3, [PV 1) [0iWarporall 5 SKOBNO,1\EF £04d1_Hin_0772_1_SKO_ 100203\ FEDA1_Bin_0722_5K0, mni] (- [of%] ]

Fio B Vw Tiw Evork Tl Formst  Segmertalion  Help
Gal 69 B L N -
NN S N e v e e ] R

:
Hin [v] |

I
Bin [nv] |

|
Nes vl | Ckay. Das kiappt ((25)) Soo. [((1,55)) Wir machen jetzt das gleicne auf Deutseh. |((15)) Du hast |#tzt varhin ein Film
! B 1
Nes [nvl|
i€ Anface det Kaswetie, 550
¢

M | ongSound 0772_A

[l Fdt Query View Select Spectrum Pich Irbeely Formand  Pubies = catvgn
& rooee " I@wxm
Pa | Gea
[ Symctworize. it webchon
Mezaagey

Vindhba pact 30 BOOCCD sevands
Total dwatinn 432 040300 seands

TiStart [ asosya. [ esson

d. Im Praat-Editor ,View - Zoom...” wahlen und 0.0 als Beginn, 60.0 als Ende eintra-
gen:
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foom El

From: [0.0 |

Tor [60.0 |

Rewvert to standards | Cancel | ok |

(60 Sekunden ist die maximale Zeit, die als Oszillogramm angezeigt werden kann)

B Synchronisieren

Im Praat-Editor kann mittels der Tabulator-Taste das Abspielen der Audio-Datei gestartet und an-
gehalten werden. Die aktuelle Position wird mit einer gestrichelten roten Linie angezeigt. Am unteren
Fensterrand befindet sich eine Scroll-Leiste, mit der der angezeigte Ausschnitt verschoben werden
kann:

M | onpSound 0722 A
File Edit GQuery Wiew Select  Spectrum  Pikch  Intensity  Formant  Pulses Help

2 350025
05538 [ | I

Position

-0.5155

| .
Q000000 Vizibl Scroll-Leiste G0.0000001 362 045285

Total duration 422.045296 zeconds

ol | n | o] o] | ) | ¥ Broup

Das Synchronisieren der Transkription mit der Audio-Aufnahme erfolgt in drei Schritten:

1. Im Partitur-Editor einen Zeitpunkt auswéahlen (dazu auf die entsprechende Stelle in der Zeit-
achse klicken):

= |EXMARaLDA Partitur-Editor 1.3. (PY 1) [D:\KorporalE5 SKOBING. 1\EFEQ4 dt_Bin_0722_f_SKO_100203\EFE04dt_Bin_0722_SKO.xml]

File Edk View Tier Event Timeline Format Segmentation Help

ha® ©9 @,
SEEEEES EEEEEEEEEEE  dEeX

Bin [¥] ar da. |- Und hat Farbe in die Seite geschoben erstmal. RIREREERENE g + » Hat ihn/ hat » ihn weggejagt. |Und denn i

Bin [nv]

Nes [v]

Nes [nv]

2. Im Praat-Editor die zugehdrige Stelle in der Aufnahme suchen, d.h. die Aufnahme an die Stel-
le bewegen, an der das ausgewahlte Element (in der Abbildung z.B. die Au3erung ,,Und denn
ist ein Wolf gekommen*) beginnt.
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3. Im Praat-Panel auf ,Get* klicken. Dem ausgewahlten Zeitpunkt in EXMARaLDA wird als abso-
lute Zeitangabe die Position in der Aufnahme aus Praat zugewiesen. Im Editor ist das z.B.
daran zu erkennen, dass in der Zeitachse eine absolute Zeitangabe erscheint:

0 [56.7] 10

[ |Und dennist ein Wolf gekommen. |+ * Hat ihnd hat » ihnwe
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